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1 Quick Guide

1.1 Product Introduction

SigVSA vector signal analysis software is a professional vector signal analysis application
software that can run on Windows and Linux operating systems.

With SigVSA, users can repeatedly analyze the signals under test, quickly troubleshoot issues,
covering a range from simple BPSK to complex broadband signals, such as FHSS, IQA, UWB,
DMA, OFDM, 4G LTE, 5G NR, IEEE802.11b/a/g/n/ac/ax/be, and 4096QAM.

> SigVSA has rich measurement functions, convenient operation experience and the same
user interface as vector analyzer, providing high efficiency and ease of use.

> Comprehensive local analysis functions, supporting offline analysis of vector analyzer raw

waveform files.

> SigVSA can perform remote vector signal analysis and debugging on the computer, can
control multiple instruments to run in parallel, and can centrally process recorded data or

simulation files, thus saving time going to the laboratory.

Offline waveform data analysis

Export the specified waveform file from the measuring instrument and put it on the computer
hard disk via a USB flash drive or network server. Then use the SigVSA import function to

import the waveform data for vector analysis.

Simultaneously control multiple instruments to collect waveform data and send it to the

computer for centralized analysis

www.siglent.com 5
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In this scenario, SigVSA vector signal analysis software performs cloud control functions,
automatically searches for instruments in the network, selects instruments as needed, and
performs remote control and acquisition. After SigVSA acquires data, it reads the remote
waveform data online and then performs local data analysis, which does not rely on the
instrument vector analysis option.

1.2 Software Installation

Minimum system requirements

Operating System Windows 10 or higher 64-bit operating system
CPU Intel® CoreTM i5 Processor or better

Memory 8 GB RAM or better

Harddisk At least 16GB of free space

Display Resolution Minimum 1280x720, recommended 1920x1080
Virtual Memory More than 1G of available virtual memory

1.2.1 Software Installation Steps

Step 1: Double-click the SigVSA software. Users can select the installation path of the SigVSA
software according to their own arrangements and click Next;

Note: Please make sure that the disk to be installed has 1144.2MB of storage space.

6 www.siglent.com
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e

Select Additional Tasks
Which additional tasks should be performed? R

Select the additional tasks you would like Setup to perform while installing SigySA, then
dick Mext.

Additional shortouts:
Create a desktop shortcut

Step 2: If you need to create a desktop shortcut for the SigVSA software, please check "Create
a desktop shortcut” and click Next;

=

Ready to Install
Setup is now ready to begin installing SigVSA on your computer, By

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Additional tasks:
Additional shortcuts:
Create a desktop shaortcut

Back Install Cancel

Step 3: Click Install to start software installation. The installation process will last for 30
seconds to 1 minute until the installation is completed.

Note: The default installed software does not have a license option. If you want to use it
normally, you also need to load the corresponding measurement option.

www.siglent.com 7
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e

Ready to Install
Setup is now ready to begin installing SigvSA on your computer., (o)
W

Click Install to continue with the installation, or didk Back if you want to review or
change any settings.

Additional tasks:
Additional shortcuts:
Create a desktop shortout

Back Install Cancel

1.2.2 Version Option Application

The SigVSA software needs to load the measurement option to perform measurement analysis
normally; the SigVSA version option application requires the user to first generate an .id file
containing the user's device information, and pass this file to the software development or
market, which will generate the corresponding option license and complete the option loading.

Id File Generation

1. Open the SigVSA software and select Utilities -> Option Management.

8 www.siglent.com
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{5 SIGLENT SigVSA
File Edit Control InputQOutput MeasSetup Trace Markers Window Utilities Help

Measurement Management X

o= AddGroup = NewMeasurement o Ao Install

Jemaining Time T
Reneg line Generate |dentification

Install fromLocal

OFDM NO —

2. Click Generate Identification, select the path to save the ID file, and name the ID file to be
saved (here we assume that the saved file is VSA.id).

7 SIGLENT SigVSA
File Edit Control InputOutput MeasSetup Trace Markers Window Utilities Help

[ | - i . EEE

Measurement Management

o= AddGroup r[= NewMeasurement

Install

Generate dentification

Install from Local

B set the file name
1+ > |EERE » ZHEEEE (C) » Program Files (x86) » EasySigVSA v O T EasySigVSA FEE r

ERv FEER

B30 7R ~ ER ol
. Shares (10.11.1 bearer
L siglent (10110 data
| SSA products ( Help
Loz p] iconengines
B mn imageformats
=Es platforms
= o styles
& translations
pea=tal= i
37
b EF
L =
STHE(N): | VSA -
FEEEM: nid »
o EEE Lo

3. Pass the generated VSA.id file to software development or marketing to obtain the

corresponding license.

Option License Loading

The option license obtained from software development or the market is a .lic file, which is

www.siglent.com
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placed in a directory on the computer, such as D:\license.

1. Select Utilities -> Option Management, click Install from Local, select D:\license (the
directory where the .lic file is stored) in the pop-up window, and click Select Folder.

{5 SIGLENT SigVSA
File Edit Control InputOutput MeasSetup Trace Markers Window Utilities Help

I: ..... = A M AR
Measurement Management

o= AddGroup = NewMeasurement

Install
Remaining Time

Generate Identification

Install from Local

B Select the local cache
« v » [HEBRE » FHEEE (D) » license v & TE license 532 -]
BN SR

Shares (10,111~ =& ENEEs ESill o
siglent (10.11.0

- BESEESHIIEN
SSA_products | EESERZEIENT.

=]

B R

=B8R
SRE-IMERTE

¥ TE

b EF

[ o)

i RS (C)

- EEE D),

=

itz |license

EEiE Bl

2. Afterclicking, the window will close automatically. After a few seconds, it will prompt Install
Success. At this time, the installation status of the corresponding standard signal analysis
option will be displayed as YES, which means that these measurement modes can be used

normally.

; SIGLENT SigVSA

InstallSuccess
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1.3 Function Introduction

SigVSA Features and Benefits

& Offline waveform data analysis on PC:
® Specify IQ data format;
® Supports waveform data up to 16M Byte;
® Supports maximum 2G analysis bandwidth.

2 Supports online control of multiple instruments and acquisition of waveform data for PC
analysis.

B The software is based on the same platform as the Siglent vector analyzer vector analysis
software. Users do not need to worry about the subsequent maintenance of the software.
It has similar measurement and analysis functions and Ul interactions, as shown below:

® Support Windows and Linux operating systems;

® Independent cloud control interface and analysis application interface;

® Support general digital/analog signal analysis;

® Support Custom OFDM signal analysis;

® Supports 4G LTE, 5G NR and other cellular protocol standard signal analysis;

® Support WLAN standard signal analysis such as IEEE802.11b/a/g/n/ac/ax/be (under
development and debugging);

® Supports more than ten measurement indicators, such as signal power, reference
power, frequency offset error, clock error, delay offset, RMS EVM, Peak EVM, single
channel EVM, etc.;

® Supports more than ten measurement functions, such as time domain diagram,
frequency domain diagram, vector error frequency domain curve, vector error time

domain curve, constellation diagram, MIMO, etc,;

® Supports simultaneous control of multiple instruments and equipment for parallel
vector analysis, and independent display of multiple applications, which is convenient

and clear.
B Multi-window display, more flexible observation.
IE The interactive interface is similar to the Siglent vector analyzer operating interface and is
easy to use.
2 Supports trigger, marker, trace and other functions.

12 www.siglent.com
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1.4 Application Wizard

14.1 Software Interface

SigVSA has a variety of windows and status bars, including menu bar, toolbar, measurement
management window, trace window, and marker information window, etc. This chapter mainly
introduces each window and status bar briefly to help increase your understanding of the
software.

{7 SIGLENT SigVSA - &
Output M

Stop T9sym

Menu bar: The menu bar provides a full-function entrance to the SigVSA software, including
file management, measurement status control, trigger control, measurement management,
Trace, cursor, multi-window management functions and some practical tools. Through the
menu bar, you can complete the full function of spectrum analysis.

Toolbar: In addition to the menu bar, SigVSA fixes some commonly used functions, such as
measurement status control, measurement window layout, peak search, etc., on the toolbar
through shortcut icons. During actual measurement, there is no need to open the menu bar

additionally, and you can directly operate the toolbar buttons.

> BCE: Control the measurement, including start, pause, continuous, single, Auto Range
and other functions;

Start: After loading file data or connecting to a remote device, click Start to start the analysis;

Pause: When analyzing data, click Pause to pause the current measurement. Click Pause or
Start again to continue the measurement.

www.siglent.com 13
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Continuous/Single: Click the Continuous/Single button to change the measurement cycle state;

Auto Range: Click Auto Range to automatically set the optimal amplitude of the signal.

ol Displays the currently working window. You can change the current measurement
window by clicking the drop-down menu.

: Change the layout of the Trace window. The three buttons represent single window,
Stack 2, and Grid 2x2 respectively.

B The four icons represent peak search, left peak, right peak, and minimum peak.

Peak search: Set the current cursor position to the position of the peak with the largest
amplitude in the trace being searched; if the cursor is not currently turned on, turn on cursor
1 and set it to the position of the peak with the largest amplitude.

Left peak: The current cursor jumps to the point whose horizontal distance is closest to the
current cursor among the peak points whose horizontal position is smaller than that of the

current cursor.

Right peak: The current cursor jumps to the point whose horizontal distance is closest to the
current cursor among the peak points whose horizontal position is greater than that of the

current cursor.

Negative peak: Set the current cursor position to the position with the minimum amplitude of

the trace being searched.

Measurement Management Window: Measurement Management is a window for adding,
deleting and controlling all measurements of SigVSA.

Measurement Management

o= AddGroup = NewMeasurement

» Group1
> AGNR1
> AGLTE1

Group2

Add Group: To facilitate the management of different measurements, we have added the
concept of Group. Each measurement must belong to a Group, that is, there must be a Group

14 www.siglent.com
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before a Measurement. A maximum of 10 Groups are supported, and each Group can be

renamed.

Each Group also has control buttons, which support operating the Group's control buttons to
start measurement, pause measurement, and modify measurement cycle configuration for all
measurements in the Group. If the measurements in the Group are not needed, all
measurements in the Group can be quickly deleted by deleting the Group.

New Measurement: When you need to add a new measurement, you can use this button to
quickly add the measurement. When adding a measurement, you need to first add a Group or
select an existing Group, and then add the measurement.

Trace window: The Trace window is mainly a window that displays measurement data. It
supports multiple data types, such as 5G Raw Main Time, IQ Meas Time, Frame Summary,
Spectrum, Error Summary, RMS Error Vector Spectrum, etc.

Marker window: used to display the markers in all trace windows; here the markers are
displayed based on different measurements and different trace windows.

Markers

= BGNR1 1Raw Main Time Mkr1 127 ms -0.689 dBm

1.4.2 Demo

The SigVSA software comes with a Demo.

Step 1: Open the SigVSA software (make sure the certificate has been installed).

{7 SIGLENT SigVSA
File Edit Control InputOutput MeasSetup Trace Markers Window Utilities Help

—
3  m=m
I

Measurement Management

== AddGroup = NewMeasurement

Step 2: Select File -> Recall -> Recall Demo. The Demo file is in the SigVSA installation directory
Help/Demo. Select and load any Demo file.

www.siglent.com 15
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{} SIGLENT SigVSA
File Edit Control |nputOutput MeasSetup Trace Markers Window Utilities Help

T v -

mw Recall »| Recall Setup... »
Default Preset | Recall Demo...

B Save »| Recall Last Power-down Setup...

Exit Alt+F4

Note: When you open the software, there is no Group by default. When you directly add a
measurement or recall a measurement/Demo, a Group 1 will be automatically created.

U7 SIGLENT SigVSA

File Edit Control InputOutput MeasSetup Trace Markers Window Utilities Help
I] _: - = == A M ARV

Measurement Management

4= AddGroup = NewMeasurement

@ Recall Demo X
< v 4 <« ZHIEIE (C) » Program Files (x86) » EasySigVSA » Help : Demo » 5G_NR v o ]
@R R - O @

s U= sEE =8 Fehs
iR [ ] NR_FR1_DL_100M_TM31b.demo. 2024/10/12 18:05 DEMO it 1KB
Shares (10.11.1 [[] NR_FR1_DL_50M_TM31.demo 2024/9/25 15:03 DEMO it 1KB
siglent (10110 [ NR_FR1_DL_20M_TM32.demo 4/ DEMO 37# 1KB
1 SSA products \_1 NR_FR1_DL_20M_TM31b.demo DEMO 37# KB
~ o [} NR_FR1_DL_10M_TM31a.demo / DEMO Ti4 1KB
tEEital [7] NR_FR1_DL_5M_TM11.demo 2024/10/12 18:05 DEMO 3T# 1KB
& w=
= Bs
B
SO TERR
¥ T
=
]
L, FREE (C)
st v < >
SZEE(N): | NR_FR1_DL_100M_TM31b.demo v| Dema (*.dema) ~
FI7HO) B

After loading is complete, as shown in the figure, the corresponding Demo storage path can
be displayed under the measurement file of measurement management.

{7 SIGLENT SigVSA

File Edit Control [InputOutput MeasSetup Trace Markers Window Utilities

HIE ] sonwi v mEmEm ST
Measurement Management X 5GNR 1:RawMain Time(Trcl)

o= AddGroup == NewMeasurement
000

~ Group1 2 dBm

~ 5GNR1 o

16 www.siglent.com



SigVSA Vector Signal Analysis Software User Manual

Step 3: Click the Restart button of the loaded Demo measurement B . the Demo file is
automatically parsed.

V7 SIGLENT SigVSA - & x

e 1

1.4.3 Parsing via offline files

Step 1: Open the SigVSA software (make sure the license has been installed).

{} SIGLENT SigVSA
Eile Edit Control InputOutput MeasSetup TIrace Markers Window Utilities Help

- JIKS] | L LIPS V&

Measurement Management

== AddGroup = NewMeasurement

Step 2: In the Measurement Management window, add a measurement.

www.siglent.com 17
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{7 SIGLENT SigVSA
File Edit Control InputOutput MeasSetup Trace Markers Window Utilities Help

N& - Joomt -~ WEE 7 77T

Measurement Management OFDM1:Raw Main TimeTrc 1

o= AddGroup = NewMeasurement
Q.00

~ Group1 * dBm

+ OFDMA1

Step 3: Select File under Measurement and click ..., select the ARB file to be loaded in the

opened file window.

' SIGLENT SigVSA
Fie Edt Control InputOutput MeasSetup Trace Markers Window Utilities Help

mn= ] orom1 - =

Messurement Management X OFDM1: RawMain TimeTrc 1

OFDM1: 10 Me]

< AddGroup = NewMeasurement

| Fasz3

v Groupl

+ « FISEE (C) » Program Files (x86) » EasySigVSA » Help > Demo » 5G NR P
orou1 M| > R TR - o @
w File o g fER xih
CERET Y NR_FR1_DL_100M_TM31b_2ARB 0,601 KB
Shares (10111 NR_FR1_DL_100M_TM31b_1 ARE

NR_FR1_DL_S0M_TM31_2ARB
NR_FR1_DL_S0M_TM31_1 ARB
NR_FR1_DL_20M_TM32_2.AR8

1 siglent (10.11.0
1 $SA products {

b NR_FR1_DL_20M TM32_1 ARB
B #= NR_FR1_DL_20M TM31b 2AR8
= Es NR_FR1_DL_20M Th31b_1.AR8
2 sz NR_FR1_DL_10M_TM31a_2.ARB
T TEER NR_FR1_DL_10M_TM31a_1.ARB
4 FE NR_FR1_DL_SM_TM11_2.ARB
I NR_FR1_DL_SM_TM11_1.ARB
L Fi]
= FEEE ()
prrp >
SEREE(N): |NR_FR1_DL_100M_TM31b_2.ARB. | AR files ("arb) v

[Fe] =

Step 4: Click the start button to start the analysis.

18 www.siglent.com
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V7 SIGLENT SigVSA - & x
o EGt Control InputOutput M

Q=
e

« oroM1 @ 3

1.4.4 Analysis via remote host

Step 1: Open the SigVSA software (make sure the license has been installed).

{5 SIGLENT SigVSA
Eile Edit Control InputOutput MeasSetup TIrace Markers Window Utilities Help

I] = —I - = == A RA AR Y

Measurement Management

== AddGroup = NewMeasurement

Step 2: Click Utilities -> Remote Device Management, a configuration box pops up, click Add
Device to add a lower-level device IP (currently supports remote control resolution of Prime
devices),

{5 SIGLENT SigVSA
File Edt Control InputOutput MeasSetup Trace Markers Wi
Measurement Management

4~ AddGroup  +f~ NewMeasuroment
Binding Window AddDevice

Remove Device
Connect Device

Disconnect Device

www.siglent.com 19



SigVSA Vector Signal Analysis Software User Manual

After adding, select the added device and click Connect Device to complete the communication
connection between the software and the device.

Step 3: Click Add Group to add Group 1, and click New Measurement to add a measurement.

U5 SIGLENT SigVSA
File Edit Control InputOutput MeasSetup Trace Markers Window Utilities Help

11| ] 5GNR1 ST 1 B

Measurement Management b 5GNR1:Raw Main Time(Trc1)

= AddGroup = NewMeasurement
000
~ Group1 s dBm

~ SGNR1 &

O File » Remote Device

Select the added measurement, click Remote Deview or click Utilities -> Data Source Settings,
in the pop-up window, select the spectrum analyzer device to be bound to the slave computer,
and click OK.

{7 SIGLENT SigVSA
Fle Edt Control InputOutpt MoasSetup Trace Markers Window Utities Holp

m 1] 56NR1 mEE Kk, T

Measurament Management x
e @) Select Window Binding Device
i AddGroup <= NewMeasurement

~ Group1

- SGNR1 i

After the binding is completed, as you can see in the figure, there will be an icon similar to a

computer monitor on the right side of the measurement name.

20 www.siglent.com
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5 SIGLENT SigVSA
Fie Edit Control InputOutput MeasSetup Trace Markers Window Utilities Help

|| ESIEEY HMEERE K STV

Measurement Management

R Select Window Binding Device

o= AddGroup = NewMeasurement
v Groupl Status Binding Window
v 5GNR1 @

O File ® Remo

Click the Restart button of the measurement, and you can see the normal connection display
of the lower computer signal in the Trace window.

V} SIGLENT SigVSA - 8 X
Fle Edt Control lnputOutpt MeasSetup Irace Markers Window \ftitios Holp

1] 1 == ko,

Measurement Management X G NR1: Raw Main Time(Tret) X | ¥ SGNR1:10Meas Time(Trc3) % | ¥ SGNR1:Frame Summary(Trc5)

= AddGroup = NewMeasurement Channel EVMGrms) v Yower per RE(dBm) Num RE
000 150

v Group! dim

~ SGNR1 @

f '\W‘f"ﬂ'wsmmm _M#r“ wl‘"ﬂ

v SGNR1: Spectrum(Trc2) 5GNR1:Error Summary(Trcd) X 5GNR1:RMSError Vector Spectrum(Trc6)

000 200
dBm %

Span 122 88MHz
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2> Software Menu

21 File

211 Save&Recall

SigVSA software requires the configuration of one or more measurement attributes and
parameters during measurement analysis, including the type of measurement, cursors, traces,
triggering, and numerous other parameters. To simplify the configuration process, SigVSA
software utilizes the Save & Recall feature to store such common configurations. These can be
recalled and loaded when needed, facilitating rapid application and use.

2.1.1.1 Save

The Save function in SigVSA is categorized into two types: full save and single measurement

save.
Save Setup Save All Measurement Configurations | File -> Save —> Save Setup
Save Single Measurement | File -> Save —> Save
Save Measurement i i
Configuration Measurement

The content saved includes:
Full Save:

Example: To save the configuration for all current measurements, select: File -> Save -> Save
Setup.

{; SIGLENT SigVSA
File Edit Control InputOutput MeasSetup Trace

oy Recall » GNR1 ~« .
Default Preset 3 x S5GNR
= Save » Save Setup..

: Save Measurement 3
Exit Alt+F4 -

TN T 1| = 100
fdiv

s File 7y Remote Device

22 www.siglent.com
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Single Measurement Save: Select an individual measurement and save the configuration for

that measurement;

Example: To save the configuration for a measurement named OFDM1: File -> Save -> Save
Measurement -> OFDMT1.
{} SIGLENT SigVSA
File Edit Control InputOutput MeasSetup Trace Markers Wir
& Recal » GLTE1 ~ e T
Default Preset » * LTE 1:Raw Main Time(Trc
™ Save ¥ Save Setup...

it Alt+F4 Save Measurement ¥ S5GNR1

SO w O B ¢ 100/ OFDM1
fdiv
> OFDM1 1 i AGLTE1

~ 4GLTE1 100

Start Os

LTE 1:Spectrum(Trc2)

2.1.1.2 Recall

Replace Full Replacement | File -> Recall -> Recall Setup ->Replace
Incremental .

Append . File -> Recall -> Recall Setup ->Append
Loading

Recall Demo Recall Demo File -> Recall -> Recall Demo

Recall Last Load Last Power- |

i . File -> Recall -> Recall Last Power-down Setup
Power-down Setup | off Configuration

Replace: Close the existing measurements and fully load the saved measurements.

The Replace function will close all current measurements and substitute them with the
measurement set to be loaded. Therefore, before clicking Replace, please ensure that the
current measurement set configuration does not need to be retained. Otherwise, use the
Append function for incremental loading.

Append: Retain the existing measurements and incrementally load the saved measurements.
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The new configuration group will be appended in sequence after the existing configuration
groups; if the configuration group is not renamed, it will incrementally increase based on the
current Group.

For example: If the current configuration group is Group1, and the appended configuration
groups are Group1 and Group?2, the final display will be Group1, Group2, and Group3.

__________________________________________

: Group2 |
| Append Group1/’6roup3 i

Note: The total number of incremental loaded configuration Groups and the current Groups
cannot exceed 10. If it exceeds 10, a load failure will be prompted.

Recall Demo: Load Demo File.

SigVSA software provides Demo files for different measurement modes by default. Users can
go to the Demo file storage directory (under the installation directory's help\Demo path) to
load and apply them according to their own needs.

After loading, you can start the demonstration by selecting Control -> Restart from the menu
or by clicking the ﬂ button, to start the demonstration.

<5 SIGLENT SigVSA - 8 X
e Edt Contr foas

Allocation(Trcd)

i mﬁm'!n;'rﬁ mmw‘g At | .
wh it iw w‘

Stop 22m st

Recall Last Power-down Setup: Load the configuration that was automatically saved at the last
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shutdown.

212 Preset

Restore the software to its | .
Preset Setup o ) . File->Default Preset -> Preset Setup
initial configuration.

Restore the initial | __
] ) File ->Default Preset ->
Measurement | configuration of the
Measurement->..
measurements.

Preset Setup: Restore the software to its initial configuration state. Regardless of the current
number of measurements and configurations, upon clicking, the software will revert to its most
initial state with configurations reset to default values; that is, only a default 5G NRT1

measurement will be displayed.

U} SIGLENT SigVSA - s x

Measurement: To restore the configuration parameters of a single measurement only, select
Measurement -> Measurement 1 (for example, 4G LTE1), and the configuration parameters for
4G LTE1 will be restored to their default values.

2.1.2.1 Preset

SigVSA offers a Preset function to restore measurements to an initial state, providing a
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convenient starting point for new measurements with initial state configurations. Currently,

two methods are supported: Preset Setup and Measurement Preset.

File -> Default Preset -> Preset Setup: This interface deletes all Groups and measurements and
simultaneously adds a default 5G NR measurement.

File -> Default Preset -> Measurement: Select the measurement you wish to restore, and with
a click, all configurations for the current measurement will be restored, including trigger,
Marker, Trace, measurement attributes, and other related parameters.

22 Control

The control menu offers various ways to start and stop measurements, with these control
buttons displayed individually or repeatedly on both the control menu page and the toolbar.

Control Keys Entry Function

Start a measurement or restart a paused
Control L . T
. Restart measurement. Clicking this button will discard
Menu/Toolbar
all current measurement data.
Pause a running measurement. A second click
will either step through the measurement
) Control . . .
. Pause / Single (when the scan is set to single) or continue the
Menu/Toolbar )
measurement (when the scan is set to
continuous).
Stop the measurement. Unlike pausing,
. Stop Control Menu stopping the measurement will clear all
measurement results.
. Control Toggle between single or continuous sweep
- Sweep/continuous
Menu/Toolbar modes.
. Control Toggle between single or continuous sweep
B Sweep/Single
Menu/Toolbar modes.
Perform an Auto Range on the selected

Auto Range Toolbar
measurement and restart the measurement.

2.3 Input Output

SigVSA provides a Trigger function similar to that of the underlying hardware. Through Trigger,

it is possible to capture time data blocks around specific events. Currently, SigVSA supports
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three types of triggers: free trigger, external trigger, and periodic trigger.
Free Run

Free trigger is the default mode used by the analyzer, where the spectrum analyzer cycles and

scans continuously.

External

External trigger offers users a more extensive triggering functionality. If users wish to achieve
periodic triggering or delayed triggering of the spectrum analyzer, they can opt for the external
trigger mode. In this mode, the trigger control is governed by the rising or falling edge of an
external input signal. Inputting a square wave signal of a certain frequency can serve the
purpose of periodic triggering, and the trigger delay time can be adjusted by setting the
Trigger Delay option.

Period

When Periodic is selected, the analyzer uses a built-in periodic timer signal as the trigger. The
trigger event is set by the periodic timer parameters, which are modified by the offset and the
periodic synchronization source. This trigger is used when there is a periodic signal but no
reliable signal to trigger upon. You can synchronize the periodic signal with an external event
(using the periodic synchronization source) to approximate a reliable trigger signal. If no
synchronization source is selected (off state), then the internal timer will not synchronize with

any external timing events.

Note: External triggering and periodic triggering are not supported when the data source is a
File, and are only supported in Remote connection mode.

2.4 Meas Setup
Meas Setup menu provides all the options for setting up measurements.
241 New Measurement

SigVSA supports adding new measurements by clicking on New Measurement. There are two
entry points for adding new measurements: one is through the Measurement Management
window, where you select the corresponding Group and then click New Measurement to add

a measurement.
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Measurement Management

o= AddGroup = MewMeasurement

~ Group1 u MNew Measurement

> S5GNR1 EH SGNR OFDM

> OFDM6 g 4GLTE
> 5GNR2

Group2

The other method is through Meas Setup -> New Measurement to add a measurement.

Currently, SigVSA supports the addition of three types of measurements: 5G NR, OFDM, and
4G LTE.

Note 1: Before adding a new measurement, it is necessary to confirm which Group the
measurement to be added should belong to. If it needs to be added to a new Group, you must
first click Add Group in the Measurement Management window to add a new window, and
then select the newly added window to proceed with the measurement addition.

Note 2: Currently, a maximum of 10 Groups can be added, and each Group can have a mix of
different measurements added to it, with a single Group supporting up to 32 measurements;
among these, each type of measurement supports a maximum addition of 10, for example, a
maximum of 10 5G NR measurements can be added across all Groups.

Note 3: By default, without a license, up to 3 measurements are supported; if more
measurements are needed, the corresponding license must be applied for, with a maximum
support of 32 measurements.

242 Remove Measurement

Currently, SigVSA supports two methods for deleting measurements.

Method 1: In the Measurement Management window, you can quickly select the measurement
you wish to delete and click the x in the upper right corner of the measurement to complete
the deletion.

Note: If none of the measurements in the entire Group are needed, you can also click the x
on the right side of the Group to delete the entire Group along with all the measurements
inside it.
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{5 SIGLENT SigVSA
File Edit Control InputOutput MeasSe

|]] ] 56NR3

Measurement Management

o= AddGroup = New Measurement

+ Group1
S5GNR1 &
OFDM &
JGNR2

« Group2

~ SGNR3

s File (O Remote Device

Method 2: Select Meas Setup -> Remove Measurement, and at the location indicated by the
red box in the image below, click on the measurement you wish to delete.

{J SIGLENT SigVSA
File Edit Control InputOutput = MeasSetup TIrace Markers Window Utilities Help

I]] .| 5GNR2 =+ New Measurement v| A AR ARV

Measurement Management Remove Measurement » 5GNR1

o= 3 = NewMeasureme
B e Measure Management... OFDM 6

~ Group1 :
Current Measurement 2 e
> 5GNR1 &
Measurement Type: 5G NR »
» OFDM6

[5G NR 2] Properties...

» S5GNR2

Group2

2.4.3 Measure Management

SigVSA supports the manual addition of a Measurement Management window. When you click
on Meas Setup -> Measurement Management, a Measurement Management window will be
added to the left of the Trace. In this window, you can quickly perform operations such as

adding or deleting measurements and controlling measurements.
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{7 SIGLENT SigVSA
File Edit Control [nputOutput MeasSetup Trace Markers Window Utilities Help

I]] —_[ 5GNR3 == New Measurement v A A AR

Measurement Management Remove Measurement » le(Trcl)

o = New sureme
1= AddGroup == NewMeasuremer Measure Management...
~ Group1
Current Measurement 3
> S5GNR1 EH
Measurement Type: 5G NR »
> OFDM6 '@

[5G NR 3] Properties...

NR2 '@

~ Group2
-100

v 5GNR3 ‘&
Start Os Stop 22ms

» File O Remote Device 5GNR 3: Spectrum(Trc2)

000
dBm

24.4 Current Measurement

When performing operations such as cursor and trace functions, it is necessary to first specify
which measurement the operation is targeting. Currently, there are two methods to quickly

change the current measurement:

Method 1: In the Measurement Management on the left side, click on the measurement you

wish to operate on;

Method 2: Select the menu Meas Setup -> Current Measurement, and then click on the

measurement you wish to operate on;

After selecting the current measurement, the information of the current measurement will be

displayed in the small window to the right of the toolbar control buttons.

{5 SIGLENT SigVSA
File Edit Control InputOutput MeasSetup Trace Markers Window Utilities Help

I]] ] 5GNR3 == New Measurement v A A ARV

Measurement Manag nent Remove Measurement » fe(Trcl)

= = New sureme
CEEETE o g Measure Management...
v Group1
Curre~t Measurement P SGNR1
> 5GNE1 =
Measuremen: Type:5GNR »| OFDM 6
> OFOME '@

[5G NR 3] Properties. . 5GNR 2

GNR2
5GNR 3

s lsroup2
-100
Start Os

v SGNR3
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24,5 Measurement Type

SigVSA supports rapid conversion between different measurement types. Simply click on Meas

Setup -> Measurement Type, and then select the desired measurement type to switch to.

Currently, eight measurement types are supported for conversion: 5G NR, 4G LTE, OFDM,

WLAN, DMA, UWB, FHSS, and IQA.

{5 SIGLENT SigVSA
File Edit

Measurement Management

Control  Input Output

'] 56NR3

== AddGroup == NewMeasuremer
v Group1

> 5GNR1 0

» OFDM®6

> S5GNR2

v Group2

Meas Setup Trace

Markers Window Utilities Help

L e -

== New Measurement 4
Remove Measurement » le(Trcl)

Measure Management...

Current Measurement >
Measurement Type: 5G NR » 5GNR

AGLTE

[5G NR 3] Properties...

OFDM
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25 Trace

SigVSA, by default, displays 6 Trace windows for each measurement. When more windows are
needed, they can be added through the Trace menu, with each measurement supporting a
maximum of 50 Trace windows. Currently, Trace addition is supported through two methods:
Format and Y scale.

Format: When Format is selected, it can be used to modify the type of Trace.

Y scale: When Y scale is selected, it allows setting the reference level and the scale of the Y-
axis for the Trace.

When adding a Trace, you can freely choose either Format or Y scale. The default Trace type
added is Raw Main Time. If you wish to change the Trace type, select this Trace window and
then click on Trace -> Format to modify the Trace type; if you want to modify the reference
level and Y-axis scale, choose Y scale for adjustments.

To quickly delete a Trace window, open the Trace menu, freely select either Format or Y scale,
choose the Trace you wish to delete, and click "Delete Trace."

26 Markers

2.6.1 Marker Setting

The cursor is a waveform measurement tool that reads data from trace points and, by
combining multiple cursors, can easily measure quantitative information such as signal
frequency, amplitude, and bandwidth. SigVSA supports various types of cursor functions, which
can be accessed from Marker -> Position to enter the cursor setup interface.

SigVSA supports three types of cursors: Normal, Delta, and Fix. The selection of cursor types
can be completed within the cursor setup interface, and it also supports cursor coupling,

allowing for coupled cursor movement across different Traces.
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B 156 NR 1] Marker Setting 4

Trace1 ~  Marker1 @ Close Marker

Position
Marker Type Delta Relative to Varkerd
Marker X 179ms

Marker Y

AllMarkers

Marker Couple ( Marker All Off
Peak Settings

Threshold Enable ( ~  Threshold Value

ExcursionEnable ( ~  ExcursionValue

Note: The cursor coupling function is effective for all cursors within a single measurement
mode.

26.2 Peak Search

SigVSA provides a peak search function, which refers to a series of maximum points on the
trace that are searched and filtered according to certain conditions.

The peak search conditions include peak threshold and peak offset:

Peak Threshold: Specifies the minimum value of the peak amplitude; only extremum points
with an amplitude greater than the peak threshold are identified as peaks. If the peak threshold
is turned off, the actual threshold used for determination is -200 dBm.

Peak Offset: Specifies the difference in amplitude between a peak and the minimum points on
its left and right sides. Except for the two peak points at the far left or far right, a peak point
must have two minimum points on either side with an amplitude difference greater than the
peak offset, and between the two nearest qualifying minimum points on either side of this
peak point, this peak point must be the one with the maximum amplitude. If the peak offset is
turned off, the actual offset used for determination is O dB.

Peak Threshold and Peak Offset Entry: Marker -> Position.
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@ [5G NR 1] Marker Setting ®

Trace1 ~  Marker1 @ Close Marker

Position
Marker Type Delta Relative to Marker 2
Marker X 179ms

Marker Y

AllMarkers

Marker All Off
Peak Settings

Threshold Enable ( ~  Threshold Value

Excursion Enable ( ~  ExcursionValue

The peak search function supports the following features:

Control Key Entry Function

Move the current Marker to the highest Y-
- Peak Control value point on the current Trace; if the polar
ea
Menu/Toolbar (IQ) data format is selected, the highest point

is the one with the greatest magnitude.

Move the current Marker to the next highest
- Next Peak Control Menu i
Y-value point on the current Trace.
Control Move the current cursor to the left to the next
- Peak Left ) )
Menu/Toolbar valid peak point on the current Trace.
. Control Move the current cursor to the right to the
- Peak Right ] ]
Menu/Toolbar next valid peak point on the current Trace.
L Control Move the current Marker to the lowest Y-value
- Peak Minimum i
Menu/Toolbar point on the current Trace.

Note: To perform peak operations on a specific cursor, you must first select the corresponding

cursor through the menu bar.

27 Window

In addition to the conventional Trace windows, SigVSA also supports additional Marker
windows and Measurement Management windows to facilitate quick operations.
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Y7 SIGLENT SigVSA - & x
Fle Edt Gontrol |npuOutput MessSetwp Irace Morkers Window Utiitios telp

mom CLL ;
Meassuramant Mana gemer . SGNR1:RawMainTime(Tre) o r SGNR1:RE Alkocation(Trc4) % | SGNR1.RMSError Vector Spactrum(TreT)

i AddGroup i NewMeasurament

o i e

oy CrS it

Markers

> 5GNR1 1RawMain Time Mkrl 1589ms -45154dBm

Marker Window: Used to display all Markers associated with the current Traces.

Measurement Management Window: The measurement management window is used to view

all current measurements, allowing for the management of measurements through grouping.

In addition to incremental windows, SigVSA also supports a wealth of auxiliary functions for

existing windows:

Only Display Current Measurement: When multiple measurements exist, the concentration of
Traces from different measurements can make observation inconvenient. Selecting this
interface will display only the Traces corresponding to the current measurement.

{5 SIGLENT SigVSA
Ele Edit Control |nputOutput MeasSetup Irace Markers Window Utilites Help

m \] 4GuTET WEE Ok, Makes
Measurement Management LTE1:RawMainTin  Qutput ] % ¥ LTE1:KQMeasTime(Trc3)

s I
i~ AddGroup -{- NewMeasurement A e

000 150

~ Group1 dBm
& Only Display Current Measurement
> SGNR1 W
Trace Window Layout
> 5GNR2 i
Trace Window Resize

v 4GLTE1 g
Delete All Empty Window

LTE 1:Error Summary(Tred) X | ¥ LTE1:RMSError Vector Spectrum(Trc8)

200
%

Span 1536MHz

Trace Window Layout
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Single All Traces are displayed within a single Tab Group.
Stack N N Trace windows are displayed stacked on top of each other.
Grid NxM A grid of Trace windows with N rows and M columns.

Cust A customizable layout dialog can be invoked to define the number
ustom
of rows and columns in the grid to be displayed.

5GNR1:Raw Main Time(Trc1) || 5GNR1: Spectrum(Tre2) | 5SGNR1:RawMain Time(Tre3) | 5G NR 1:Raw Main Time(Trc5) | SGNR1:Raw Main Time(Trc6) | 3G NR 1:RawMain Time(Trc7) 5GNE1:RawMainTime(TrcSl[

M \' i ”“M“"\h'ﬂ“’m

(e

00
Start Os Stop 22ms

Stack N
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5GNR1:Raw MamTwﬁeETlcﬂ| 5GNR1:RawMainTime(Trc8)

Convi N

5GNR1: Spectrum(Trc2)

Center 1GHz

5GNR1:RawMain Time(Trc3)

Start 0s

5GNR 1-RawMain Time(Trc5)

Start Os

5GNR1:RawMain Time(Trc6)

Start 0s

5GNR1:RawMain Time(TreT)

Start 0s

5GNR 1:RawMain Time(Trc8) {

Start Os Stop 22ms
S5GNR 1: Spectrum(Tre2)

Center 1GHz Span 768 MHz
5GNR 1:RawMain Time(Trc3)

Stop 22ms

Custom

5GNR 1:Raw Main Time(Trc5)

000

Start Os

5GNR1:RawMain Time(Trc€)

000

100
Mdiv

-100
Start Os

5GNR 1:Raw Main Time(Trc7)

000 #

100
fdiv

-100

Span 768 MHz

Stop 22ms

Stop 22ms

Stop 22ms

Stop 22ms

Stop 22ms

Stop 22ms

Stop 22ms
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¥ 5GNR1:RawMain Time(Trc1) % | ¥ 5GNR1:RawMain Time(Trc3) % | % 5GNR1:RawMain Time(Trc6) % % 5GNR1:RawMain Time(TrcB) o X
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768 MHz

Trace Window Resize: SigVSA supports the addition of multiple windows for display. Windows
added via the Trace method are displayed side by side. To better view different Trace windows,

you can click on Trace Window Resize to tile all windows for display.

566N S

Delete All Empty Window: When a Trace window shows No Data, you can quickly close all
windows without data by clicking on Delete All Empty Window.

5G NR 1: Raw Main Time(Trc1) ® NoData
Mkr1 11
000 Ml iptutrspsp ey A A
Lru_m;'r-m]'

100

fdiv
-100

Start Os Stop 22ms

56 NR1:Spectrum(Trc2) 5GNR 1:Raw Main Time(Trc5)

-383 000

100
fdiv

-100
Center 1GHz Span 768 MHz Start Os Stop 22ms
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28 Utilities

SigVSA supports two functionalities: file analysis and real-time analysis through connection to
the underlying hardware. The Utilities feature allows for convenient configuration of the
underlying hardware information.

Remote Device Management:

Used for adding, deleting, and connecting to the underlying hardware, among other functions.
After entering the IP address of the underlying hardware to add and connect the device, you
can associate the measurement window through the Data Source Setting interface. Once
associated, the information is displayed as follows:

B Remote Device Management X

Model Serial Protocol Status Binding Window AddDevice

SOCKET 1012666 online OFDM 6 OFDM Remaove Device
Connect Device

Disconnect Device

Data Source Setting:
The data source can be set through two entry points:

@ Under the measurement management directory, select the measurement to be associated,
and choose to connect and analyze either through File or a remote underlying hardware.

@ Select Utilities -> Data Source Setting, and in the pop-up window interface, choose to
connect and analyze through File or a remote underlying hardware. Typically, method one
is simpler and faster.

Note: When using method two for association, it is necessary to explicitly select the
measurement to be associated, otherwise, the associated measurement may not match the

expectation.
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{5 SIGLENT SigVSA
File Edit Control |nputOutput MeasSetup Trace Markers Window Utilities Help

MmE Joom =~ w=EE - 7 7

Measurement Management OFDM1:Raw Main TimeTrc 1

o= AddGroup = New Measurement
000

Group1 x dBm

v OFDM1 '@ in

» File () Remote De & [OFDM 1] Data Source Settings

Browse...

(O Remote Device

Cancel
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3 Measurement

31 QA

3.1.1 Configuration

The path to access the IQA configuration interface is: Meas Setup -> IQA Properties.

; SIGLENT SigVSA
File Edit Control InputOutput MeasSetup Trace Markers Wir

I]] _: QA1 == New Measurement N

Measurement Management Remove Measurement

o= AddGroup rl= NewMeasuremet

Current Measurement
~ Group1

- 10A1 i

Measure Management...

Measurement Type: IOA

e File () Remotel .
[IQA 1] Properties...

3.1.1.1 Meas

1. Meas Time

Set the measurement duration.

2. Sample Rate

Set the sampling rate.

3. Center Freq

Set the center frequency.

3.1.2 Measurement Results

The path to set IQA measurement results is: Trace -> Format.
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B 1104 1] Trace Setting et

Trace1 o= AddTrace (%) Delete Trace

Format

Data Result |-Real

Setup Steps:
1) Select the display window.

2) Choose Result to switch the measurement result data to be displayed.

Example of Measurement Results:

3 SIGLENT SigVSA -8 x
Fle EGt Control InptOutpt MeasSetp Trace Markers Window Utiites Help
> 1] 1oa1 - Y,
[T — ¢ QA 1: -RaakTrct)
 AddGroup + NewMeasurement
Groupl

~ QA1 &

1. Real

Displays the time-domain waveform of the I-channel data.

2. Q-lmag

Displays the time-domain waveform of the Q-channel data.

3. RF Envelop
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RF envelope diagram, showing the time-domain waveform of IQ data.

4. Wrap Phase

Wrapped phase diagram.

5. Unwrap Phase

Unwrapped phase diagram.

6. Spectrum

Frequency spectrum diagram.

32 OFDM

3.2.1 Configuration

The path to enter the OFDM configuration interface is: Meas Setup -> OFDM Properties.

File Edit Control InputOutput MeasSetup Trace Markers Wi

I]] _: OFDMA + New Measurement b

Measurement Management Remove Measurement

e 3 = New Measureme
i AddGroup sz NewMeasureme Measure Management...

¢+ Group1
Current Measurement 3

. OFDM1 i

Measurement Type: OFDM »

« File 7 Remote [ _
) [OFDM 1] Properties...

.';Ij iv
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3.2.1.1 Meas Time

A

Search Length >

< Meas ; |
<« >
Of fset > Meas Interval :

\ 4

/< Result Length

Analysis Boundary

1. Search Length

Specify the amount or length of input data to include in the measurement burst search.
Range: 0 ~ 100 s, Default: 512 us for WLAN 802.11a; 20ms for LTE DL/UL.

Unit options: ns | s | ys | s, Default: ps.

Note: The minimum value of Search Length is also limited by the value of Result Length, and
the actual minimum value of the sampling time for each OFDM symbol is greater than 0.

2. Result Length

Used to specify the amount of collected time data (in symbols) available for measurement
analysis. For OFDM, the result length data includes the preamble and payload data symbols
starting from the first preamble symbol in the measurement burst.

Default: 64.

Range: 1 - The number of OFDM symbols corresponding to Search Length.

3. Meas Interval

Specify the length of time (in integer symbols) for the data measurement range in Result
Length, used to calculate and display tracking data results.

The Meas Offset parameter is used to locate the starting point of the measurement interval
data, related to the first symbol in the measurement burst. The sum of Meas Interval and Meas
Offset must fit within the range of the measurement Result Length, with the Result Length and
Result Length Selection properties determining the maximum length of time (in symbols) that
Meas Interval can locate.
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Default: 64.

Range: 1 - Result Length.

4. Meas Offset

Set the time offset (in symbols) for the measurement range. Specifies the starting position of
Meas Interval relative to the first symbol within Result Length.

Default: 0.

Range: 0 — (Result Length - Meas Interval).

5. Down Sampling Ratio
Specify the downsampling factor for the received signal.
Default: 1,

Range: Positive integer. Data type: Integer.

3.2.1.2 Format

1. FFT Length
The FFT length used for OFDM transmission, must be a power of 2.
Default: 64.

Range: 4 to 65536. Data type: Integer.

2. Sys Sample Freq

System sampling rate, in Hz. Data type: Float.

3. Guard Lower Subcarriers
Set the number of lower guard subcarriers.

Default: O - FFT Length/2.

4. Guard Upper Subcarriers

Set the number of upper guard subcarriers.
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Default: 0 - (FFT Length - Guard Lower Subcarriers - 1).

5. Half Subcarrier Shift

This parameter is needed for demodulating LTE OFDM. Enables or disables the half subcarrier
shift of phase reset at each OFDM symbol (i.e., LTE uplink signal). Data type: Boolean.

6. DFT Spread

Demodulate SC-OFDM, LTE uplink signal. Data type: Boolean.

7. Transmitter Window Beta

Set how much windowing is used at the transmitter to smooth transitions between symbols.
Specified as a fraction of the OFDM FFT length. This value is unitless (not a percentage).

Default: 0.005.
Range: 0 - Guardinterval. Data type: Float.

This parameter specifies the window filter Beta value. Beta is the amount of windowing used
by the transmitter to smooth transitions between symbols.

3.2.1.3 Mapping

1. Pilot1Q

Pilot data I1Q values.

2. Preamble IQ

Preamble data IQ values.

3. Resource Mapping

Resource grid distribution, the resource mapping file defines the function of each subcarrier in
each symbol, describing whether the subcarrier is Preamble, Pilot, Data, or null subcarrier type.
The resource mapping file must contain one value for each valid (i.e., non-guard) subcarrier,
including the "DC" center subcarrier. Therefore, a mapping for an 802.11a/g signal (FFT size of
64, with 11 guard subcarriers) will contain 53 values per symbol. If the number of pilots in the
pilot value array is insufficient to fill the resource mapping, the pilot values are repeated to fill
the remaining resource mapping pilot positions.
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4. Guard Interval

Set the guard interval (also known as cyclic prefix) for each symbol individually. Each is
specified as a fraction of the OFDM FFT length. This value is unitless (not a percentage). Guard
Interval is typically between 1/16 to 1/4, entered in decimal form.

Default: 0.25.
Range: 0 - 1. Data type: Float.

Note: Ensure that the result of FFTLength*Guardinterval is an integer based on the FFT Length.

5. Guard Interval Repeat Index

If the Guard Interval array is at least as long as the measurement result length, it provides a
guard interval value for each symbol. If the array is shorter than the measurement result length,
the array is cycled (and continues to cycle each time the end of the array is reached again). The
position cycled back to in the array is determined by the Guard Interval Repeat Index.

Default: 0.

Range: O - (array length - 1).

6. Time Gap

Set the time gap before the start of each OFDM symbol. Each is specified as the number of
samples at the OFDM system sampling frequency.

Default: 0.

Range: Non-negative integer.

7. Time Gap Repeat Index

If the Time Gaps array is at least as long as the measurement result length, it provides a time
gap value for each symbol. If the array is shorter than the measurement result length, the array
is cycled (and continues to cycle each time the end of the array is reached again). The position
cycled back to in the array is determined by the Repeat Index. This repeat index works in the
same way as the Guard Interval Repeat Index and Guard Interval array.
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3.2.1.4 Equalizer

1. Use Data
Enable/disable the use of data subcarriers to assist in training the equalizer.

Default: Off.

2. Use DC Pilot

Specify whether the pilot subcarrier on the DC is used for channel estimation. This only applies
when Equalizer Use Pilots is enabled and the resource mapping specifies that the DC subcarrier
is a pilot.

3. Use Pilot

Enable/disable the use of pilot subcarriers to assist in training the equalizer. Note: The DC
subcarrier is ignored; to include the DC subcarrier, enable Equalizer Use DC Pilot.

4. Use Preamble

Enable/disable the use of preamble subcarriers to assist in training the equalizer. After
initialization, the equalizer coefficients remain unchanged while demodulating the rest of the
OFDM burst.

5. Initial Mode

Set the mode used to construct the initial equalizer. When creating the initial channel equalizer,
the Custom OFDM analysis attempts to use any available information from known pilot and
preamble subcarriers. The initial equalizer mode controls which symbols are included when
searching for known pilot and preamble subcarriers. It can be set to Automatic or Manual.

Default: Automatic.

Automatic: Custom OFDM analysis attempts to use all symbols containing known pilot or

preamble subcarriers.

Manual: The user specifies the number of symbols to use. The number of symbols is specified
by the Initial Equalizer Symbols property. Manual mode may be useful for signals without a
preamble and with known pilots in many symbols. If there is significant frequency drift, an

initial equalizer built with fewer symbols may be more accurate.
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6. Initial Symbol

Specify the number of symbols used when the initial equalizer mode is set to manual. Data
type: Integer.

Default: 4Symbol.

3.2.1.5 Tracking

1. Include Data Subcarriers

Enable/disable the use of data subcarriers in phase, amplitude, and timing tracking. When
enabled, the VSA uses pilot and data subcarriers in phase, amplitude, and timing tracking.
When disabled, the VSA only uses pilot subcarriers for tracking (default is disabled).

Some signal formats (e.g., LTE and LTE-related formats) do not include pilots in every symbol.
In such cases, selecting this setting will improve EVM by ensuring tracking for symbols without
pilot subcarriers.

2. Track Amplitude

Enable/disable tracking and compensation of pilot subcarrier amplitude. The VSA applies pilot

subcarrier amplitude error correction to pilot and data subcarriers (default is enabled).

3. Track Phase

Enable/disable tracking and compensation of pilot subcarrier phase. The VSA applies pilot

subcarrier phase error correction to pilot and data subcarriers (default is enabled).

4. Track Timing

Enable/disable tracking and compensation of pilot phase ramp (symbol clock timing). The VSA
applies pilot subcarrier timing error correction (frequency offset correction) to pilot and data
subcarriers (default is enabled).

3.2.1.6 Advanced

1. Filter Type

Filter type.
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Default: None.

2. Meas Standard
Preset demodulation OFDM standard signal types.

Default: WIFI.

3. Timing Adjust

Set the symbol timing adjustment. This value is a percentage of the OFDM FFT length. The
value is negative because it represents an adjustment from the end of the OFDM symbol.

Default: -12.5%.

Range: 0 — GuardIntervalPerSymbol.

4. Sync Mode
Set the synchronization mode used for signal synchronization.

Time Correlation: The VSA uses time correlation between the user-defined preamble and the
measured signal to synchronize to the start of the OFDM burst.

Cyclic Prefix: Synchronizes the start of the OFDM burst to the cyclic prefix.

5. Center Frequence
Signal center frequency.

Default: 1GHz.

6. Report Evm In db
Enable switch for converting EVM to dB units.

Default: Off.

3.2.2 Measurement Result

The path to set OFDM measurement results is: Trace -> Format.
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Trace1 o= AddTrace (%) Delete Trace

Format

Data Group Pre-demod

Data Result Raw Main Time

Setup steps:
1) Select the display window;
2) Select Group, different measurement results are placed in different groups;

3) Select the measurement result data to display.

1. Raw Main Time

Display the magnitude of raw data input from hardware or read from a playback file, with time
on the x-axis and amplitude on the y-axis.

2. Spectrum

Display the spectrum of raw data input from hardware or read from a playback file, with
frequency on the x-axis and amplitude on the y-axis.

3. 1Q Meas Time

IQ Measurement Time displays the constellation diagram of data within the measurement
length, with amplitude (normalized amplitude) on both the x-axis and y-axis.

4. Error Summary

Error Summary includes the following error items of the measurement results:
EVM: Average EVM value of all Pilot, Preamble, Data;

EVM Peak: Peak EVM value of all Pilot, Preamble, Data;

Pilot EVM: Average EVM value of all Pilot;

Data EVM: Average EVM value of all Data;
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Preamble EVM: Average EVM value of all Preamble;
SNR/MER: Signal-to-noise ratio;
Freq Error: Frequency offset relative to the carrier center;

Sync Corr: Correlation between measured synchronization

synchronization signal;

Tx Power: Transmit signal power.

3.3 Digital Modulation(DMA)

3.3.1 Configuration

signal

and

reference

The path to enter the DMA configuration interface is: Meas Setup -> DMA Properties.

{; SIGLENT SigVSA
File Edit Control InputOutput MeasSetup Trace Markers

I]] _j DMA1 | = New Measurement

Window

— —v

Measurement Management Remove Measurement » [Trcl)

o= AddGroup = NewMeasuremei

Current Measurement
~ Group1

- DMA1 moe

Measure Management...

Measurement Type: DMA »

# File () Remote [ )
B [DMA 1] Properties...

3.3.1.1 Frame

1. Search Length

Set the data length of the collected Raw Data, with units in us/ms. The adjustable range

depends on the device's IQ acquisition capability, with a default value of 610 us.

2. Segment Number

Set the number of segments per frame of data. This is an integer value without units, ranging

from 1 to 6, with a default value of 1.
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3. Segment Selected

Select the segment, with Segment 0 as the default.

4. Burst Search
Pulse Search Switch: On/Off, default setting is Off.

5. Burst Search Threshold

Pulse search threshold, default value: -15 dB, minimum: -200.0, maximum: 200.0.

6. Sync Search

Synchronization search switch, On/Off, default is Off.

7. Sync Offset

Specify the time (in symbols) between the start of the measurement data and the start of the
synchronization word. If the value is positive, the synchronization word starts after the
beginning of the measurement data. If the value is negative, the synchronization word starts

before the beginning of the measurement data.

8. Sync Pattern

Set the input synchronization sequence format.

9. Sample Rate

Set the demodulation sampling rate mode, default is Auto.

3.3.1.2 Meas Time

1. Meas Interval Symbol

Measurement length refers to the data length used for calculating EVM, measured in symbols
(Symbols).
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2. Meas Offset Symbol

Measurement offset, relative to the Meas Offset Ref, unit: symbols (Symbols).

3. Meas Offset Reference
Set the reference point for the offset, with two options available.

® Relative To Capture: Specifies that the offset of the segment is relative to the start of the
captured data.

® Relative To Sync Pattern: The offset of the segment is relative to the starting position of
the synchronization pattern.

3.3.1.3 Demod

1. Modulation Type

Set the modulation format category of the signal to be demodulated, with the default
parameter being PSK.

2. PSK Formats

Set the subcategory of the PSK modulation format for the signal to be demodulated. The
default parameter is BPSK.

3. QAM Formats

Set the subcategory of the QAM modulation format for the signal to be demodulated, with the
default parameter being 16QAM.

4. FSK Formats

Set the subcategory of the FSK modulation format for the signal to be demodulated, with the
default parameter being 2FSK.

5. MSK Formats

Set the modulation format subclass for the demodulated MSK signal, with the default
parameter as MSK Type1.
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6. ASK Formats

Set the subcategory of the MSK modulation format for the signal to be demodulated, with the
default parameter being MSK Type1.

7. APSK Formats

Set the subcategory of the APSK modulation format for the signal to be demodulated, with the
default parameter being 16-APSK.

8. OQPSK Formats

Set the subcategory of the OQPSK modulation format for the signal to be demodulated, with
the default parameter being Offset QPSK.

9. DPSK Formats

Set the subcategory of the DPSK modulation format for the signal to be demodulated, with
the default parameter being DBPSK.

10. Points

Set the number of points displayed per symbol in the time-domain representation of the

demodulated data.

11. Symbol Rate

Set the symbol rate (symbols per second) for the digital demodulator. Max BW represents the
selected bandwidth; for PC-segment VSA, the maximum bandwidth is 20 GHz.

12. Bandwidth

Set the multicarrier filter bandwidth.

13. Meas Filter

Set the measurement filter type, with the default parameter being Root Raised Cosine.
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14. Ref Filter

Set the reference filter type, with the default parameter being Raised Cosine.

15. Alpha

The shape and bandwidth of the filter are defined by alpha (for cosine filters) or BT (for
Gaussian filters).

16. Filter Length

Set the length of the instrument equalization filter.

17. Equalizer

Enable or disable the adaptive equalization filter. Adaptive equalization uses the measured
signal to determine the coefficients of the equalization filter.

18. Equalizer Filter Length

Set the length of the instrument equalization filter in symbols.

19. Hold

Enable or disable filter coefficient updates. Typically, the adaptive algorithm updates the filter
coefficients after each scan. When Hold is enabled, the coefficients of the equalization filter
are frozen—meaning the adaptive filter becomes fixed. Disabling Hold again will allow the
coefficients to resume adaptation from their current positions.

20. Coefficient

Setting the adaptive filter convergence factor higher results in faster convergence speed.

21. FFT Window

Set the window function used for calculating the spectrum with FFT.
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22. Multi-Carrier Filter

Specify whether to apply a filter to the acquired IQ data to filter out adjacent carriers.

23. Spectrum

Set the spectrum to Normal or Invert for demodulation-related measurements. If set to Invert,
the upper and lower spectra are swapped.

24. Gain Imb/Quad Skew Couping

Control the measurement data included in the calculation of quadrature tilt error and 1Q gain

imbalance error.
Off (default value): Calculates using one point per symbol.

On: Calculations use the value displayed in the "Points per Symbol" parameter box.

25. Clock Adjust

Adjust the symbol clock timing in fractional multiples of symbols.

26. 1Q Normalize

Enable or disable IQ Normalize. When enabled, measurement errors will be normalized, with
the normalization coefficient determined based on the setting of EVM Normalization

Reference.

27. 1Q Rotation

Rotate the IQ Meas/Ref Time data and the corresponding ideal constellation points by a user-
defined amount, specified in degrees, ranging from -360 to 360 degrees. The Rotation
parameter affects the 1Q Gain Imbalance and Quadrature Skew error data results.

28. 1Q Normalize

Enable or disable IQ Normalize. When enabled, measurement errors will be normalized, with
the normalization coefficient determined based on the EVM Normalization Reference setting.

29 Low SNR Enhancement
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Enhance the demodulator's ability to lock onto low SNR signals.

30. EVM Normalization Reference
The EVM normalization reference has two possible values:

Constellation Maximum (Default): Sets the normalization value to the maximum constellation
amplitude. For "cross-QAM" constellations (32QAM, 128QAM, 512QAM), the normalization
value will be set to the magnitude of the outer corners of the square containing the
constellation, even if the constellation itself does not actually use those outer corners.

Reference RMS: Sets the normalization value to the RMS level of the IQ reference symbol points.
If the only impairment in the input signal is additive white Gaussian noise, using Reference
RMS will make the average EVM approximately equal to the reciprocal of the signal's signal-
to-noise ratio. Using Reference RMS also makes it easier to compare EVM values between
signals with different modulation formats.

31. 1Q Offset Compensation

Before calculating metrics such as EVM, select whether to compensate for 1Q offset during

parameter estimation and compensation timing.
Applicable only to IQ modulation formats other than FSK, ASK, CPM (FM), and DVB QAM.

It automatically turns on if the modulation format is changed to any format other than MSK

Typel. For the MSK Type1 format, it automatically turns off.

32. Average Move Length

Average move length.

3.3.1.4 Ber

Ber State

Enable or disable Tx BER. When Tx BER is enabled, the results for bit error rate, error bits, and
total bits will be displayed in the Demodulated Bits window.
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3.3.2 Measurement Results

The DMA measurement result settings path is: Trace -> Format.

B [DMA 1] Trace Setting e

Tracel o= AddTrace (%) Delete Trace

Format
Data Group Demod
Data Result 12 Meas Time
Segment Selected

Format Constellation

Setup Steps:

1)
2)
3)
4)

Select the display window.
Choose a Group to organize different measurement results into separate categories.
Select Result to switch the measurement result data to be displayed.

Choose Format to switch the format of the displayed measurement results.

Example of Measurement Results (1024QAM):
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 SIGLENT SigVSA _ 5 x
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1. Raw Main Time

Displays the magnitude of the captured raw IQ data, with the demodulated data positions
marked. The horizontal axis is in time units (s, ms, us, ns, depending on the data format), and
the vertical axis units are determined by the data format.

The definitions of various data formats are the same as those for IQ Meas Time.

2. Spectrum

Displays the spectrogram of 1Q data before demodulation, which is the FFT of Raw Main Time.
The horizontal axis is in frequency units (Hz, kHz, MHz, depending on the data format), and
the vertical axis units are determined by the data format.

The definitions of various data formats are the same as those for IQ Meas Time.

3. Time

The magnitude of the resampled IQ data, with demodulated data positions marked. The
horizontal axis is in time units (s, ms, us, ns, depending on the data format), and the vertical

axis units are determined by the data format.

The definitions of various data formats are the same as those for IQ Meas Time.

4. 1Q Meas Time
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Displays the time-domain representation of the measured 1Q data. The horizontal axis is in
units of symbols (depending on the data format), and the vertical axis units are determined by
the data format.

1) LogMag: The logarithmic magnitude of the measured data, calculated using the formula:
20 * log10( | a(n) | ).
2) LineMag: The linear magnitude of the measured data, calculated using the formula: | a(n)

|, supports only normalized amplitude.

3) Real/Imag: Displays the real or imaginary part of the data. Requires marking the decision
point positions and supports only normalized amplitude.

4) Wrap Phase: Displays the phase of the data, with the phase folded into the range of -1t to
.. The decision point positions must be marked. The calculation formula is: angle( a(n) ).

5) UnWrap Phase: Displays the unwrapped phase of the data. Decision point positions must
be marked. The calculation formula is: angle( a(n) ), followed by phase unwrapping.

6) |-Q: Displays the 1Q values of the data as a two-dimensional image. Decision point
positions must be marked. Only normalized amplitude is supported

7) Constellation: Displays the data in a constellation diagram format, which shows only the
values at the decision points. Decision point positions must be marked. Only normalized

amplitude is supported.

8) I-Eye/Q-Eye: Displays the real or imaginary part of the data in an eye diagram format. By
default, the horizontal axis shows the overlay of 3 symbols, but more symbols can be
configured. The eye diagram is implemented by plotting multiple symbols together and
overlaying them, with the default being 3 symbols. Only normalized amplitude is
supported.

9) Group Delay: Displays the group delay of the data. The calculation formula is: iff( angle( a(n)
) ). where diff represents the difference calculation.

5. 1QRef Time

Displays the time-domain representation of the reference IQ data. The horizontal axis is in units
of symbols (depending on the data format), and the vertical axis units are determined by the
data format.

The definitions of various data formats are the same as those for IQ Meas Time.

6. 1Q Meas Spectrum

Displays the spectrum of the measured IQ data, calculated by performing FFT on the measured
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data. The horizontal axis is in frequency units (Hz, kHz, MHz), and the vertical axis is in dB.

7. Error Vector Time

The magnitude of the vector error. The horizontal axis is in units of symbols (depending on the
data format), and the vertical axis units are determined by the data format.

The definitions of various data formats are the same as those for IQ Meas Time.

8. Error Vector Spectrum

The spectrum of the vector error. The horizontal axis is in frequency units (Hz, kHz, MHz), and
the vertical axis is in logarithmic percentage units (dB%).

9. Mag Error

The amplitude error between the measured and reference signals. The horizontal axis is in units
of symbols (depending on the data format), and the vertical axis units are determined by the
data format.

The definitions of various data formats are the same as those for IQ Meas Time.

10. Phase Error

The phase error between the measured and reference signals. The horizontal axis is in units of
symbols (depending on the data format), and the vertical axis units are determined by the data

format.

The definitions of various data formats are the same as those for IQ Meas Time.

11. Error Summary

Display the demodulated data table:

Parameters for QAM:

1) EVM: RMS and peak, unit: %|m%|n%|dB.

2) Mag Error: RMS and peak, unit: %|m%|n%.

3) Phase Error: RMS and peak, unit: deg|mdeg.

4) Freq Error: Carrier frequency offset, unit: mHz|Hz|kHz|MHz.

5) Clock Error: Sampling clock deviation, unit: mHz|Hz|kHz|MHz.

62 www.siglent.com



SigVSA Vector Signal Analysis Software User Manual

6) 1Q Offset: 1Q offset, unit: dB.
7) SNR (MER): Signal-to-noise ratio, unit: dB.
8) Quad Error: Quadrature error, unit: deg.

9) Gain Imbalance: IQ imbalance, unit: dB.

12. Demod Bits

Display the demodulated bits. Mark the synchronization results when the synchronization
function is enabled. When BER is enabled, this table includes BER results.

Example of Measurement Results (32APSK):

{7 SIGLENT SigVSA - 5 x

1. Raw Main Time

Displays the magnitude of the captured raw IQ data, with demodulated data positions marked.
The horizontal axis is in time units (s, ms, us, ns, depending on the data format), and the vertical
axis units are determined by the data format.

The definitions of various data formats are the same as those for IQ Meas Time.

2. Spectrum

Displays the spectrogram of 1Q data before demodulation, which is the FFT of Raw Main Time.

The horizontal axis is in frequency units (Hz, kHz, MHz, depending on the data format), and
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the vertical axis units are determined by the data format.

The definitions of various data formats are the same as those for IQ Meas Time.

3. Time

The magnitude of the resampled IQ data, with demodulated data positions marked. The
horizontal axis is in time units (s, ms, us, ns, depending on the data format), and the vertical
axis units are determined by the data format.

The definitions of various data formats are the same as those for IQ Meas Time.

4. 1Q Meas Time

Displays the time-domain representation of the measured 1Q data. The horizontal axis is in
units of symbols (depending on the data format), and the vertical axis units are determined by
the data format.

1) LogMag: The logarithmic magnitude of the measured data, calculated using the formula:
20 * log10( | a(n) | ).

2) LineMag: The linear magnitude of the measured data, calculated using the formula: | a(n)

|, supports only normalized amplitude.

3) Real/Imag: Displays the real or imaginary part of the data. Requires marking the decision

point positions and supports only normalized amplitude.

4) Wrap Phase: Displays the phase of the data, with the phase folded into the range of -1t to
.. The decision point positions must be marked. The calculation formula is: angle( a(n) ).

5) UnWrap Phase: Displays the unwrapped phase of the data. Decision point positions must
be marked. The calculation formula is: angle( a(n) ), followed by phase unwrapping.

6) |-Q: Displays the 1Q values of the data as a two-dimensional image. Decision point
positions must be marked. Only normalized amplitude is supported

7) Constellation: Displays the data in a constellation diagram format, which shows only the
values at the decision points. Decision point positions must be marked. Only normalized
amplitude is supported.

8) |-Eye/Q-Eye: Displays the real or imaginary part of the data in an eye diagram format. By
default, the horizontal axis shows the overlay of 3 symbols, but more symbols can be
configured. The eye diagram is implemented by plotting multiple symbols together and
overlaying them, with the default being 3 symbols. Only normalized amplitude is
supported.
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9) Group Delay: Displays the group delay of the data. The calculation formula is:
diff( angle( a(n) ) ), where diff represents the difference calculation.

5. 1QRef Time

Displays the time-domain representation of the reference IQ data. The horizontal axis is in units
of symbols (depending on the data format), and the vertical axis units are determined by the
data format.

The definitions of various data formats are the same as those for IQ Meas Time.

6. 1Q Meas Spectrum

Displays the spectrum of the measured IQ data, calculated by performing FFT on the measured
data. The horizontal axis is in frequency units (Hz, kHz, MHz), and the vertical axis is in dB.

7. Error Vector Time

The magnitude of the vector error. The horizontal axis is in units of symbols (depending on the
data format), and the vertical axis units are determined by the data format.

The definitions of various data formats are the same as those for IQ Meas Time.

8. Error Vector Spectrum

The spectrum of the vector error. The horizontal axis is in frequency units (Hz, kHz, MHz), and

the vertical axis is in logarithmic percentage units (dB%).

9. Mag Error

The amplitude error between the measured and reference signals. The horizontal axis is in units
of symbols (depending on the data format), and the vertical axis units are determined by the
data format.

The definitions of various data formats are the same as those for IQ Meas Time.

10. Phase Error

The phase error between the measured and reference signals. The horizontal axis is in units of
symbols (depending on the data format), and the vertical axis units are determined by the data

format.
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The definitions of various data formats are the same as those for IQ Meas Time.

11. Error Summary

Display the demodulated data table:

Parameters for QAM:

1) EVM: RMS and peak, unit: %|m%|n%|dB.

2) Mag Error: RMS and peak, unit: %|m%|n%.

3) Phase Error: RMS and peak, unit: deg|mdeg.

4) Freq Error: Carrier frequency offset, unit: mHz|Hz|kHz|MHz.
5) Clock Error: Sampling clock deviation, unit: mHz|Hz|kHz|MHz.
6) 1Q Offset: IQ offset, unit: dB.

7) SNR (MER): Signal-to-noise ratio, unit: dB.

8) Quad Error: Quadrature error, unit: deg.

9) Gain Imbalance: IQ imbalance, unit: dB.

12. Demod Bits

Display the demodulated bits. Mark the synchronization results when the synchronization
function is enabled. When BER is enabled, this table includes BER results.

Example of Measurement Results (16FSK):
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1. Raw Main Time

Displays the magnitude of the captured raw IQ data, with demodulated data positions marked.
The horizontal axis is in time units (s, ms, us, ns, depending on the data format), and the vertical
axis units are determined by the data format.

The definitions of various data formats are the same as those for IQ Meas Time.

2. Spectrum

Displays the spectrogram of 1Q data before demodulation, which is the FFT of Raw Main Time.
The horizontal axis is in frequency units (Hz, kHz, MHz, depending on the data format), and
the vertical axis units are determined by the data format.

The definitions of various data formats are the same as those for IQ Meas Time.

3. Time

The magnitude of the resampled IQ data, with demodulated data positions marked. The
horizontal axis is in time units (s, ms, us, ns, depending on the data format), and the vertical

axis units are determined by the data format.

The definitions of various data formats are the same as those for IQ Meas Time.

4. 1Q Meas Time
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Displays the time-domain representation of the measured 1Q data. The horizontal axis is in
units of symbols (depending on the data format), and the vertical axis units are determined by
the data format.

1) LogMag: The logarithmic magnitude of the measured data, calculated using the formula:
20 * log10( | a(n) | ).
2) LineMag: The linear magnitude of the measured data, calculated using the formula: | a(n)

|, supports only normalized amplitude.

3) Real/Imag: Displays the real or imaginary part of the data. Requires marking the decision
point positions and supports only normalized amplitude.

4) Wrap Phase: Displays the phase of the data, with the phase folded into the range of -1t to
.. The decision point positions must be marked. The calculation formula is: angle( a(n) ).

5) UnWrap Phase: Displays the unwrapped phase of the data. Decision point positions must
be marked. The calculation formula is: angle( a(n) ), followed by phase unwrapping.

6) |-Q: Displays the 1Q values of the data as a two-dimensional image. Decision point
positions must be marked. Only normalized amplitude is supported.

7) Constellation: Displays the data in a constellation diagram format, which shows only the
values at the decision points. Decision point positions must be marked. Only normalized

amplitude is supported.

8) I-Eye/Q-Eye: Displays the real or imaginary part of the data in an eye diagram format. By
default, the horizontal axis shows the overlay of 3 symbols, but more symbols can be
configured. The eye diagram is implemented by plotting multiple symbols together and
overlaying them, with the default being 3 symbols. Only normalized amplitude is
supported.

9) Group Delay: Displays the group delay of the data. The calculation formula is:
diff( angle( a(n) ) ), where diff represents the difference calculation.

5. 1QRef Time

Displays the time-domain representation of the reference IQ data. The horizontal axis is in units
of symbols (depending on the data format), and the vertical axis units are determined by the
data format.

The definitions of various data formats are the same as those for IQ Meas Time.

6. 1Q Meas Spectrum

Displays the spectrum of the measured IQ data, calculated by performing FFT on the measured
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data. The horizontal axis is in frequency units (Hz, kHz, MHz), and the vertical axis is in dB.

7. Error Vector Time

The magnitude of the vector error. The horizontal axis is in units of symbols (depending on the
data format), and the vertical axis units are determined by the data format.

The definitions of various data formats are the same as those for IQ Meas Time.

8. Error Vector Spectrum

The spectrum of the vector error. The horizontal axis is in frequency units (Hz, kHz, MHz), and
the vertical axis is in logarithmic percentage units (dB%).

9. Mag Error

The amplitude error between the measured and reference signals. The horizontal axis is in units
of symbols (depending on the data format), and the vertical axis units are determined by the
data format.

The definitions of various data formats are the same as those for IQ Meas Time.

10. Phase Error

The phase error between the measured and reference signals. The horizontal axis is in units of
symbols (depending on the data format), and the vertical axis units are determined by the data

format.

The definitions of various data formats are the same as those for IQ Meas Time.

11. Error Summary

Display the demodulated data table:

FSK parameters:

1) FSK Error: RMS and peak, unit: %|m%|n%|dB.

2) Mag Error: RMS and peak, unit: %|m%|n%.

3) Freq Error: Carrier frequency offset, unit: mHz|Hz|kHz|MHz.
4) Clock Error: Sampling clock deviation, unit: mHz|Hz|kHz|MHz.

5) Deviation: Frequency deviation, unit: mHz|Hz|kHz|MHz.
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12. Demod Bits

Display the demodulated bits. Mark the synchronization results when the synchronization
function is enabled. When BER is enabled, this table includes BER results.

34 NR
5G NR demodulation is compatible with the 5G NR standard: 3GPP TS38 V17.3.0 (2022-09).

3.4.1 Properties

The path to enter the 5G NR configuration interface is: Meas Setup -> 5G NR Properties.

File Edit Control InputOutput MeasSetup Trace Markers Win

I] | 9GNR1 | == New Measurement »|

Measurement Management Remove Measurement b2l

o= AddGroup rJ= NewMeasuremet

Measure Management...

~ Group1

.~ 5GNR1 3 -

Current Measurement [ 3

Measurement Type: 5G NR »

a File () Remotel _
[5G NR 1] Properties...

-100

3.4.1.1 Config Carrier

3.4.1.1.1 Carrier

NR supports a maximum of 16 carrier measurements, which are managed in a tabular format,
with only one carrier available by default. The number of carriers is managed through the
following two buttons:

Add Carrier: Adds a carrier at the last row of the table, with the total number that can be added
ranging from 1 to 16;

Remove Carrier: Removes the currently selected carrier from the table.
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ConfigCCs R

Carrier Enabled  Carrier Type ase pensation Freq nge Bandwidth Center Frequency rum CelllD

cCo On Uplink 1GHz Normal
1GHz
1GHz

CCOEnabled On ~  Phase Compensation Auto
Carrier Type Uplink ~  Center Frequency 1GHz
Frequency Range FR1 v Spectrum Normal

Bandwidth 100 MHz ~  CelllD 0

The list displays all carrier information, and by selecting a row, you can modify the parameters
of the chosen carrier.

1. CCn Enabled
Optional: On | Off; Default: On.

This option is used to set the enable state of the current carrier. By default, carrier CCO is
displayed, and by selecting a different carrier CCn from the list, the current parameter name
changes accordingly to CCn Enabled.

2. Phase Compensation

Optional: Off | Auto | Manual; Default: Auto.

Sets the phase compensation switch and the frequency for phase compensation.

® Off: Turn off phase compensation.

® Auto: The phase compensation frequency is obtained from the center frequency.

® Manual: Manually set the phase compensation frequency.

3. Carrier Type
Optional: Downlink | Uplink;
Default: Downlink.

This option is used to switch between the configuration of uplink or downlink carriers.
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4. Center Frequency
Configurable range: 0 Hz ~ 100 GHz, Default value: 1 GHz.
Unit options: Hz | kHz | MHz | GHz, Default unit: GHz.

Set the center frequency of the current carrier.

5. Frequency Range
Optional: FR1 | FR2-1 | FR2-2, Default: FR1.

Select the frequency band of the current carrier, with specific frequency ranges detailed in
Table 3-1.

Table 3-1 Operational Frequency Band Ranges

Frequency range designation Corresponding frequency range
FR1 410 MHz - 7125 MHz
FRD FR2-1 24250 MHz - 52600 MHz
FR2-2 52600 MHz - 71000 MHz
6. Spectrum

Optional: On | Off, Default: Off.

Toggle the spectrum inversion state; turning it on inverts the Q-path in the signal IQ data.

7. Bandwidth

Optional:

FR1 5MHz | FR1 10MHz | FR1 15MHz | FRT 20MHz | FR1 25MHz | FR1 30MHz

FR1 35MHz | FR1 40MHz | FR1 45MHz | FR1 50MHz | FR1 60MHz | FR1 70MHz

FR1 80MHz | FR1T 90MHz | FRT 100MHz

FR2-1 50MHz | FR2-1 100MHz | FR2-1 200MHz | FR2-1 400MHz

FR2-2 100MHz | FR2-2 400MHz | FR2-2 800MHz | FR2-2 1600MHz | FR2-2 2000MHz
Default value: FR1 100MHz.

Set the channel bandwidth, with different bandwidths corresponding to the three frequency
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ranges (Frequency Range) FR1, FR2-1, and FR2-2 in the 3GPP protocol, and the specific
constraints related to subcarrier spacing (SCS) and the number of resource blocks (RB) are
detailed in Table 3-2, Table 3-3, and Table 3-4.

Note: This parameter is constrained by the Frequency Range parameter, and the configurable
bandwidth displayed varies depending on the frequency band.

Table 3-2 (Table 5.3.2-1) Transmission bandwidth configuration NRB for FR1

SCS 5 10 15 20 25 30 35 40 45 50 60 70 80 90 100
(kHz) MHz MHz MHz MHz MHz MHz MHz MHz MHz MHz MHz MHz MHz MHz MHz

Nre Nrs Nrs Nrs Nre Nrs Nrg Ngg Nrs Nre Nrs Nrz Ngs  Nrs  Neges
15 25 52 79 106 133 160 188 216 242 270 N/A N/A N/A N/A N/A
30 11 24 38 51 65 78 92 106 119 133 162 189 217 245 273
60 N/A 11 18 24 31 38 44 51 58 65 79 93 107 121 135

Table 3-3 (Table 5.3.2-2) Transmission bandwidth configuration NRB for FR2-1

SCS (kHz) 50 MHz 100 MHz 200 MHz 400 MHz
Nrs Nrs Nrs Nrs
60 66 132 264 N/A
120 32 66 132 264

Table 3-4 (Table 5.3.2-3) Transmission bandwidth configuration NRB for FR2-2

SCS (kHz) 100 MHz 400 MHz 800 MHz 1600 MHz 2000 MHz
Nrs NRre NRre NRre NRre
120 66 264 N/A N/A N/A
480 N/A 66 124 248 N/A
960 N/A 33 62 124 148
8. CellID
Configurable range: 0 ~ 1007, default 0.
Set the cell ID number of the current carrier.
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34.1.1.2 Test Model

When the carrier type is Downlink, click on the DL Test Model at the top right corner of the
Configs CCs menu to enter the demodulation settings for the downlink test mode.

vsa [5G NR 2] Properties

== Add Carrier @ Remove Carrier Test Model

Carrier Enabled Ca ype  Phase Compensation FrequencyRange = Bandwidth Center Frequency Spectrum CelllD

CCco Cn Downlink Auto FR1 100MHz 1GHz Normal 1

CCOEnabled On ~  Phase Compensation Auto
Carrier Type Downlink Center Frequency 1GHz
Frequency Range FR1 v Spectrum Normal

Bandwidth 100 MHz ~  CelllD 1

vsa Test Model

Downlink Test Model
Enabled Off
Frequency Range FR1
Bandwidth 100 MHz

Test Model DLNR-TM11

Duplex Mode TDD

SCS K =1:30kHz
Modulation

Port Port 0

1. Enabled
Optional: On | Off, Default: Off.

This option is used to switch the EVM statistics for the QPSK modulation scheme of test modes
TM3.2 and TM3.3.
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Note: This parameter only takes effect when the Test Model is set to TM3.2 | TM3.3. For specific
constraints, please refer to the physical layer related content of the 3GPP protocol.

2. Frequency Range
Optional: FR1 | FR2-1 | FR2-2, Default: FR1.

Select the frequency band required for the test mode, with specific frequency ranges detailed
in Table 3-1.

3. Bandwidth

Optional:

FR1 5MHz | FR1 10MHz | FRT 15MHz | FR1 20MHz | FR1 25MHz | FR1 30MHz

FR1 35MHz | FR1 40MHz | FR1 45MHz | FR1 50MHz | FR1 60MHz | FR1 70MHz

FR1 80MHz | FRT 90MHz | FR1 100MHz

FR2-1 50MHz | FR2-1 100MHz | FR2-1 200MHz | FR2-1 400MHz

FR2-2 100MHz | FR2-2 400MHz | FR2-2 800MHz | FR2-2 1600MHz | FR2-2 2000MHz
Default value: FR1T 100MHz.

Select the channel bandwidth required for the test mode. Different bandwidths correspond to
the three frequency ranges (Frequency Range) FR1, FR2-1, and FR2-2 in the 3GPP protocol,
and the specific constraints related to subcarrier spacing (SCS) and the number of resource
blocks (RB) are detailed in Table 3-2, Table 3-3, and Table 3—4.

4. Test Model

Optional:

NR-FR1-TM1.1 | NR-FR1-TM1.2 | NR-FR1-TM2 | NR-FR1-TM2a | NR-FR1-TM2b
NR-FR1-TM3.1 | NR-FR1-TM3.1a | NR-FR1-TM3.1b | NR-FR1-TM3.2 | NR-FR1-TM3.3
NR-FR1-TM11 | NR-FR1-TM1.2 | NR-FR1-TM2 | NR-FR1-TM2a | NR-FR1-TM2b
NR-FR1-TM3.1 NR-FR1-TM3.1a | NR-FR1-TM3.1b | NR-FR1-TM3.2 | NR-FR1-TM3.3
NR-FR2-TM1.1 | NR-FR2-TM2 | NR-FR2-TM2a | NR-FR2-TM3.1 | NR-FR1-TM3.1a
Default value: NR-FR1-TM1.1.

Select the test mode you require.
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Note: The options for this parameter are constrained by the Frequency Range.

5. Duplex Mode
Optional: TDD | FDD, Default: TDD.
Choose between different duplex types.

Note: The options for this parameter are constrained by the Frequency Range, with the FR2
band supporting only TDD.

6. SCS

Options:

FR1: p = 1:30KHz | p = 2:60KHz

FR2-1: p =2:60KHz | p = 3:120KHz | p = 4:240KHz
FR2-2: p = 3:120KHz | p = 5:480KHz | p = 6:960KHz
Default: p = 1:30KHz.

Set the subcarrier spacing for the current test mode.

Note: The options and display of this parameter are constrained by Frequency Range and Test
Model.

7. Modulation
Options: QPSK | 16QAM | 64QAM, Default: QPSK.
This option is used to display or select the modulation scheme for the current test mode.

Note: The options and display of this parameter are constrained by Frequency Range and are
configurable only in certain test modes (FR2 TM2 | FR2 TM3.1).

8. Port
Options: Port 0 | Port 1, Default: Port 0.
This option is used to display or select the antenna port for the current test mode.

Note: The options and display of this parameter are constrained by Frequency Range and
Duplex Mode and are configurable only in certain test modes (TM1.1).
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34.1.1.3 Resource Grid

Each carrier corresponds to a resource grid list, with each row in the list corresponding to a
resource grid with a different parameter set. By default, all supported parameter sets are
displayed, but only one parameter set can be activated at a time.

Resource Grid Capture Time BWP CORESET PDCCH

Component Carrier CCco ~  Carrier Type Downlink

Enabled N_grid_start N_grid_size
K =1:30kHz On ORB 273RB
W =2:60kHz Off ORB 135RB

K =1:30 kHz Enabled
N_grid_start

N_grid_size

1. Component Carrier
Options: CO ~ currently existing carriers, Default: CCO.

Select the carrier for which the parameter set needs to be configured currently. When this
option switches to a different carrier, the parameter configuration on the current page also
switches to the configuration of the current carrier, without changing the parameters on other

pages.

2. Carrier Type
Options: Downlink | Uplink, Default: Downlink.

This option is used to switch between the configuration of uplink or downlink carriers.

3. M Enabled
Options: On | Off, Default: On.

Toggle the subcarrier spacing for the current subcarrier spacing. You can select the desired
subcarrier spacing from the list above, and the parameter name will change according to the

currently enabled subcarrier spacing.

Note: Multiple subcarrier spacings can be enabled simultaneously, but it is not allowed to

disable all of them.

www.siglent.com 77



SigVSA Vector Signal Analysis Software User Manual

4. N _grid start
Configurable range: 0 ~ maximum number of RBs for the numerology — 1, Default: 0.

Set the starting position of the resource blocks for the parameter set corresponding to the
current carrier. For specific constraints, please refer to the physical layer related content of the
3GPP protocol.

5. N_grid size
Configurable range: 6 ~ maximum number of RBs for the numerology — 1, Default: 0.

Set the number of resource blocks for the parameter set corresponding to the current carrier.
For specific constraints, please refer to the physical layer related content of the 3GPP protocol.

6. KO

Displays the offset of the resource grid center relative to the carrier center for the parameter
set corresponding to the current carrier.

34114 BWP

The number of BWPs per carrier is managed through the BWP table, with a maximum limit of
100 BWPs. The number of BWPs is controlled by the following buttons:

Add BWP: Adds a BWP at the end of the list, with the default list containing 1 BWP.

Remove BWP: Removes the currently selected BWP.
vsa [5G NR 1] Properties

PDCCH PDSCH

dd BWP @ Remove BWP Component Carrier Cco

BWP SCS Cyclic Prefix NBWP Start NBWP Size Max RB Number CORESET Number
BWPO W =1:30kHz Nermal ORB 27T3RB 273RB 1

BWP1 u Hz Normal ORB 273RB 273RB 1

NBWP Start
Cyclic Prefix NBWP Size

CORESET Number = Max RB Number
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The list displays all BWP information, and by selecting a BWP, you can modify the parameters
of the chosen BWP.

1. Component Carrier
Options: CCO ~ currently existing carriers, Default: CCO.

Select the carrier for which demodulation parameters need to be configured currently. When
this option switches to a different carrier, the parameter configuration on the current page also
switches to the configuration of the current carrier, without changing the parameters on other

pages.

2. SCS

Options:

FR1: p = 1:30KHz | p = 2:60KHz

FR2-1: p =2:60KHz | p = 3:120KHz | p = 4:240KHz
FR2-2: py = 3:120KHz | p = 5:480KHz | p = 6:960KHz
Default: p = 1:30KHz.

Set the subcarrier spacing for the current BWP, constrained by Frequency Range and Channel
Bandwidth.

3. Cyclic Prefix
Options: Normal | Extended, Default: Normal.

Set the cyclic prefix type for the current BWP. When SCS is 60kHz, both Normal and Extended
are available; for other SCS values, only Normal is displayed, and Extended is not configurable.

4. CORESET Number
Configurable range: 1 ~ 3, Default: 1.

Set the number of CORESETs included in the current BWP.

5. N BWP Start

Configurable range: current N_grid_start value ~ maximum number of RBs for the numerology
~1,
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Default: N_grid_start value.

Set the starting position of the BWP offset relative to PointA, constrained by N grid start.

6. N BWP Size
Configurable range: 6 ~ current N_grid start value, Default: N_grid_start value.

Set the size of the BWP, constrained by N_grid_start.

7. Max RB Number

Displays the maximum number of RBs that can be set for the current BWP.

34.1.1.5 CORESET

The CORESET table is used to manage the CORESET for each BWP, with a maximum of 3
CORESETs that can be set per BWP. Select a CORESET from the table to configure the
corresponding CORESET parameters.

CORESET PDCCH
BWPID W o= AddBWP (%) Delete BWP

CORESET Number

CORESETID = RBOffset = Duration s ) : 3 erleaver gt Index

CORESETO 1 TN Non-Interleaved
ET1 ( 1 TN Nen-Inte e
2 1 MMM Ne

CORESETID CORESETO
RE Offset 0 : Duration 1

FreqDomain Resources TINIIIMTMITININIMIIMIIMNININNM CCE-REG-Mapping Type Non-Interleaved

1. BWPID
Options: BWP 0 ~ current total number of BWPs, Default: BWP 0.

Switch the current BWP, you can select one from the currently existing BWPs to configure the
CORESET.
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2. CORESET Number
Configurable range: 1 ~ 3, Default: 1.

Set the number of CORESETs included in the current BWP.

3. CORESET ID
Options: CORESET 0 ~ CORESET 11, Default: CORESET 0;

Switch the current CORESET, the CORESET index and configuration in the list above will change
accordingly.

4. RB Offset
Configurable range: -1 ~ 5, Default: 1.

Set the RB offset value for the current CORESET. When set to -1, it indicates no configuration,
aligning with pointA.

5. Duration
Configurable range: 1~3, Default: 1.

Set the number of symbols for the current CORESET.

6. Freq Domain Resources
Setting content: One bit represents one RBG, checking indicates activation of that bit.

Set the frequency domain resources allocated to PDCCH for the current CORESET, configured
via Bitmap, with each bit representing 6 consecutive RBs (REG), supporting up to 45 bits.
Checking the corresponding bit position indicates activation of the corresponding group of 6
RBs.

7. CCE-REG-Mapping Type
Options: Interleaved | Non-Interleaved, Default: Non-Interleaved.

Set the mapping method from CCE to REG.
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8. REG-Bundle Size
Options: 2 | 3 | 6, Default: 6.

When the parameter CCE-REG Mapping Type is set to interleaved mapping, this parameter is
used to set the parameter L for interleaved mapping, see 3PGG protocol for specific constraints;
for non-interleaved mapping, L defaults to 6.

Note: Only displayed when CCE-REG Mapping Type is set to Interleaved.

9. Interleaver Size
Options: 2 | 3 | 6, Default: 3.
Set the interleaver size for interleaved mapping.

Note: Only displayed when CCE-REG Mapping Type is set to Interleaved.

10. Shift Index
Configurable range: -1 ~ 274, Default: O (set to -1 to use CellID).
Set the ng,e parameter for interleaved mapping.

Note: Only displayed when CCE-REG Mapping Type is set to Interleaved.

11. Precoder Granularity
Options: Reg Bundle Size | CORESET Size, Default: Reg Bundle Size.

Set the precoding granularity. When this parameter is set to Reg Bundle Size, DMRS is only
mapped to REGs with PDCCH; when set to CORESET Size, DMRS is mapped to all RBs of the
CORESET.

Note: Only displayed when CCE-REG Mapping Type is set to Interleaved.

3.4.1.2 Channel(Downlink)

34.121 SSB

Currently, only one SSB setting is supported per carrier. Select the carrier through the
Component Carrier parameter, and the SSB page displays the SSB of the current carrier,

allowing for parameter configuration.
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SET PDCCH PDSCH

Component Carrier

S5 ock L Half Frame . -
Enabled =~ Numerology Periodicity Index Active Indicies

Off K =1:30kHz o] 0123 0dB.0dB,0dB 0dB

Enabled Off

Numerology W =1:30kHz ~  S3/PBCH Block Pattern
Lmax 4 ~  Periodicity

Active Indices 0123 Half Frame Index
S5/PBCH Block Power 0dB,0dB 0dB 0dB RB Offset

PSS Power 0dB kSSB

1. Enable
Options: On | Off, Default: Off.
SS/PBCH Block channel enable switch.

2. Numerology

Options:

FR1: p = 1:30KHz | p = 2:60KHz;

FR2-1: y =2:60KHz | p = 3:120KHz | p = 4:240KHz;
FR2-2: y = 3:120KHz | p = 5:480KHz | p = 6:960KHz.

This parameter is the subcarrier parameter set p, used to describe waveform characteristics,
supporting 7 different subcarrier spacings, as detailed in Table 3-2 to Table 3-4 and Table 3-
5. Related parameters for Numerologies include: Subcarrier Spacing and p, Cyclic Prefix type
(CyclicPrefix: normal and Extended), starting RB (RB Start), and RB count (RB Size).

Table 3-5 Supported transmission parameter set settings

Af =2*-15[kHz] Cyclic prefix
0 15 Normal
1 30 Normal
2 60 Normal, Extended
3 120 Normal
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4 240 Normal
480 Normal
6 960 Normal

3. SS/PBCH Block Pattern
Options:

15kHz: Case A ;

30kHz: Case B | Case C ;
120kHz: Case D ;
240kHz: Case E ,

Default: Case B.

Set the synchronization broadcast block pattern.

34.1.22 PDSCH

The number of PDSCH is operated by the following keys: Currently, a maximum of 20 PDSCH
settings are supported per carrier. Select the carrier through the Component Carrier parameter,
and the PDSCH page displays the configuration of the current carrier, allowing for parameter
configuration and modification. The number of PDSCHs is controlled by the following buttons:

Add PDSCH: Adds a PDSCH at the end of the list, with the default list containing 1 PDSCH.
Remove PDSCH: Removes the currently selected PDSCH.
Remove PDSCH: Removes the currently selected PDSCH.

Clear All: Keeps only the first PDSCH, removing all others.
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Resource Allocation C

== AddPDSCH (%) Remove PDSCH Clear All

BWP

BWP1
BWP1

PDSCH2 Enabled
Symbol Start
Symbol Number
rce Allocation Type
RB Offset

RB Number

1. General Settings
1) PDSCH Enable
Options: On | Off, Default: On.

PUSCH channel enable switch.

2) Power Boosting

PDSCH

Component Carrier

RB RB
Offset Number

Allocated Slots

BWP

\VRB-to-RPB Mapping Type

Bundle Size

Configurable range: -40 dB ~ 40 dB, Default: 0 dB.

Set the power of PUSCH data relative to other channels.

3) RNTI
Configurable range: 0 ~ 65535, Default: 0.

RBG Bitmap

Non-Interleaved

Neon-Interleaved

019
BWP1

Non-Interleaved

2

Set the scrambling sequence nyyp; for PDSCH data, used to distinguish different UEs.

4) n_ID
Configurable range: -1 ~ 65535;

Default: -1 (set to -1 to use CellID).

Set the nID for the PDSCH data scrambling sequence.
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2. Resource Allocation
1) Symbol Start
Configurable range: 0 ~ 13, Default: 0.

Set the position of the first symbol for the current PDSCH.

2) Symbol Number
Configurable range: 0 ~ 14 (Normal) | 0 ~ 11 (Extended)
Default: 14| 11.

Set the number of symbols available for the current PDSCH, with the maximum value related
to the CP type.

3) Resource Allocation Type
Options: TypeO | Type1, Default: Type1.

Select the frequency domain resource allocation type for the current PDSCH, as detailed in the
3GPP protocol physical layer related content.

4) RB Offset

Configurable range: 0 ~ current BWP RB count - 1;

Default: 0.

Set the offset RB count relative to the start of the BWP when the current PUSCH is Type1.

Note: Only displayed when the Resource Allocation Type parameter in this section is TypeT.

5) RB Number

Configurable range: 0 ~ current BWP RB count - RB Offset;
Default: maximum RB count.

Set the number of RBs when the current PUSCH is TypeT.

Note: Only displayed when the Resource Allocation Type parameter in this section is TypeT.
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6) Allocated Slots

Set the Slot number for PDSCH transmission within a frame.

7) BWP

Use the dropdown list to select the BWP sequence number for the current CORESET, with
specific options constrained by the number of BWPs.

8) VRB-to-PRB Mapping Type
Options: Interleaved | Non-Interleaved;
Default: Non-Interleaved.

Set the mapping method from VRB to PRB.

9) Bundle Size
Options: 2 | 4, Default: 2.

Set the Bundle size for interleaved mapping.

3. Code & Modulation

1) MCS Table

Options: QAM64 | QAM256 | QAM64Low SE | QAM1024;
Default: QAM64.

Select the table for calculating TB size, as detailed in the 3GPP protocol physical layer protocol.

2) MCS
Default: 0.

Set the corresponding MCS index, with the specific range related to the corresponding table
in the 3GPP protocol.

3) Coding Rate

Display the coding rate, obtained according to the MCS Table parameter.
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4) Transport Block Size

Display the channel transport block size, automatically changing with the MCS value.

5) xOverhead
Options: 0| 6 | 12 | 18, Default: 0.

Set the high-level parameter xOverhead in the 3GPP protocol, used to set the parameter N;;RB

for calculating TBS.

6) TB Scaling Factor S
Options: 1| 0.5 | 0.25, Default: 1.

Set the Scaling Factor S for calculating TBS, with specific values detailed in the 3GPP protocol
TS38.214 Table 5.1.3.2-2.

7) Modulation

Display the modulation method, obtained according to the MCS Table parameter.

8) RV Index
Configurable range: 0 ~ 3, Default: 0.

Set the redundancy version RV index for rate matching.

4. DMRS
1) DMRS-r16
Options: On | Off, Default: Off.

Set whether to provide the high-level parameter dmrsUplink-r7é.
2) n_SCID
Configurable range: 0 ~ 1, Default: 0.

Set the parameter ngy, for sequence generation.

3) Scramble ID 0
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Configurable range: -1 ~ 65535, Default: -1 (set to -1 to use CellID).

Set the Nip for DMRS sequence generation.

4) Scramble ID 1
Configurable range: -1 ~ 65535;
Default: -1 (set to -1 to use CellID).

Set the Nip for DMRS sequence generation.

5) PDSCH Mapping
Options: TypeA | TypeB, Default: TypeA.
Set the PDSCH mapping type.

6) PDSCH TypeA Position
Options: 2 | 3, Default: 2.

Set the high-level parameter dmrs-TypeA-Position in the 3GPP protocol.

7) DMRS Power Boosting
Configurable range: -40 dB ~ 40 dB;
Default: 0 dB.

Set the power of PDSCH DMRS relative to the PUSCH channel.

8) DMRS Configuration Type
Options: Type1 | Type2, Default: Type1.

Set the DMRS configuration type.

9) DMRS Length
Options: Single Symbol|Double Symbol,
Default: Single Symbol.

Set the symbol length for DMRS.
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10) DMRS Additional Position

Options:

® Single symbol DMRS:
pos0 | pos1 | pos2 | pos3;

® DMRS Length is Double Symbol or Single symbol with intra-slot frequency hopping
enabled:

pos0 | posT.
Default: pos0.

Set the high-level parameter dmrs-AdditionalPosition in the 3GPP protocol.

11) DMRS Mapping Reference
Options: CRB | RRB;
Default: CRB.

Select the reference point for DMRS mapping.

5. PTRS
1) PTRS Enable
Options: On | Off, Default: On.

PTRS enable switch.

2) PTRS K (Frequency Density)
Options: 2 | 4, Default: 2.

Set the frequency domain density.

3) PTRS L (Time Density)
Options: 2 | 4, Default: 2.

Set the number of points per PT-RS group.
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4) PTRS Power Boosting
Configurable range: -40 dB ~ 40 dB;
Default: 0 dB.

Set the power of PTRS data relative to PUSCH data.

5) PTRS RE Offset
Options: 00 | 01 | 10| 11;
Default: 00.

Set the RE offset for PTRS.

6. Antenna Port

1) DMRS Port

Configurable range: 0 ~ 3, Default: 0.
Set the port number for DMRS.

2) Layers Number
Configurable range: 1 ~ 4;
Default: 1.

The number of layers for PDSCH, calculated based on the number of DMRS ports.

3) Antenna Port
Options: Port 0 | Port_1 | Port 2 | Port_3;
Default: Port 0.

Specify the data for each antenna, used to allocate PDSCH layers to antennas. The number of
antenna ports is determined by the antenna data in the Waveform Setup.

4) DMRS CDM Groups w.o. Data
Configurable range: 1 ~ 3;

Default: 1.
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Set the number of CDM groups for DMRS that do not allow mapping PDSCH data, with
configuration Type1 having 2 CDM groups, setting range 1~2, and configuration type2 having
3 CDM groups, setting range 1~3.

7. Lmax

Options:

® CaseA/ CaseB, CaseC: 4| 8;
® (CaseD / CaseE: 64.

Set the number of SS/PBCH blocks, with specific choices constrained by the SS/PBCH Block
Pattern.

8. Periodicity
Options: 5ms | 10ms | 20ms | 40ms | 80ms | 160m,
Default: 10ms.

Set the synchronization broadcast period.

9. Active Indices

Set the active SS/PBCH blocks within a half-frame, with the maximum value constrained by
Lmax. For example, when the SS/PBCH block supports a maximum of 4, you can set the active

indices to any one or more of 0~3.

10. Half Frame Index
Configurable range: 0 ~ 1 (0: first half-frame, 1: second half-frame),
Default: 0.

When the Periodicity parameter (SSB period) is not 5ms, this parameter is used to specify which
half-frame the SSB is in.

11. SSB Power Boosting
Configurable range: -40dB~40dB;
Default: 0dB.
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Set the relative power of the synchronization broadcast block, allowing for individual power
settings for each active synchronization broadcast block.

12. RB Offset
Configurable range: -1 ~ maximum RB count for numerology - 1,
Default: -1.

Set the offset of the synchronization broadcast block (SSB) center relative to CRBO (PointA).

13. PSS Power Boosting
Configurable range: -40 dB ~ 40 dB;
Default: 0 dB.

Set the power of PSS relative to SSS or PBCH, with SSS and PBCH power being the same.

14. kSSB
Configurable range: 0 ~ 23 (u=0 and u=1) | 0 ~11 (u=3 and u=4),
Default: 0.

Set the kSSB parameter size for SS/PBCH.

34.1.23 PDCCH

Currently, a maximum of 10 PDCCH settings are supported per carrier. Select the carrier
through the Component Carrier parameter, and the PDCCH page displays the configuration of
the current carrier, allowing for parameter configuration and modification. The number of
PDCCHs is controlled by the following buttons:

Add PDCCH: Adds a PDCCH at the end of the list, with the default list containing 1 PDCCH.
Remove PDCCH: Removes the currently selected PDCCH.

Clear All: Keeps only the first PDCCH, removing all others.
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PDCCH

General Settings S

o= AddPDCCH (%) Remove PDCCH Clear All Component Carrier

o) - Candidate
PDCCH Enabled ver | o W : : Candidate oo offeet

Index
PDCCH1 On
PDCCH2 Off

PDCCH1Enabled
Power Aggregation Level
DMRS Power Candidate Index

CCE Offset

1. General Settings
1) Enable
Options: On | Off, Default: On.

PDCCH channel enable switch.

2) Power Boosting
Configurable range: -40 dB ~ 40 dB. Default: 0 dB.

Set the relative power of PDCCH data.

3) DMRS Power Boosting
Configurable range: -40 dB ~ 40 dB.
Default: 0 dB.

Set the power of PDCCH DMRS relative to the PDCCH channel.

4) DMRS Scrambling ID
Configurable range: -1 ~ 65535;
Default: -1 (set to -1 to use CelllD).

Set the nID for DMRS sequence generation.
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5) RNTI
Configurable range: 0 ~ 65535;
Default: 0.

Set the scrambling RNTI for CRC.

6) Adggregation Level
Options:1]2|4|8|16;
Default: 4.

Set the aggregation level for PDCCH, with the optional maximum aggregation level
constrained by CORESET.

7) Candidate Index
Configurable range: 0 ~ number of PDCCH candidates - 1;
Default: 0.

Set the search space candidate index for the current PDCCH aggregation level.

8) CCE Offset
Display the CCE offset, indicating the starting position of the DCI.

Default: 0.

2. Search Space
1) BWP

Use the dropdown list to select the BWP sequence number for the current CORESET, with
specific options constrained by the number of BWPs.

BWP and CORESET are interrelated.

2) Search Space Type

Options: UE Specific | Common,
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Default: UE Specific.

Set the search space type for DCI.

3) Allocated Slots

Set the Slot number for PDCCH transmission within a frame.

4) Start Symbol Within Slot
Configurable range: 0 ~ 13, Default: 0.

Set the starting symbol position for the current PDCCH within a slot.

5) Number of Candidates
Options:1]2|3|4|5]| 6|8, Default: 1.

Set the number of search space candidates used to calculate the CCE Offset.

34.1.24 CSI-RS

Currently, a maximum of 10 CSI-RS settings are supported per carrier. Select the carrier through
the Component Carrier parameter, and the CSI-RS page displays the configuration of the
current carrier, allowing for parameter configuration and modification. The number of CSI-RSs

is controlled by the following buttons:
Add CSI-RS: Adds a CSI-RS at the end of the list, with the default list containing 1 CSI-RS.
Remove CSI-RS: Removes the currently selected CSI-RS.

Clear All: Keeps only the first CSI-RS, removing all others.
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CSI-RS

o= AddCSI-RS (%) Remove CSI-RS Clear All ( ent Carrier cco

Enabled Pows ng Antenna Port nlD ] e lo ocation BWP StartingRB RE Number
0dB PortQ 1000 Non Zero Power ) BWP1 ORB 272RB
0dB Port0 1000 Nen ower 01,234 BWP1 ORB 272RB

|
CSI-RS0Enabled
Power Boosting Antenna Port Port0
nlD : CSI-RS Type NonZero Power
Slot Allocation BWP BWP1 ‘
Starting RB 2 = Locations Table Index 4
RB Number : First Symbol (10) 12 ‘
Frequency Domain Bitmap l

Density ~  REUsedfor PDSCH

1. CSI-RS Enable
Options: On | Off, Default: On.

CSI-RS channel enable switch.

2. Power Boosting
Configurable range: -40 dB ~ 40 dB. Default: 0 dB.

Set the power of CSI-RS data relative to other channels.

3. nlID
Configurable range: 0 ~ 65535, Default: 1000.

Set the parameter nip for generating the CSI-RS sequence.

4. Slot Allocation
Configurable range: 0 ~ 10*2/p, Default: 0.

Set the Slot number for CSI-RS transmission within a frame. It can be set in the following three
ways:
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® If you need to configure by individual slots, use "," as a separator, e.g., 0,1,2,3.

® If you need to configure by slot range, use 2:7 to indicate the start index and the last index,
for example, 2:7 represents 2,3,4,5,6,7.

® If you need to configure by different steps, use two ":" to indicate the starting slot, step,
and the last slot, for example, 0:2:8 represents 0,2,4,6,8.

All three configuration methods can be combined.

5. Starting RB
Configurable range: 0 ~ current BWP RB count + BWP RB start number - 4, Default: 0.
Set the offset RB number for the current CSI-RS relative to the start of the BWP.

Note: The set RB number must be a multiple of 4.

6. RB Number
Configurable range: 4 ~ current BWP RB count - RB Offset, Default: maximum RB count.
Set the number of RBs for the current CSI-RS.

Note: The set RB number must be a multiple of 4.

7. Frequency Domain Bitmap
Setting content: One bit represents one RBG, checking indicates activation.

Set the frequency domain position of CSI-RS via bitmap, with the number of bits constrained
by the CSI-RS Locations Table Index.

Note: When the CSI-RS Locations Table Index is 1, 4 bits can be set; when it is 2, 12 bits can be
set; when it is 4, 3 bits can be set; for other values, 6 bits can be set.

8. Density
Options: 1| 0.5, Default: 1.

Set the density of CSI-RS, constrained by the location table, as detailed in 3GPP protocol 38.211
Table 7.4.1.5.3-1.

Note: When the CSI-RS Locations Table Index is set to 1, Density = 3; when set to 4 ~ 10,
Density=1; in these cases, this parameter is hidden. When the CSI-RS Locations Table Index is
set to other values, Density=1 | 0.5, and this parameter is only displayed at this time.
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9. Antenna Port
Options: Port 0 | Port_1 | Port 2 | Port_3, Default: Port 0.

Set the mapping of CSI-RS ports to antenna ports.

10. CSI-RS Type
Display the CDM type of CSI-RS.

11. BWP

Select the BWP for the current CSI-RS transmission.

12. Locations Table Index
Configurable range: 1 ~ 18, Default: 1.

Set the row index of the CSI-RS location table, as detailed in 3GPP protocol 38211 Table
7.4.1.5.3-1.

13. First Symbol(10)
Configurable range: 0 ~ 13, Default: 10.
Set the 10 of the CSI-RS location table, as detailed in 3GPP protocol 38.211 Table 7.4.1.5.3-1.

14. RE Used for PDSCH
Options: On | Off, Default: Off.

Set whether the resources configured for CSI-RS can be used for PDSCH. Setting to On means
PDSCH will be mapped to CSI-RS resources, and CSI-RS will cover PDSCH. Setting to Off means
PDSCH mapping will skip CSI-RS resources.

3.4.1.3 Channel (Uplink)

34.1.3.1 PUCCH

Currently, a maximum of 10 PUCCH settings are supported per carrier. Select the carrier
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through the Component Carrier parameter, and the PUCCH page displays the configuration of
the current carrier, allowing for parameter configuration and modification. The number of
PUCCHs is controlled by the following buttons:

Add PUCCH: Adds a PUCCH at the end of the list, with the default list containing 1 PUCCH.
Remove PUCCH: Removes the currently selected PUCCH.

Clear All: Keeps only the first PUCCH, removing all others.
]

PUCCH

General Settings R

o= AddPUCCH (®) Remove PUCCH Clear All Component Carrier

Scrambling Ac

PUCCH  Enabled Format DO

PUCCH1 On Format0 0dB
PUCCH2 Off FormatQ 0dB

PUCCH1Enabled On
Format Format O ~  Power Boosting

mes ]

1. General Settings
1) PUCCH 1 Enabled
Options: On | Off, Default: Off.

Toggle the enable state of the current PUCCH channel.

2) Format
Options: Format O | Format 1 | Format 2 | Format 3 | Format 4,
Default: Format 0.

Select the format of the current PUCCH.

3) Power Boosting
Configurable range: -40 dB ~ 40 dB. Default: O dB.

Set the power of PUCCH data relative to other channels.
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4) mcs
Options: 0| 1|3|4]6]|7]9]|10, Default: 0.

This parameter is used for format 0 sequence generation, as a specific cyclic shift for HATRQ-
ACK, with values related to bit information.

Note: Only displayed when PUCCH Format is format 0.

5) Scrambling IDO

Configurable range: -1 ~ 1023;

Default: -1 (set to -1 to use CellID).

Set the scrambling ID for scrambling sequence generation.

Note: Only displayed when PUCCH Format is format 2 | 3 | 4.

6) DMRS Power Boosting
Configurable range: -40 dB ~ 40 dB.
Default: 0 dB.

Set the power of DMRS relative to PUSCH.

7) Additional DMRS
Options: On | Off, Default: Off.
Enable or disable additional DMRS.

Note: Only displayed when PUCCH Format is format 3 | 4.

8) DMRS-UplinkTransformPrecoding-r16
Options: On | Off, Default: Off.

Set whether to provide the high-level parameter dmrsUplink-r16.

2. Resource Allocation

1) Enabled
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Options: On | Off, Default: Off.

Toggle the enable state of the current PUCCH channel.

2) First Symbol
Configurable range: 0 ~ 13, Default: Determined by the PUCCH format.

Set the position of the first symbol for the current PUCCH.

3) Allocated Slots
Configurable range: 0 ~ 10*2/p, Default: 0.

Set the Slot number for PUCCH transmission within a frame. It can be set in the following three
ways:

nun

® If you need to configure by individual slots, use "," as a separator, e.g., 0,1,2,3.

® If you need to configure by slot range, use 2:7 to indicate the start index and the last index,
for example, 2:7 represents 2,3,4,5,6,7.

non

® If you need to configure by different steps, use two ":" to indicate the starting slot, step,
and the last slot, for example, 0:2:8 represents 0,2,4,6,8.

All three configuration methods can be combined.

4) Symbol Number

Set the number of symbols available for the current PUCCH, with the configurable range
determined by the PUCCH format, as detailed in Table 3-6.

Table 3-6 PUCCH format and symbol constraints

PUCCH Format Number of symbols
0 1-2
1 4-14
2 1-2
3 4-14
4 4-14

5) BWP

Options: BWP 0 ~ current total number of BWPs;
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Default; BWP 0.

Switch the BWP for the current PUCCH transmission, you can select one from the currently
existing BWPs for configuration.

6) Use Interlace PUCCH
Options: On | Off;
Default: On.

Enable switch for interlace transmission, which is only supported for subcarrier spacings of
15kHz and 30kHz, and conflicts with frequency hopping.

Note: When interlace transmission is On, the parameters RB Offset and RB Number will be
hidden, and the parameters RB-Set Index, Interlace0, and Interlace1 will be displayed.

7) RB Offset
Configurable range: 0 ~ current BWP RB count - 1;
Default: 0.

Set the offset RB number for the current PUCCH relative to the start of the BWP.

8) RB Number
Configurable range: Specific constraints are detailed in Table 3-7.
Set the number of RBs for the current PUCCH.

Table 3-7 PUCCH format and RB number constraints

PUCCH format RB Number
0 1
1 1
2 1-16
3 1-16 (excluding 7, 11, 13, 14)
4 1

9) RB-Set Index
Configurable range determined by carrier settings;

Default: 0.
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Set the RB set index used for the current PUCCH transmission.

10) PUCCH Interlace 0
Configurable range: -1 ~9 (u=0) |0~ 4 (u=1);
Default: 0.

Set the parameter InterlaceO for the current PUCCH, as detailed in the 3GPP physical layer
protocol (TS38.211).

Note: Only displayed when the parameter Use Interlace PUCCH is On.

11) PUCCH Interlace
Configurable range: -1 ~9 (u = 0) | -1 ~ 4 (u = 1), Default: -1 (i.e., no configuration).

Set the parameter Interlace1 for the current PUCCH, as detailed in the 3GPP physical layer
protocol (TS38.211).

Note: Only displayed when the parameter Use Interlace PUCCH is On and PUCCH Format is
format 2 | 3.

12) Interlace 0
Options: 10 | 11 | not configured, Default: 10.

Set the number of RBs after interlace for the current PUCCH, with not configured indicating no

limit on the number of RBs, distributed across the entire bandwidth.

Note: Only displayed when the parameter Use Interlace PUCCH is On.

13) Interlace 1
Options: 10 | 11 | not configured, Default: 10.

Set the number of RBs after interlace for the current PUCCH, with not configured indicating no
limit on the number of RBs, distributed across the entire bandwidth.

Note: Only displayed when the parameter Use Interlace PUCCH is On and PUCCH Format is
format 2 | 3.

3. PUCCH Settings
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1) PUCCH 1 Enabled
Options: On | Off, Default: Off.

Toggle the enable state of the current PUCCH channel.

2) Hopping ID

Configurable range: -1 ~ 1023;

Default: -1 (set to -1 to use CelllD).

Set the hopping ID for the current PUCCH when the formatis0| 1|3 | 4.

Note: Only displayed when PUCCH Format is format 0 | 1| 3| 4.

3) Format
Options: Format 0 | Format 1 | Format 2 | Format 3 | Format 4;
Default: Format 0.

Select the format of the current PUCCH.

4) PUCCH-Group Hopping
Options: Neither | Enable | Disable;
Default: Neither.

Set the high-level parameter pucch-GroupHopping for PUCCH when the formatis 0| 1| 3| 4,
as detailed in the 3GPP protocol.

Note: Only displayed when PUCCH Format is format 0 | 1| 3| 4.

5) Initial Cyclic Shift

Configurable range: 0 ~ 11;

Default: 0.

When the current PUCCH is format 0 | 1, set the initial cyclic shift (m0) of its sequence.

Note: Only displayed when PUCCH Format is format O | 1.

6) Intra-slot Frequency Hopping
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Options: On | Off, Default: Off.
Enable or disable intra-slot frequency hopping. Only PUCCH format 1 is supported.

Note: Only displayed when PUCCH Format is format 1.

7) Inter-slot Frequency Hopping

When the number of slots is greater than 1, i.e., the number of slots configured by the
parameter Allocated Slots is greater than 1, enable or disable inter-slot frequency hopping.
Only PUCCH format 1 is supported.

Note: Only displayed when PUCCH Format is format 1.

8) Scrambling ID

Configurable range: -1 ~ 1023;

Default: -1 (set to -1 to use CelllD).

Set the scrambling ID for scrambling sequence generation.

Note: Only displayed when PUCCH Format is format 2 | 3 | 4.

9) nNRNTI

Configurable range: 0 ~ 65535;

Default: 0.

Set the n_RNTI parameter for scrambling sequence generation.

Note: Only displayed when PUCCH Format is format 2 | 3 | 4.

10) OCC Index

Set the index value of the spreading sequence, corresponding to the parameter
TimeDomainOCC for PUCCH format 1 in the 3GPP protocol, and the parameter occ-Index for
PUCCH formats 2 | 3 | 4.

Note: Only displayed when PUCCH Format is format 1|2 | 3| 4.

11) OCC Length

Configurable range:
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e format2/3:1|2]|4;
e format4:2|4.
Default: 1.

Set the length of the spreading sequence (OCC) for formats 2/3/4, corresponding to the
parameter occ-Length in the 3GPP protocol.

Note: Only displayed when PUCCH Format is format 2| 3 | 4.

12) N PUCCH Repeat

Configurable range: 1 ~ Min (configured number of slots, 8);
Default: 1.

Set the number of slots for PUCCH transmission repetition.

Note: Only displayed when PUCCH Format is format 1| 3 | 4.

13) T/2BPSK

Options: On | Off;

Default: Off.

Enable or disable Pi/2 BPSK modulation.

Note: Only displayed when PUCCH Format is format 3 | 4.

34.1.3.2 PUSCH

Currently, a maximum of 20 PUSCH settings are supported per carrier. Select the carrier
through the Component Carrier parameter, and the PUSCH page displays the configuration of
the current carrier, allowing for parameter configuration and modification. The number of
PUSCHs is controlled by the following buttons:

Add PUSCH: Adds a PUSCH at the end of the list, with the default list containing 1 PUSCH.
Remove PUSCH: Removes the currently selected PUSCH.

Clear All: Keeps only the first PUSCH, removing all others.
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Resource Allocation C

o= AddPUSCH (%) Remove PUSCH Clear All

PUSCH = Enabled  AllocatedSlots ("ot~ S¥mbol - gyp

PUSCH1 On H 14 BWPO
PUSCH2 Off ( 14 BWPO

PUSCH1Enabled
Symbol Start
Symbol Number
rce Allocation Type
RB Offset

RB Number

1. General Settings
1) PUSCH1Enabled
Options: On | Off, Default: Off.

PUSCH

Component Carrier

RB RB

Offset =~ Number R

rt
Typel 0

Type1

Allocated Slots 0:19

BWP BWPO

Frequency Hopping Mode

Frequency Hops RB Offset

Toggle the enable state of the current PUSCH channel.

2) Power Boosting
Configurable range: -40 dB ~ 40 dB;
Default: 0 dB.

Set the power of PUSCH data relative to other channels.

3) Transform Precoding
Options: On | Off, Default: Off.

Enable or disable transform precoding.

4) RNTI
Configurable range: 0 ~ 65535, Default: 0.

RB-Se
Numbx

Set the n_RNTI for PUSCH data scrambling sequence, used to distinguish different UEs.
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5) n_ID
Configurable range: -1 ~ 1023;
Default: -1 (set to -1 to use CellID);

Set the n_ID for PUSCH data scrambling sequence.

6) Nn_RAPID
Configurable range: -1 ~ 63;
Default: -1 (i.e., no configuration).

Set the n_RAPID for PUSCH data scrambling sequence.

2. Resource Allocation
1) PUSCH1Enabled
Options: On | Off, Default: Off.

Toggle the enable state of the current PUSCH channel.

2) Symbol Start
Configurable range: 0 ~ 13, Default: 0.

Set the position of the first symbol for the current PUSCH.

3) Allocated Slots
Configurable range: 0 ~ 10*2/p, Default: 0.

Set the Slot number for PUSCH transmission within a frame. It can be set in the following three

ways:
® If you need to configure by individual slots, use "," as a separator, e.g., 0,1,2,3.

® If you need to configure by slot range, use 2:7 to indicate the start index and the last index,
for example, 2:7 represents 2,3,4,5,6,7.

® If you need to configure by different steps, use two ":" to indicate the starting slot, step,
and the last slot, for example, 0:2:8 represents 0,2,4,6,8.

All three configuration methods can be combined.
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4) Symbol Number
Configurable range: 0 ~ 13, Default: 0.

Set the position of the first symbol for the current PUSCH.

5) BWP
Options: BWP 0 ~ current total number of BWPs;
Default: BWP 0.

Switch the BWP for the current PUCCH transmission, you can select one from the currently
existing BWPs for configuration.

6) Resource Allocation Type
Options: TypeO | Type1 | Type2, Default: Type1.

Select the frequency domain resource allocation type, as detailed in the 3GPP protocol physical
layer related content.

7) RB Offset
Configurable range: 0 ~ current BWP RB count - 1, Default: 0.

Set the offset RB number for the current PUSCH relative to the start of the BWP when the type
is Type1.

Note: Only displayed when Resource Allocation Type is Type1.

8) RB Number

Configurable range: 0 ~ current BWP RB count - RB Offset;

Default: maximum RB count.

Set the number of RBs for the current PUSCH when the type is Type1.

Note: Only displayed when Resource Allocation Type is Typel.

9) RBG Size

Configurable range: Select the RBG range based on the resource size of the BWP, with specific
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constraints detailed in Table 3-8, Default: 16.
Set the size of the RBG.

Table 3-8 BWP and RBG constraints

Bandwidth Part Size RBG configuration 1 RBG configuration 2
1-36 2 4
37-72 4 8
73 -144 8 16
145 - 275 16 16

10) RBG Bitmap
Setting content: One bit represents one RBG, setting 1 indicates activation.

Set the frequency domain position of the RBG, with the number of bits calculated based on
the RBG size and BWP.

Note: Only displayed when the parameter Resource Allocation Type is TypeO.

11) Frequency Hopping Mode

Options: Disable | Intra-slot Frequency hopping | Inter-slot Frequency hopping;
Default: Disable.

Select to disable or enable different frequency hopping modes.

Note: Only displayed when the parameter Resource Allocation Type is TypeO.

12) Frequency Hops RB Offset
Configurable range: 0 ~ current BWP RB count - RB Number - RB Offset;
Default: 0.

When the parameter Hopping Mode is enabled, set the RB offset parameter for calculating the
RB start of each second hop.

Note: Only displayed when the parameter Hopping Mode is not Disable.

3. Code &Modulation
1) MCS Table
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When transform precoding is not enabled:

Options: QAM64 | QAM256 | QAM64Low SE | QAM1024.
When transform precoding is enabled:

Options: QAM64 | QAM256 | QAM64Low SE | QAM1024.
Default: QAM64.

Select the table for calculating TB size, as detailed in the 3GPP protocol physical layer protocol.

2) MCS
Default: 0.

Set the corresponding MCS index, with the specific range related to the corresponding table
in the 3GPP protocol.

3) xOverhead
Options: 0| 6| 12| 18, Default: 0.

Set the high-level parameter xOverhead in the 3GPP protocol, used to set the parameter N_,

for calculating TBS.

4) Coding Rate

Display the coding rate, obtained according to the MCS Table parameter.

5) Modulation

Display the modulation method, obtained according to the MCS Table parameter.

6) Transport Block Size

Display the TB Size, obtained according to the MCS Table parameter.

7) RV Index
Configurable range: 0 ~ 3, Default: 0.

Set the redundancy version RV index for rate matching.
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8) LBRM
Options: On | Off, Default: Off.

Set the LBRM parameter for the encoding process.

4. DMRS
1) PUSCH1 Enabled
Options: On | Off, Default: Off.

Toggle the enable state of the current PUSCH channel.

2) DMRS-r16
Options: On | Off, Default: Off.

Set whether to provide the high-level parameter dmrsUplink-r16.

3) n_SCID

Configurable range: 0 ~ 1, Default: 0.

Set the parameter ngy, for sequence generation.

4) Scrambling IDO
Configurable range: -1 ~ 65535;

Default: -1 (set to -1 to use CelllD).

Set the N{, for DMRS sequence generation.

5) Scrambling ID1
Configurable range: -1 ~ 65535;

Default: -1 (set to -1 to use CellID).

Set the N, for DMRS sequence generation.

6) PUSCH Mapping
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Options: TypeA | TypeB, Default: TypeA.
Set the PUSCH mapping type.

7) Group Hopping
Options: On | Off, Default: Off.

Toggle the enable state of PUSCH DMRS group hopping.

8) Sequence Hopping
Options: On | Off, Default: Off.

Toggle the enable state of PUSCH DMRS sequence hopping.

9) nIDRS
Configurable range: -1 ~ 65535;
Default: -1 (set to -1 to use CelllD).

Set the ni5 for DMRS generation.

10) DMRS Power Boosting
Configurable range: -40 dB ~ 40 dB, Default: 0 dB.

Set the power of PUSCH DMRS relative to the PUSCH channel.

11) DMRS Configuration Type
Options: Type1 | Type2, Default: Type1.

Set the DMRS configuration type.

12) DMRS Length
Options: Single Symbol|Double Symbol;
Default: Single Symbol.

Set the symbol length for DMRS.
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13) DMRS Additional Position

Options:

® Single symbol DMRS:
pos0 | pos1 | pos2 | pos3;

® DMRS Length is Double Symbol or Single symbol with intra-slot frequency hopping
enabled:

posO | posT.

Set the high-level parameter dmrs-AdditionalPosition in the 3GPP protocol.

14) PUSCH TypeA Position
Options: 2 | 3. Default: 2.

Set the high-level parameter dmrs-TypeA-Position in the 3GPP protocol.

5. PTRS
1) PUSCH1Enabled
Options: On | Off, Default: Off.

Toggle the enable state of the current PUSCH channel.

2) PTRS Enabled
Options: On | Off, Default: Off.

Toggle the enable state of the PTRS channel.

3) PTRS Power Boosting
Configurable range: -40 dB ~ 40 dB, Default: O dB.

Set the power of PTRS data relative to PUSCH data.

4) PTRSK (Frequency Density)
Options: 2 | 4, Default: 2.

Set the time domain density of PTRS, as detailed in the 3GPP protocol physical layer protocol.
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5) PTRS RE Offset
Options: 00 | 01| 10| 11, Default: 00.

Set the RE offset for PTRS.

6) PTRSL (Time Density)
Options: 1| 2 | 4, Default: 1.

Set the frequency domain density of PTRS, as detailed in the 3GPP protocol physical layer
protocol.

7) n PTRS Group
Options: 2 | 4 | 8, Default: 2.

Set the number of groups for each PT-RS group.

8) n PTRS Group Sample
Options: 2 | 4, Default: 2.

Set the number of groups for each PT-RS group.

9) nPTRSID
Configurable range: 0 ~ 65535, Default: 0.

Set the initialization parameter N_ID for PTRS sequence generation.

6. Antenna Port
1) PUSCH1Enabled
Options: On | Off, Default: Off.

Toggle the enable state of the current PUSCH channel.

2) DMRS Port
Configurable range: 0 ~ 4, Default: 0.

Set the port number for DMRS, which can be set to one or multiple values. Setting multiple
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values indicates multiple layers for PUSCH, with a maximum of 4 layers supported. Specific
constraints are detailed in Table 3-9.

Table 3-9 Antenna port and DM-RS duration constraints

Supported antenna ports P

DM-RS duration i ) .
Configuration type 1 Configuration type 2
single-symbol DM-RS 0 0-3 0-5
double-symbol DM-RS 0,1 0-7 0-11

3) Antenna Port
Options: 0~Layers Number — 1, Default: port 0.

Select the DMRS port, constrained by Layers Number.

4) Layers Number

Display the current number of layers, calculated based on the number of DMRS Ports.

5) DMRS CDM Groups w.o. Data
Configurable range: 1~3, Default: 1.

Set the number of CDM groups for DMRS that do not allow mapping PUSCH data, with
configuration Type1 having 2 CDM groups with a setting range of 1~2, and configuration type2
having 3 CDM groups.

6) PTRS Port
Configurable range: 0~5, Default: DMRS Port.

Set the port number for PTRS, which can be set to one or multiple values. The set values must
be included within DMRS Port. If DMRS port does not include a port number that supports
PTRS port, PTRS cannot be enabled.

7) Codebook Enable
Options: On | Off, Default: Off.

Enable or disable codebook transmission.
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8) TPMI Index

Configurable range:

® Single layer single antenna: 0;
® Single layer 2 antennas: 0 ~ 5;
® Single layer 4 antennas: 0 ~ 27;
® 2 layers 2 antennas: 0 ~ 2;

® 2 layers 4 antennas: 0 ~ 21;

® layers 4 antennas: 0 ~ 6;

® layers 4 antennas: 0 ~ 4.
Default: 0.

When the parameter Codebook is On, set the corresponding coding matrix index based on the
number of layers and antenna ports.

34.1.4 Meas Time

Search Length »

A

Meas
— e >
Offsot Meas Interval:

/‘ Analysis Length

Analysis Boundary
(Frame/SubFrame/Slot)

\ 4

1. Search Length
Configurable range: 0 ~ 100 s, Default: 22 ms.
Unit options: ns | s | us | s, Default: ms.

Set the length of the collected data, which will be used for synchronization search. This length
determines the data that can be demodulated.
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2. Analysis Boundary

Options: Frame | SubFrame | Slot, Default: Frame.

Select the boundary to align after successful synchronization.
1) Frame

After successful synchronization, adjust the measurement data to the frame header position.
This option requires the search length to exceed 2 frames to obtain a complete frame of

measurement data.
2) SubFrame

After successful synchronization, adjust the measurement data to the nearest subframe
boundary. In this case, at least one frame of search length is required for correct
synchronization and demodulation. If the search data is less than one frame, synchronization
may not always succeed, but demodulation is possible after successful synchronization.

3) Slot

After successful synchronization, adjust the measurement data to the nearest slot boundary.
In this case, at least one frame of search length is required for correct synchronization and
demodulation. If the search data is less than one frame, synchronization may not always

succeed, but demodulation is possible after successful synchronization.

3. Analysis Subframe
Configurable range: 0 ~ 10, Default: 10.

Set the number of subframes used for frequency offset estimation in demodulation.

4. Analysis Slot
Configurable range: 0 ~ 1, Default: 0.

Set the number of slots used for frequency offset estimation in demodulation. The current
analysis length is the sum of Analysis Subframe and Analysis Slot. This parameter is constrained
by Analysis Subframe. If Analysis Subframe is configured as 10, this parameter can only be set
to 0.

5. Meas Interval Subframe
Configurable range: 0 ~ current Analysis Subframe value, Default: 10.

Set the average subframe interval of the current analysis data, used to calculate demodulation
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parameters. This parameter, together with Meas Interval Slot and Meas Interval Symbol,
determines which part of the data's demodulation results are analyzed.

Note: The measurement length is the sum of Meas Interval Subframe, Meas Interval Slot, and
Meas Interval Symbol. The constraints of these three parameters comply with the 3GPP
protocol, and automatic carry-over occurs if conditions are met.

6. Meas Interval Slot
Configurable range: 0 ~ 1, Default: 0.

Set the slot interval of the current analysis data, used to calculate demodulation parameters.
This parameter, together with Meas Interval Subframe and Meas Interval Symbol, determines
which part of the data's demodulation results are analyzed.

Note: The measurement length is the sum of Meas Interval Subframe, Meas Interval Slot, and
Meas Interval Symbol. The constraints of these three parameters comply with the 3GPP
protocol, and automatic carry-over occurs if conditions are met.

7. Meas Interval Symbol
Configurable range: 0 ~ 13, Default: 0.

Set the symbol interval of the current analysis data, used to calculate demodulation parameters.
This parameter, together with Meas Interval Slot and Meas Interval Subframe, determines

which part of the data's demodulation results are analyzed.

Note: The measurement length is the sum of Meas Interval Subframe, Meas Interval Slot, and
Meas Interval Symbol. The constraints of these three parameters comply with the 3GPP
protocol. When this parameter is set to 14, it automatically carries over to Meas Interval Slot.

8. Meas Offset Subframe
Configurable range: 0 ~ current Analysis Subframe value, Default: 10.

Set the offset length from the measurement boundary, used to calculate demodulation
parameters. This parameter, together with Meas Offset Slot and Meas Offset Symbol,
determines the starting position of the analyzed measurement data.

Note: The offset length is the sum of Meas Offset Subframe, Meas Offset Slot, and Meas Offset
Symbol. The sum of the offset length and the measurement length cannot exceed the sum of
Analysis Subframe and Analysis Slot. The constraints of these parameters comply with the 3GPP
protocol, and automatic carry-over occurs if conditions are met.
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9. Meas Offset Slot
Configurable range: 0 ~ current Analysis Subframe value, Default: 10.

Set the offset length from the measurement boundary, used to calculate demodulation
parameters. This parameter, together with Meas Offset Subframe and Meas Offset Symbol,
determines the starting position of the analyzed measurement data.

Note: The offset length is the sum of Meas Offset Subframe, Meas Offset Slot, and Meas Offset
Symbol. The sum of the offset length and the measurement length cannot exceed the sum of
Analysis Subframe and Analysis Slot. The constraints of these parameters comply with the 3GPP

protocol, and automatic carry-over occurs if conditions are met.

10. Meas Offset Symbol
Configurable range: 0 ~ current Analysis Subframe value, Default: 10.

Set the offset length from the measurement boundary, used to calculate demodulation
parameters. This parameter, together with Meas Offset Slot and Meas Offset Subframe,
determines the starting position of the analyzed measurement data.

Note: The offset length is the sum of Meas Offset Subframe, Meas Offset Slot, and Meas Offset
Symbol. The sum of the offset length and the measurement length cannot exceed the sum of
Analysis Subframe and Analysis Slot. The constraints of these parameters comply with the 3GPP

protocol, and automatic carry-over occurs if conditions are met.

3.4.1.5 Advanced

1. General
1) Sync Mode
Options: CP Correlation | Time Cross Correlation, Default: CP Correlation.

Select the synchronization type required for demodulation.

2) Sync Signal
Options: Auto | SSB | PDSCH DMRS | PDCCH DMRS | CSI-RS,
Default: Auto.

Select the synchronization signal required for demodulation.
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3) Multicarrier Filten
Options: On | Off, Default: Off.

When multiple carriers are present in the current signal, a filter can be used to remove other

carriers.

4) DC Punctured
Options: On | Off, Default: Off.

Toggle the state of DC participation in demodulation.

5) Report EVM in dB
Options: On | Off, Default: Off.

Toggle the unit display of the current EVM. When Off is selected, %rms is displayed by default.
When On is selected, dB is displayed.

6) Symb Clock Err Compensation
Options: On | Off, Default: Off.

When enabled, the data before demodulation will first undergo Clock error compensation.

2. Window

1) Symbol Time Adjust

Options: Win Start | Win Center | Win End | %FFT size;
Default: Win End.

Select the windowing type.

2) %FFT Size
Configurable range: -25% ~ 0;
Default: -1.76 %.

Set the percentage relative to the FFT Size.
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3. 3GPP Conformance Test
Options: On | Off;
Default: On.

Toggle the 3GPP measurement switch. When On is selected, 3GPP settings will be used for
EVM calculation. When Off is selected, Equalizer and Tracking related parameters can be
configured.

4. Equalizer

1) Equalizer Type
Options: Off | RS | RS+Data;
Default: RS.

Set the equalization type.

2) Time Averaging Type
Time domain averaging type: Slot | SubFrame | Frame | Measure Length, Default: Slot.

Set the length of averaging in the time domain.

3) Frequency Moving Length
Setting value: 0~65535, Default: 19.

Set the length of frequency domain smoothing.

5. Tracking
1) Tracking Mode
Options: Off | RS | RS+Data, Default: RS.

Set the tracking mode.

2) Track Amplitude
Options: On | Off, Default: Off.
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Choose whether to use reference signals for amplitude correction.

3) Track Phase
Options: On | Off, Default: Off.

Choose whether to use reference signals for phase correction.

4) Track Timing
Options: On | Off, Default: Off.

Choose whether to use reference signals for timing offset correction.

3.4.2 Measurement Result

The 5G NR measurement result settings path is: Trace -> Format.

Trace1 o= AddTrace (%) Delete Trace

Format

Data Group Demod Error
Data Result Error Vector Spectrum
Carrier CCco

SCS H=2:80kHz

Setup steps:
1) Select the display window;
2) Select Group, different measurement results are placed in different groups;

3) Select the measurement result data to be displayed.

Measurement result example (Uplink):
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U} SIGLENT SigVSA __
File Edit Control InputOutpst MeasSetup Trace

=3 {] sonei -

Measurement Management X o ¢ % v SGNR1-Spectrum(Tred)

= AddGroup = NewMeasurement
Groupt

~ SGNR1 g

Power par REWBM) NumRB

Measurement result example (Downlink):

7 SIGLENT SigVSA - 5 X
Fie EGt Control InputOutput MessSetup Trace Markers Window
=3 1] sanr1 - =
Measurament Management > SGNR1:RawMainTime(Trel) % v SGNR1:Spectrum(Trcd)
 AddGroup <[ NewMeasurement
494

Geoupl

v SGNR1 '@

I

e

|

1. Raw Main Time

Display the modulus of the raw data input from hardware or read from a playback file, with

time on the x-axis and amplitude on the y-axis.

2. Spectrum

Display the spectrum of the raw data input from hardware or read from a playback file, with
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frequency on the x-axis and amplitude on the y-axis.

3. 1Q Meas Time

IQ measurement time displays the constellation diagram of the data within the measurement
length, with amplitude (normalized amplitude) on both the x-axis and y-axis. Different channels
are distinguished by different colors.

4. RMS Error Vector Spectrum

RMS error vector spectrum displays the root mean square (RMS) EVM of each subcarrier, with
RMS calculation of EVM for all symbols within the measurement range on each subcarrier. The
x-axis shows the subcarrier range within the entire channel bandwidth, in units of
subcarrier|ksubcarrier; the y-axis shows RMS EVM, in units of %.

5 Error Vector Time

Error vector time domain displays the EVM at the subcarrier level, with time on the x-axis and
EVM values on the y-axis. Each trace represents the EVM of each symbol on a subcarrier within

the measurement range, and all subcarrier traces overlap.

6. Error Vector Spectrum

Error vector frequency domain displays the EVM at the subcarrier level, with subcarriers on the
x-axis and EVM values on the y-axis. Each trace represents the EVM of each subcarrier on a
symbol, and all symbol traces within the measurement range overlap.

7. RE Allocation

Display the resource allocation of each channel within the measurement range, equivalent to
a resource grid view, with symbols on the x-axis and subcarriers on the y-axis. Different
channels are distinguished by different colors.

8. Error Summary
Error summary displays the following error items of the measurement data:
Channel Power: Display the average power of the carrier;

EVM (RMS/Peak): Display the RMS EVM and peak EVM of all measured channels;
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Freq Error: Frequency offset relative to the carrier center;

Clock Error: Clock deviation between the measured signal and the reference signal, in ppm;
this parameter may not be displayed if the number of RBs of the signal is too small to calculate.

Time Offset: Display the time deviation from the start position of the collected data to the start
position of the measurement interval (Meas Interval);

Sync Correlation: Display the correlation between the measured synchronization signal and the
ideal reference synchronization signal;

Magnitude Error: Display the amplitude error between the measured signal and the reference
signal;

Phase Error: Display the phase error between the measured signal and the reference signal.

9. Frame Summary

Frame summary parameters are calculated from the measurement data within the
measurement length range, including the following parameters of the measurement data:

Channel: Display the name of the currently enabled channel;

® Uplink: PUCCH | PUSCH | PTRS | PUCCH_DMRS | PUSCH_DMRS;

® Downlink: PDCCH | PDSCH | PTRS | PDCCH-DMRS | PDSCH-DMRS | SSB
P-SS | S-SS | PBCH | PBCH-DMRS | CSI-RS

EVM (%rms): Display the RMS EVM of the current channel;

Power Per RE (dBm): Display the power of each subcarrier of the current channel, averaged
over all subcarriers of the current channel;

Modulation: The modulation scheme of the current channel, if there is no modulation scheme,
it will not be displayed;

Num.RB: Display the total number of RBs occupied by the current channel. PUCCH | PUSCH |
PDCCH | PDSCH and their corresponding reference signals calculate the number of RBs
together.
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35 LTE
LTE demodulation is compatible with the LTE standard: 3GPP TS36 V17.3.0.
3.5.1 Configuration

The path to access LTE settings is: Meas Setup -> 4G LTE Properties.

File Edit Control InputOutput MeasSetup Trace Markers Wir

I]] = —_[ AGLTE1| == New Measurement

Measurement Management Remove Measurement b IC

o= AddGroup == NewMeasureme:

Measure Management...

- Group1
Current Measurement
+ AGLTE1 '@ ]| -
Measurement Type: AGLTE »

e File ) Remotel .
B [4G LTE 1] Properties...

3.5.1.1 Config Carrier

Currently, only single-carrier is supported.

Config Carrier Profile
Direction Downlink ~  Duplex Mode

cpP

Carrier = BandWidth Test Mode r Sync Type  Sync Slo .. o CelllD Length

Ccco 10MHz TEST_MODE_CFF Auto

BandWidth 10MHz ~  Mirror Freq Spectrum

Sync Type PSS ~  Sync Slot

CellID Auto Auto ~  CelllD
CRSPort Num 1 ~  CRSRef Port0
CP Length Auto ~  Center Frequency 1GHz

TestMode TEST_MODE_OFF
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1. Direction
Options: Downlink | Uplink, Default: Downlink.

Toggles the carrier state and related configurations.

2. Duplex Mode
Options: TDD | FDD, Default: FDD.

Toggles the carrier duplex type and related configurations.

3. BandWidth
Options: 1.4MHz | 3MHz | 5MHz | 10MHz | 15MHz | 20MHz, Default: 10MHz.

Toggles the carrier bandwidth.

4. Mirror Freq Spectrum
Options: On | Off, Default: Off.

Enables or disables mirror frequency spectrum.

5. TDD Config (TDD)
Options: Config 0 ~ 6,
Default: Config 0.

Sets the TDD configuration option.

TDD Config Uplink/Downlink Subframe Allocation
0 D.S.U.U.U.D.S.U.U.U
1 D.S.U.U.D.D.S.U.UD
2 D.S.U.D.D.D.S.U.D.D
3 D.S.U.U.U.D.D.D.D.D
4 D.S.U.Uu.D.D.D.D.D.D
5 D.S.U.D.D.D.D.D.D.D
6 D.S.U.U.U.D.S.U.U.D

Where: D = Downlink subframe, U = Uplink subframe, S = Special subframe.
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6. Special Subframe Config (TDD)
Options:

® Config 0 ~ 10 (normal CP),

® Config 0 ~ 7 (extended CP).
Default: Config 0.

Sets the DWPTS/UpPTS configuration option for special subframes. For more information, refer
to 3GPP TS 36.211 Table 4.2-1.

7. Sync Type
Options: PSS | CRS, Default: PSS.

Toggles the synchronization method.

8. Sync Slot
Options: 0 ~ 19, Default: 0.

Configures the slot number used for CRS synchronization.

9. Cell ID Auto
Options: Auto | Manual, Default: Manual.

Sets the method for obtaining the Cell ID.

10. Cell ID
Configurable range: 0 ~ 503.

Sets the value of the Cell ID.
11. CRS Port Num
Options: 1| 2 | 4, Default: 1.

Sets the number of CRS ports.

12. CRS Ref
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Options: 0 ~ CRS Port Num - 1, Default: 0.

Selects the CRS reference port.

13. CP Length
Options: Auto | Normal | Extended, Default: Auto.

Selects the CP length type, where Auto automatically detects the CP type.

14. Test Mode

Options:

® TEST MODE OFF |TM 1.1 |TM_1 2|
e TM2|TM2A|TM 2 B|

e TM31|TM 3 1A|TM 3 1 B|

e TM32

Default: TEST MODE_OFF.

Toggles the test mode.

3.5.1.2 Channel (Downlink)

1. Power Boost
Configurable range: -20dB ~ 20dB, Default: 0dB.

Sets the power of the corresponding channel.

2. Auto Detect
Options: On | Off, Default: On.

Enables or disables automatic search for control channel power. When disabled, you can
configure the power of the channel by clicking the power window of the corresponding
channel under Power Boost.
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rrier Profile

CRS P35 555 PBECH PHICH PCFICH AutoDetect PAEnable

PowerBoost 0dB 0dB 0dB 0dB 0dB 0dB

9  AutoDetect

Cancel
v

3. PAEnable
Options: On | Off, Default: On.

Toggles the enable state of the data channel PA.

4. PDCCH
2

Config Carrier Profile Advanced Meas Time

PSS 558 CRS PBCH PCFICH PHICH AutoDetect PA Enable
Power Boost vy o
PDCCH PDSCH PHICH

Power Boost

Allocations

Subframe 0 ¢ 3 9  AutoDetect

Symbol =

1) Power Boost
Configurable range: -20dB ~ 20dB, Default: 0dB.

Sets the power of PDCCH.
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2) Auto Detect
Options: On | Off, Default: On.

Enables or disables automatic search for the number of symbols occupied by PDCCH in each
subframe. When disabled, you can configure the number of symbols occupied by PDCCH by
clicking the Symbol item under the corresponding subframe number.

PDCCH PDSCH PHICH
Power Boost
Allocations

Subframe 0O i 3 > Auto Detect

Symbol

3) Symbol
Configurable range: 1 ~ 3, Default: 1.

Sets the number of symbols occupied by PDCCH in each subframe.

5 PDSCH
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Profile

888 CRS PCFICH
Power Boost
PDCCH PDSCH PHICH
AutoDetect On
Include
QPSK 160AM 640AM 2560AM 10240AM

= L L

o= Add (%) Remove

Name RB Num RB Offset
(VE=T0] 6 0

UserQ
RBNum
Power

Allocation 1N

1) Auto Detect

Options: On | Off, Default: On.

PHICH AutoDetect PAEnable

L

-~ Precoding

Allocation

M

RB Offset

Mod Type

Mod Type

QPSK

Enables or disables automatic search for PDSCH modulation type and power.

2) Precoding
Options: Off | Sp.Mux | Tx.Div, Default: Off.

Sets the precoding type for PDSCH data.

3) Include

Options: On | Off,

Default:

® On (QPSK/16QAM/64QAM),
e Off (256QAM/1024QAM).

Sets the modulation types included during PDSCH auto-detection.
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4) Add

Used to manually add a new PDSCH channel, with a maximum of 5 PDSCH channels supported.

Click the corresponding User in the table to configure this PDSCH channel in detail below.

PDCCH PDSCH PHICH

Auto Detect On ~ Precoding
Include

QPSK 16QAM B4QAM 256QAM 1024QAM

= = = O (]

o= Add () Remove

Name RB Num RB Offset Allocation
UserQ 6 0 mmmmm
User1 50 o] mnnmm

Userl

RB Num RB Offset
Power 0dB Mod Type
Allocation mnmmm

5) Remove

Used to remove manually added PDSCH channels.

6) RBNum
Configurable range: 1RB ~ (BandWidth RB count - 1), Default: 6RB.

Sets the number of RBs occupied by the PDSCH channel in one subframe.

7) RB Offset
Configurable range: ORB ~ (BandWidth RB count - RB Num), Default: ORB.

Sets the RB offset within the subframe.

8) Power

Configurable range: -20dB ~ 20dB, Default: 0dB.
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Sets the power of PDSCH.

9) Mode Type
Options: QPSK | T6QAM | 64QAM | 256QAM | 1024QAM, Default: QPSK.

Sets the modulation scheme for PDSCH data.

10) Allocation
Options: On | Off, Default: On.

Sets the enable state of PDSCH subframes. Clicking this configuration item opens a sub-
window to configure the enable state of each subframe.

User1

RE Num S50RB REB Offset

Power OdB Mod Type

Allocation 111

rier Profile

PCFICH PHICH AutoDetect PAEnable

Power Boost = =

PDSCH PHICH

Auto ~ Duration Auto

1) Ng
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Options: Auto | 1/6 | 1/2 | 1| 2, Default: Auto.

Sets the value of the Ng parameter. Auto enables automatic search for the Ng value.

2) Duration
Options: Auto | Normal | Extended, Default: Auto.

Sets the duration of PHICH. Auto enables automatic search for the PHICH duration.

3.5.1.3 Channel (Uplink)

3.5.1.3.1 Common

Set common parameters that apply to all uplink channels.

Sequence Hopping ( »  Group Hopping

RNTI

PUSCH PUCCH
PUSCH State ( ~  Power Boosting
Auto Sync ( ~  Sync Slot
PUSCH Common
FreqHopping ( ~ HopMode
N_HORB > Nsb
Delta ss - nDMRS(1)

PUSCHID - © DMRSPUSCHCSHID

Layer Number = Activate DMRS with OCC

1. Sequence Hopping
Options: On | Off, Default: Off.

Toggle the enable state of sequence hopping, uniformly setting PUCCH-DMRS and PUSCH-
DMRS with this parameter.

2. Group Hopping
Options: On | Off, Default: Off.
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Toggle the enable state of group hopping, uniformly setting PUCCH-DMRS and PUSCH-DMRS
with this parameter.

3 RNTI
Range: 0 ~ 65535, Default: 1.

Set the RNTI value, uniformly configuring PUCCH and PUSCH with this parameter.

3.5.1.3.2 PUSCH

LTE uplink supports only a single PUSCH configuration.

g Carrier Profile
Common

Sequence Hopping ( Group Hopping
RNTI

PUSCH
PUSCH State ( ~  Power Boosting

Auto Sync ( ~  Sync Slot

PUSCH Common

FreqHopping ( ~~ HopMode
N_HORB > Nsb
Delta ss - nDMRS(1)

PUSCHID - © DMRSPUSCHCSHID

Layer Number : Activate DMRS with OCC

1. PUSCH State
Options: On | Off, Default: On.

Toggle the enable state of the PUSCH channel.

2. Power Boosting
Range: -40 dB ~ 40 dB,
Default: 0 dB.

Set the power of the PUSCH channel relative to other channels.
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3. Auto Sync
Options: On | Off, Default: On.

Toggle the enable state of PUSCH auto-sync. When On, the current channel uses auto-sync; if
Off, manual selection of the first slot for current sync is supported.

4. Sync Slot
Range: 0 ~ slot length-1, Default: 0.
Set the starting slot for PUSCH demodulation sync.

Note: Configurable only when Auto Sync is set to Off.

5. Freq Hopping

Options: Off | Inter-Subframe | Intra and Inter-Subframe,
Default: Off.

Turn off or select different hopping modes for PUSCH.

Intra and inter-subframe hopping: Hopping occurs both within the same subframe and
between different subframes.

Inter-subframe hopping: Hopping occurs between subframes, not between the two slots within

the same subframe.

6. Hop Mode

Options: Type1 +1/4 | Typel -1/4 | Typel +1/2 | Type2,
Default: Typel +1/2.

Select the hopping type for PUSCH.

Note: This option is not configurable when Hopping Mode is Off, with different Hopping Mode
having different selectable ranges.

7. N HO RB
Range: 0 ~ maximum RB number for current bandwidth - 1,
Default: 0.

Set the hopping offset for the current PUSCH, with this parameter and other RB-related
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parameters constrained by 3GPP protocol.

Note: This option is not configurable when Hopping Mode is Off.

8. Nsb
Range: 1 ~ 4, Default: 1.
Set the number of subbands for PUSCH.

Note: This option is not configurable when Hopping Mode is Off.

9. Deltass
Range: 0 ~ 29, Default: 0.

Set DMRS sequence parameters for calculating sequence shift.

10. nDMRS (1)
Range: 0 ~ 1, Default: 0.

Set DMRS sequence-related parameters (for PUCCH formats 4 and 5, range as per Table 3-10),
calculating the cyclic shift for intra-frame demodulation reference signals (DMRS).

Table 3-10 (TS36.211 Table 5.5.2.1.1-2) Mapping of cyclic Shift to 7 )zs values

cyclicShift n ks
0 0
1 2
2 3
3 4
4 6
5 8
6 9
7 10

11. PUSCH ID
Range: 0 ~ 509, Default: -1 (no configuration).

Set the PUSCH ID value.
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12. DMRS PUSCH CSH ID
Range: 0 ~ 509, Default: -1 (no configuration).

Set the initial value for cyclic shift hopping used in PUSCH DMRS pseudo-random sequence
generation.

13. Layer Number
Options: 1(1 Antenna) |2(2 Antennas) | 4 (4 Antennas), Default: 1.

Set the number of layers for PUSCH, with the range depending on the number of antennas.

14. Activate DMRS with OCC
Options: On | Off, Default: Off.

Determine whether DMRS uses orthogonal cover code (OCC).

15. PUSCH Transmission Table

Click to enter the subframe configuration interface for PUSCH, supporting individual parameter

configuration for each subframe.

ves PUSCH Transmission Table X

Frame Subframe State DMRSPower RA Type RBOffset RBSize RBGStart1 RBGEnd1 RBGStart2 RBGEnd2 MCSIndex CSField Index

1) Frame

Display the frame number corresponding to each frame.
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2) Subframe

Display the subframe number corresponding to each subframe.

3) State
Options: On | Off, Default: On.

Toggle the enable switch for each subframe.

4) DMRS Power
Range: -40 dB ~ 40 dB, Default: 0 dB.

Set the power of PUSCH DMRS relative to the PUSCH channel for each subframe.

5) RAType
Options: Type 0 | Type 1, Default: Type 0.
Set the mapping type for PUSCH.

6) RB Offset
Range: 0 ~ maximum RB number for current bandwidth - PUSCH RB Size, Default: 0.

Set the RB offset for the current subframe of PUSCH, with the range constrained by the

maximum RB number for current bandwidth and RB Size.

Note: Configurable only when PUSCH's RA Type is set to Type 0.

7) RBSize
Range: 0 ~ maximum RB number for current bandwidth, Default: 25.

Set the number of RBs occupied by the current subframe of PUSCH, with RB Size and RB Offset
not exceeding the maximum RB number for current bandwidth.

8) RBG Start 1
Range: 1 ~ RBG End 1 -1, Default: 1.

Set the starting position 1 of RBG for the current subframe of PUSCH when RA Type is Type 1.
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Note: Configurable only when PUSCH's RA Type is set to Type 1.

9) RBGENd1
Range: RBG Start 1 + 1 ~ RBG End 2 — 1, Default: 8.
Set the ending position 1 of RBG for the current subframe of PUSCH when RA Type is Type 1.

Note: Configurable only when PUSCH's RA Type is set to Type 1.

10) RBG Start 2
Range: RBG End 1 + 1 ~ RBG Start 2 — 1, Default: 10.
Set the starting position 2 of RBG for the current subframe of PUSCH when RA Type is Type 1.

Note: Configurable only when PUSCH's RA Type is set to Type 1.

11) RBG End 2

Range: RBG End 1 + 1 ~ maximum RBG number for current bandwidth;

Default: 18.

Set the ending position 2 of RBG for the current subframe of PUSCH when RA Type is Type 1.

Note: Configurable only when PUSCH's RA Type is set to Type 1.

12) MCS Index
Range: 0~28, Default: 0.

Set the MCS index for the current subframe, affecting modulation mode and TBS index, refer
to 3GPP TS 36213 for more information.

13) CS Field Index
Range: 0 ~ 7, Default: 0.

Set the cyclic shift index for the current subframe.

3.5.1.3.3 PUCCH

LTE uplink supports only a single PUCCH configuration.
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Profile
TIMon
Sequence Hopping ( ~ Group Hopping
RNTI

PUCCH

PUCCH State ( ~ Power Boosting

Auto Sync ( ~ Sync Slot

N_RB(2) > NCS()

Delta Shift PUCCH > PUCCHID

1. PUCCH State
Options: On | Off, Default: On.

Toggle the enable switch for the PUCCH channel.

2. Power Boosting
Range: -40 dB ~ 40 dB, Default: 0 dB.

Set the power of PUCCH data relative to other channels.

3. Auto Sync
Options: On | Off, Default: On.

Toggle the enable state of PUCCH auto-sync. When On, the current channel uses auto-sync; if
Off, manual selection of the first slot for current sync is supported.

4. Sync Slot
Range: 0 ~ slot length-1, Default: 0.
Set the starting slot for PUSCH demodulation sync.

Note: Configurable only when Auto Sync is set to Off.

5. NRB(2)

Range: 0 ~ maximum RB number for current bandwidth, Default: 0.
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Set the number of RBs used for PUCCH format 2/2a/2b resources (nPUCCH?2).

6. N_C5(1)
Range: 0 ~ 7, Default: 0.

Set the number of resources for format 1 in mixed resources of PUCCH format 1/1a/1b and
format 2/2a/2b.

7 Delta Shift PUCCH

Range: 1 ~ 3, Default: 1.

Set the cyclic shift interval AEEiECH for PUCCH format 1/1a/1b.

8. PUCCH ID
Range: -1 ~ 509, Default: -1.
Set the PUCCH parameter npp " .
9. PUCCH Transmission Table

Click to enter the subframe configuration interface for PUCCH, supporting individual
parameter configuration for each subframe.

vs+ PUCCH Transmission Table X

nPUCCH(10) nPUCCH(11) nPUCCH(20) nPUCCH(21) nPUCCH(30) nPUCCH(3.1) nPUCCH(40) nPUCCH(5.0) nPUCCH(4sb) noc ndmrsl niddmrs Di

1) Subframe

Display the subframe number corresponding to each subframe.

2) State
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Options: On | Off, Default: On.

Toggle the enable switch for each subframe.

3) DMRS Power
Range: -40 dB ~ 40 dB, Default: 0 dB.

Set the power of PUCCH DMRS relative to the PUCCH channel.

4) PUCCH Format

Options:

Format 1 | Format 1a | Format 1b | Format 2 | Format 2a
Format 2b | Format 3 | Format 4 | Format 5.

Default: Format 1.

Set the PUCCH format for the current subframe.

5) Data Size
Range: 1 ~ 13, Default: varies by format.

Set the number of bits for the current subframe.

6) nPUCCH (1,0)

Range: maximum value constrained by CP Type, maximum RB number for current bandwidth,
and Delta Shift PUCCH,

Default: 0.
Set the resource index for PUCCH Format 1| 1a | 1b, refer to 3GPP protocol 36211 for details.

Configurable only when PUCCH Format is setto 1| 1a| 1b.

7) nPUCCH (1,1)

Range: maximum value constrained by CP Type, maximum RB number for current bandwidth,
and Delta Shift PUCCH,

Default: 0.
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Set the resource index for PUCCH Format 1 | 1a | 1b with 2 antennas, refer to 3GPP protocol
36211 for details.

Configurable only when PUCCH Format is setto 1| 1a| 1b.

8) nPUCCH (2,0)
Range: maximum value constrained by N _RB(2) and N_CS(1), Default: 0.
Set the resource index for PUCCH Format 2 | 2a | 2b, refer to 3GPP protocol 36211 for details.

Configurable only when PUCCH Format is set to 2 | 2a | 2b.

9) nPUCCH (2,1)
Range: maximum value constrained by N RB(2) and N_CS(1), Default: 0.

Set the resource index for PUCCH Format 2 | 2a | 2b with 2 antennas, refer to 3GPP protocol
36211 for details.

Configurable only when PUCCH Format is set to 2 | 2a | 2b.

10) nPUCCH (3,0)

Range: maximum value constrained by maximum RB number for current bandwidth, Default:
0.

Set the resource index for PUCCH Format 3, refer to 3GPP protocol 36211 for details.

Configurable only when PUCCH Format is set to 3.

11) nPUCCH (3,1)

Range: maximum value constrained by maximum RB number for current bandwidth, Default:
0.

Set the resource index for PUCCH Format 3 with 2 antennas, refer to 3GPP protocol 36211 for
details.

Configurable only when PUCCH Format is set to 3.

12) nPUCCH (4,0)

Range: 0 ~ maximum RB number for current bandwidth / 2, Default: 0.
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Set the resource index for PUCCH Format 4, refer to 3GPP protocol 36211 for details.

Configurable only when PUCCH Format is set to 4.

13) nPUCCH (5,0)
Range: 0 ~ maximum RB number for current bandwidth, Default: 0.
Set the resource index for PUCCH Format 5, refer to 3GPP protocol 36211 for details.

Configurable only when PUCCH Format is set to 5.

14) NPUCCH(4,rb)

Display the number of RBs for PUCCH Format 4 in the current subframe, corresponding to the
parameter.

Displayed only when PUCCH Format is set to 4.

15) noc
Range: 0 | 1, Default: 0.
Set the spreading sequence index for PUCCH Format 5 in the current subframe.

Configurable only when PUCCH Format is set to 5.

16) Delta SS
Range: 0 ~ 29, Default: 0.

Set DMRS sequence parameters for calculating sequence shift.
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3.5.1.4 Meas Time

Frame
Boundary

Meas Meas Length

Offset

—_— " — —

|

£

)
|

Result Length(20 Slots)

—_— e — — e —

Raw Main Time

1. Meas Offset
1) Slot Offset
Range: 0~19, Default: 0.

Set the offset for measurement slots.

2) Symbol Offset
Range:

® 0~ 6 (normal CP),

® (0 ~ 5 (extended CP);
Default: 0.

Set the offset for measurement symbols.

2. Meas Length
1) Slot Length
Range: 0~20, Default: 20.

Set the measurement length (in slots).

2) Symbol Length
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Range:

® 0~ 6 (normal CP),

® 0~ 5 (extended CP);
Default: 0.

Set the measurement length (in symbols).

3.5.1.5 Advanced

1. Equalizer
1) Equalizer Type
Options: Off | RS | RS+DATA, Default: RS.

Select the type of equalizer.

2) Moving Avg Filter

Range: 1 ~ Number of RBs set by BandWidth - 1,
Default:

® 19 (3MHz | 5MHz |[10MHz | 15MHz [20MHz),
® 5 (1.4 MHz).

Set the length of the moving average filter.

2. EVM window
1) Window Type
Options: 3GPP | CUSTOM, Default: 3GPP.

Set the type of EVM window.

2) Window Length
Range: 1~512, Default: 32.

Set the length of the EVM window. Not configurable when the window type is 3GPP, as it is
defined by the protocol. For more information, refer to 3GPP TS 36101 Section F.5.
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3) EVM Window Adjust Type
Options: Start | Center | End, Default: Center.

Set the position of the EVM window.

3. EVM Minimization
1) EVM Minimization Type
Options: OFF | 3GPP | Tracking, Default: 3GPP.

Set the type of EVM minimization.

2) Timing
Options: On | Off, Default: On.

Toggle the enable state of timing compensation.

3) Amplitude
Options: On | Off, Default: Off.

Toggle the enable state of amplitude compensation.

4) Freq And Phs
Options: On | Off, Default: On.

Toggle the enable state of frequency and phase compensation.

352 Measurement Result

LTE measurement results setup path: Trace -> Format.

Trace1 o= AddTrace (%) Delete Trace

Format

Data Group Pre-demod

Data Result RawMain Time

www.siglent.com 151



SigVSA Vector Signal Analysis Software User Manual

Setup steps:
1) Select the display window;
2) Select Group, different measurement results are placed in different groups;

3) Select the measurement result data to display.

Example of measurement results (Downlink):

5 SIGLENT SigVSA 5

arkers Window  Utilities  Help

ME 1w

MessurementManagement % LTE1:RawMain Tame(Trct) 0 % ¥ LTE:Spectrumi(Ticd)

vy m“‘w|’\]W’MM,}Mi,jﬂﬂ'{l'?{‘lﬁW’\MI1ﬁ“IW

K

i

Example of measurement results (Uplink):

; SIGLENT SigVSA &
Fie Edt Control InputOuput MessSetup Trace Markers Window Utities Help

M B ] wue L L

Measurement Management % | ¥ LTE1:RawMainTime(Trcl) % | W LTE1:Spectrumi(Trcd) % | W LTE1:RMSEmor Vector Time(Tre7)

= AddGroup [ NewMeasuremant

anfl A e [l

v 4GUTET i@

W W

Stop 139sym

LTE 1: Frame Summary{Trc3)

(] Power(dB) EVMOims)
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1. Raw Main Time

Display the magnitude of raw data input from hardware or read from a playback file, with time
on the x-axis and amplitude on the y-axis.

2. Spectrum

Display the spectrum of raw data input from hardware or read from a playback file, with
frequency on the x-axis and amplitude on the y-axis.

3. 1Q Meas Time

IQ Measurement Time displays the constellation diagram of data within the measurement
length, with amplitude (normalized amplitude) on both the x-axis and y-axis. Different channels
are distinguished by different colors.

4. RMS Error Vector Spectrum

RMS Error Vector Spectrum displays the Root Mean Square (RMS) EVM for each subcarrier,
calculating the RMS EVM for all symbols within the measurement range on each subcarrier.
The x-axis shows the subcarrier range across the entire channel bandwidth, in units of

subcarrier|ksubcarrier; the y-axis shows the RMS EVM, in units of %.

5. RMS Error Vector Time

RMS Error Vector Time displays the Root Mean Square (RMS) EVM for each symbol, calculating
the RMS EVM for all subcarriers within the measurement range on each symbol. The x-axis
shows the symbol range across the entire channel bandwidth, in units of symbol; the y-axis
shows the RMS EVM value, in units of %.

6. Error Vector Time

Error Vector Time displays the EVM at the subcarrier level, with time on the x-axis and EVM
values on the y-axis. Each trace represents the EVM of each symbol within the measurement
range on a subcarrier, with traces of all subcarriers overlapping each other.

7. Error Vector Spectrum
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Error Vector Spectrum displays the EVM at the subcarrier level, with subcarriers on the x-axis
and EVM values on the y-axis. Each trace represents the EVM of each subcarrier on a symbol,
with traces of all symbols within the measurement range overlapping each other.

8. RE Allocation

Display the resource allocation of each channel within the measurement range, equivalent to
a resource grid view, with symbols on the x-axis and subcarriers on the y-axis. Different
channels are distinguished by different colors.

9. Error Summary

Error Summary includes the following error items of the measurement results:

Channel Power: Display the average power of the carrier, in units of dBm;

EVM (RMS/Peak): Display the RMS EVM and peak EVM of all current measurement channels;
RS Tx. Power (Downlink): Display the average power of the CRS signal, in units of dBm;

OFDM Sym. Tx. Power (Downlink): Display the average power of data subcarriers, in units of
dBm;

Frequency Error: Frequency offset relative to the carrier center, in units of Hz;

Sync Correlation: Display the correlation between the measured synchronization signal and the

ideal reference synchronization signal;

Common Tracking Error: RMS average of corrections applied to each symbol through EVM
minimization;

Time Offset: Distance from the start of the search time trace to the measurement frame header,
in units of s;

CP Length Mode: CP type of the signal (normal CP or extended CP);
Cell ID: Cell ID of the signal.

10. Frame Summary

Frame Summary parameters are calculated from the measurement data within the

measurement length, including the following parameters of the measurement data:
Channel :

® Downlink channels: CRS/PBCH/PCFICH/PDCCH/PDSCH/PHICH/P-SS/S-SS;
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® Uplink channels: PUCCH/PUSCH/PUCCH_DMRS/PUSCH_DMRS.

Power Per RE(dBm): Display the power of each subcarrier of the current channel, averaged over
all subcarriers of the current channel;

EVM: RMS EVM of the current channel;

Mod.Format: Modulation scheme of the current channel, not displayed if there is no
modulation scheme;

Num.RB: Number of RBs occupied by the current channel.
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36 NB-loT

3.6.1 Configuration

The path to enter the NB-loT configuration interface is: Meas Setup -> NB-loT Properties.

; SIGLENT SigVSA
File Edit Control InputOutput MeasSetup Trace Markers Win

I]] _: NB-loT1| =f= New Measurement

Measurement Management Remove Measurement (-

o= AddGroup = NewMeasureme:
Current Measurement
~ Group1
Measure Management...

~ NB-loT1 m g

Measurement Type: NB-loT »

» File {7y Remote [ _
) [MB-loT 1] Properties...

3.6.1.1 Config Carrier

1. Direction

Uplink/downlink type of the carrier. Default value is Downlink.

2. Duplex Mode

Duplex mode of the carrier. Default is FDD.

1. Operation Mode
NB-loT signal mode. Options: Standalone | In-band | Guard Band. Default value is Standalone.

Operation mode. Double-click or use the drop-down menu to set the operation mode, which
specifies the deployment mode of the NB-loT downlink carrier.

® Stand-Alone: Independent deployment mode. The system bandwidth is set to 200 kHz.

® Guard-Band: Guard band deployment mode. The system bandwidth is set to the same as
that of the coupled E-UTRA carrier.

® In-Band: In-band deployment mode.
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4. Half-subcarrier Shift

Half-subcarrier shift, used to control whether the uplink transmission subcarrier is shifted by
half the subcarrier spacing (i.e., 7.5 kHz). For downlink, this parameter is only used as a test
configuration parameter, setting the instrument's downlink demodulation algorithm to
"comply with LTE standards regarding subcarrier shift."

For more information, see 3GPP TS 36.331, Section 6.7.2.

5. Center Frequency

Carrier center frequency.

6. Bandwidth
Carrier bandwidth. Not visible under Standalone Operation Mode.

Options: 1.4 MHz (6 RB) | 3 MHz (15 RB) | 5 MHz (25 RB) | 10 MHz (50 RB) | 15 MHz (75 RB) |
20 MHz (100 RB).

Default value: 10 MHz (50 RB).

7.  Frequency Offset
Frequency offset.

® Stand-Alone: Sets the frequency offset of the carrier relative to the signal generator's

current frequency setting.

® The value range of this parameter is affected by the following factors: oversampling ratio,
base sampling rate, system bandwidth, and the maximum arbitrary waveform sampling
clock of the connected signal generator.

® Guard-Band: The frequency offset is calculated from the following parameters: coupled E-
UTRA carrier, position relative to the coupled E-UTRA carrier, and offset from the edge of
the coupled E-UTRA carrier.

® In-Band Same PCI / In-Band Different PCl: The frequency offset is calculated from the
following parameters: coupled E-UTRA carrier and in-band resource block offset (In-Band
RB Offset).

8. PRB Index
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Physical Resource Block index. The PRB Index identifies the specific physical resource block
number allocated to the NB-IoT carrier (especially in in-band deployment). This index is used
in conjunction with parameters such as system bandwidth and In-Band RB Offset to determine
the precise frequency position of the NB-loT carrier within the LTE band.

9. AftoDC

Frequency offset relative to the DC subcarrier. Only visible in Guard Band operation mode.

9.  Num. of NRS Ports

Number of NRS antenna ports. Displays the number of antenna ports for the Narrowband
Reference Signal (NRS), which is the same as the total number of antennas.

10. Reference NRS Port

Reference NRS port. This parameter specifies on which antenna port the NRS is transmitted.

11. Carrier Type

Downlink carrier narrowband configuration. Options: Anchor Carrier | Non-Anchor Carrier.
Default value: Anchor Carrier.

Double-click or use the drop-down menu to set the downlink carrier narrowband configuration.

® Anchor Carrier: In NB-loT, the UE assumes that NPSS/NSSS/NPBCH/SIB-NB are
transmitted on this carrier.

® Non-Anchor Carrier: In NB-loT, the UE does not assume that NPSS/NSSS/NPBCH/SIB-NB
are transmitted on this carrier. This carrier is used for all unicast transmissions.
For more information, see 3GPP TS 36.331, Section 6.7.3.2.

12. Sync Type

Synchronization signal source. Options: NPSS | NRS. Default value: NPSS.

13. CelllD Detect

Cell ID detection mode. Options: Auto | Manual. Default value: Auto.
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14. CelllD

Cell ID setting. Only configurable when CellID Detect mode is Manual.

15. Data Sample Rate

Base sampling rate. Displays the base sampling rate for each system bandwidth or multi-carrier
condition. When the system bandwidth is 200 kHz, the base sampling rate is 1.92 MHz.

16. Multicarrier Filter

Multi-carrier filter.

3.6.1.2 Channel

1. NB downlink channel enable

Enables detection of NPSS, NSSS, NPBCH, and NPDCCH channels.

2. NPDCCH

Number of subframes to start detecting NPDCCH signals.

3. NPDSCH

Number of repetitions for NPDCCH signal detection.

3.6.1.3 Meas Time

1. Search Length

Search Length is the amount of data used to acquire and search for NB-loT frames. Search and
demodulation are performed within the Search Length range. Unit: seconds (s).

2. Meas Offset

Sets the starting position of the measurement signal. Slot Offset is the starting slot position.
Symbol Offset is the starting symbol position.
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3. Meas Length

Sets the length of the measurement signal. Slot Offset is the slot length of the signal. Symbol
Offset is the symbol length of the signal.

3.6.1.4 Advanced

1. Equalizer
Equalizer settings.

Equalizer Type: Reference equalization signal type. Options: off | RS | RS + Data. Default value:
RS.

Moving Avg. Filter: Moving average filter. The main function of this parameter is to smooth
the measurement results.

2.  EVM window
Error Vector Magnitude window.

Window Type: Method for measuring and calculating EVM. Options: 3GPP | Custom. Default
value: 3GPP.

Window Length: Window length.

EVM Window Adjust Type: Flexibly selects the FFT snapshot position for calculation based on
the test objective. Options: EVM Window Start | EVM Window End | EVM Window Center.
Default value: EVM Window Center.

3.  EVM Mimimization

Error Vector Magnitude minimization. Compensates for common signal impairments during
transmission through algorithms to minimize the measured EVM.

EVM Mimimization Type: Three options: off | 3GPP | Tracking. Default value: off.

Timing: When enabled, the instrument analyzes the phase slope of the reference signal in the
frequency domain (reflecting time-domain delay) and adjusts the sampling point position
accordingly to compensate for sampling point offset caused by symbol timing deviation.

Amplitude : When enabled, measures the amplitude error between the received reference
signal and the ideal signal, and applies reverse compensation.

Frequency/Phase: When enabled, it eliminates the measured residual frequency offset and

160 www.siglent.com



SigVSA Vector Signal Analysis Software User Manual

phase noise in real time, "tightening” the constellation diagram to accurately evaluate phase
noise and PLL performance, preventing them from being incorrectly counted in the EVM results.

4. Sacle Conversion

Scale conversion.

3.6.2 Measurement Results

The path for setting NB-loT measurement results is: Trace -> Format.

B [(NB-IoT 1] Trace Setting X

Trace1 o= AddTrace (%) Delete Trace

Format

Data Group Pre-demod

Data Result RawMain Time

Setup Steps:
1) Select the display window.
2) Select Group to place different measurement results into different groups.

3) Select the measurement result data to be displayed.

Measurement Result Example (Downlink):
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L7 SIGLENT SigVSA -
Fie Edt Control InputOutput MessSet indow Utiities Help  Logger

p | . 7] NB-loTi

< ¥ NB-laT 1:RawMain Time(Trcl) X ¥ NB-IoT 1: Spectrum(Tred) X | ¥ NB-loT1:RMSError Vector Spectrum(TreT)

T W \“u I

|||

Stop 42ms

mll | IH |l||| LLEL

1. Raw Main Time

Displays the magnitude of the raw data read from hardware input or played from a file. X-axis
shows time, Y-axis shows amplitude.

2. Spectrum

Displays the spectrum of raw data read from hardware input or played from a file. X-axis shows

frequency, Y-axis shows amplitude.

3. 1Q Meas Time

IQ measurement time displays a constellation diagram of the data within the measurement
length. Both X and Y axes show amplitude (normalized amplitude). Different colors are used to
distinguish different channels.

4. RMS Error Vector Spectrum

RMS error vector spectrum displays the root mean square (RMS) EVM for each subcarrier. RMS
calculation of EVM is performed over all symbols within the measurement range for each
subcarrier. X-axis shows the subcarrier range across the entire channel bandwidth (unit:
subcarrier | ksubcarrier). Y-axis shows RMS EVM (unit: %).

5. RMS Error Vector Time
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RMS error vector time displays the RMS EVM for each symbol. RMS calculation of EVM is
performed over all subcarriers within the measurement range for each symbol. X-axis shows
the symbol range across the entire channel bandwidth (unit: symbol). Y-axis shows RMS EVM
(unit: %).

6. Error Vector Time

Error vector time domain displays EVM at the subcarrier level. X-axis is time, Y-axis is EVM value.
Each trace represents the EVM for individual symbols on a specific subcarrier within the

measurement range. Traces for all subcarriers overlap each other.

7. Error Vector Spectrum

Error vector frequency domain displays EVM at the subcarrier level. X-axis is subcarrier, Y-axis
is EVM value. Each trace represents the EVM for subcarriers on a specific symbol within the
measurement range. Traces for all symbols overlap each other.

8. RE Allocation

Displays resource allocation for various channels within the measurement range, essentially a
resource grid view. X-axis is symbol, Y-axis is subcarrier. Different channels are distinguished

by different colors.

9. Error Summary

The error summary includes the following error terms in the measurement results:

Channel Power: Displays the average power of the carrier (unit: dBm).

EVM (RMS/Peak): Displays the RMS EVM and peak EVM for all measured channels.

RS Tx. Power (Downlink): Displays the average power of the CRS signal (unit: dBm).

OFDM Sym. Tx. Power (Downlink): Displays the average power of data subcarriers (unit: dBm).
RSSI: Received Signal Strength Indicator.

Freq Error: Frequency offset relative to the carrier center (unit: Hz).

SynCorr: Displays the correlation between the measured synchronization signal and the ideal
reference synchronization signal.

Common Tracking Error : RMS average of corrections applied per symbol through EVM
minimization.

www.siglent.com 163



SigVSA Vector Signal Analysis Software User Manual

Time Offset : Distance from the start of the search time trace to the measurement frame
header (unit: s).

Cell ID: Cell ID of the signal.

10. Frame Summary

Frame summary parameters are calculated from the measurement data within the
measurement length and include the following:

Channel :
® Downlink channels : NPSS/NRS/NSSS/NPBCH/NPDCCH/NPDSCH-QPSK/NPDSCH-
16QAM;

Power(dB): Displays the relative power per subcarrier for the current channel, averaged over
all subcarriers of that channel.

EVM(%rms): RMS EVM of the current channel.
EVM(%pk): Peak EVM of the current channel.

37 WLAN

3.7.1 Configuration

The path to enter the WLAN configuration interface is: Meas Setup -> WIFI Properties.

{7 SIGLENT SigVSA
File Edit Control InputOutput MeasSetup Trace Markers Wi

I]] | WIFIT | o= Mew Measurement

Measurement Management Remove Measurement

o= AddGroup = NewMeasureme:

Current Measurement
~ Group1

, WIFI1 m g

Measure Management...

Measurement Type: WIFI »

# File ) Remote [ .
B [WIFI1] Properties...
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3.7.1.1 Base

1. Standard

Options: IEEE 802.11b/g | IEEE 802.11a/g | IEEE 802.11n | IEEE 802.11ac | IEEE 802.11ax | IEEE
802.11be.

Default: IEEE 802.11ax.

Select the demodulated signal protocol type.

2. Data Modulation Format
Options: Barker 1 | Barker 2 | CCK 5.5 | CCK11.
Default: Barker 1.

Select the demodulated signal modulation rate.

3. Bandwidth
Options: 20MHz | 40MHz | 80MHz | 160MHz | 320MHz.
Default: 20MHz.

Select the demodulated signal bandwidth.

4. Frame Format
Options: HE SU | HE ER SU | HE MU | HE TB | EHT MB | EHT TB.
Default: HE SU (Wi-Fi 6) | EHT MB (Wi-Fi 7).

Select the demodulated signal PHY-layer PPDU frame type.

5. SIG Compression Field
Options: On | Off.
Default: Off.

When enabled, indicates full-bandwidth transmission (as opposed to OFDMA, which divides
bandwidth into multiple RUs).

6. Compression Mode(Non-OFDMA)
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Options: On | Off.
Default: Off.

When enabled, indicates full-bandwidth transmission (as opposed to OFDMA, which divides
bandwidth into multiple RUs).

7. HE PPDU RU Allocation

Configure HE PPDU RU allocation mode.

1) SU

Options: On | Off; Default: On.

When HE SU PPDU mode is enabled, MU and Trigger Based options are grayed out.
2) MU

Options: Off | From SIG Symbols | Manual; Default: Off.

When HE MU PPDU mode is enabled, SU and Trigger Based options are grayed out.
3) Trigger Based

Options: Off | Automatic (1 RU) | Manual.

Default: Off.

When HE Trigger Based PPDU mode is enabled, SU and MU options are grayed out.

8. ETH PPDU RU Allocation

Configure EHT PPDU RU allocation mode.

1) SU

Options: On | Off.

Default: On.

When EHT SU PPDU mode is enabled, MU and Trigger Based options are grayed out.
2) MU

Options: Off | From SIG Symbols | Manual.

Default: Off.

When EHT MU PPDU mode is enabled, SU and Trigger Based options are grayed out. If Manual
mode is selected, the Allocate Signal settings dialog will appear.
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3) Trigger Based
Options: Off | Automatic (1 RU) | Manual.
Default: Off.

When EHT Trigger Based PPDU mode is enabled, SU and MU options are grayed out.

9. Data Subcarrier Modulation Format

Specify the modulation format for data subcarriers.

1) From Sig Symbols

Options: On | Off.

Default: On.

2) Manual

Options: Off | BPSK | QPSK | 16-QAM | 64-QAM | 256-QAM | 1024-QAM | 4096-QAM.
Default: Off.

10. Guard Interval

The Guard Interval is the ratio of the cyclic prefix (CP) time to the IFFT time (T_IFFT), used to

eliminate inter-symbol and inter-carrier interference.
1) From SIG Symbols

Options: On | Off.

Default: On.

2) Manual

Options: On | Off.

Default: Off.

3) Manual Value

Options: 0-1.

Default: 0.25.

11. HE-LTF Duration

Select the HE-LTF type parameter to adjust HE-LTF symbols.
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1) From SIG Symbols
Options: On | Off.
Default: On.

2) Manual

Options: Off | 1x | 2x | 4x.
Default: Off.

12. EHT-LTF Duration

Select the EHT-LTF type parameter to adjust EHT-LTF symbols.
1) From SIG Symbols

Options: On | Off.

Default: On.

2) Manual

Options: Off | 1x | 2x | 4x.

Default: Off.

3.7.1.2 Filter

1. Reference Filter
Options: Gaussian | Raised Cosine | Rectangular.

Select the reference filter type.

2. Alpha BT

Configure the Alpha/BT parameter.

3. Alpha

When specifying the Gaussian filter as the reference filter, the BT (bandwidth-time product) of
the filter can be set to a value between 0.05 and 100. Default value: 0.5.

4, BT

When specifying the Raised Cosine filter as the reference filter, the Alpha of the filter can be
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set to a value between 0.05 and 1. Default value: 0.5.

3.7.1.3 Time

1. Search Length
Minimum: 60 us; Default: 1.5 ms.

Defines the time duration for pulse search.

2. Result Length Mode
Options: Auto | Manual; Default: Auto.

Specifies the demodulated chip pattern available for analysis.

3. Result Length Value
Range: 1 — 250,000 Chips.
Default: 60 Chips.

Specifies the number of demodulated chips available for analysis.

4. Automatic Result Length
Options: On | Off; Default: On.

When enabled, the measurement result length is determined automatically by comparing the
detected symbol count with the **Maximum Result Length** parameter and using the smaller

value.

5. Maximum Result Length
Minimum: 0 Symbols.
Default: 60 Symbols.

User-defined maximum number of symbols.

6. Manual Result Length
Options: On | Off.
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Default; Off.

When enabled, the measurement result length can be set manually.

7. Measurement Offset
Minimum: 0 Chips.
Default: 0 Chips.

Sets the measurement offset (in chips) relative to the **Result Length** start position.

8. Measurement Interval
Minimum: 0 Chips.
Default: 60 Chips.

Defines the interval of demodulated and analyzed data within the Result Length.

9. Meas Interval
Minimum: 0 Symbols.
Default: 0 Symbols.

Defines the time duration of Result Length data used for computing and displaying trace
results.

10. Meas Offset
Minimum: 0 Symbols.
Default: 0 Symbols.

Sets the symbol offset (from the first data symbol) relative to the Result Length start position.

3.7.1.4 Advanced

1. Chip Rate
Minimum: 0 Hz.
Default: 11 MHz.

Configures the chip rate for the VSA demodulator.
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2. Clock Adjustment
Minimum: 0 Chips.
Default: 0 Chips.

Determines when the VSA digital demodulator samples the 1/Q trace.

3. Normalize I1Q Traces
Options: On | Off; Default: On.

Normalizes |/Q data when enabled.

4. Equalize
Options: On | Off; Default: Off.

Applies the VSA equalization filter to the measurement. The filter length can be specified in
the Filter Length field.

5. Filter Length
Range: 3 to 99 chips (odd numbers only).
Default: 5 Chips.

Sets the length of the VSA equalization filter.

6. Descramble Mode

Options: On | Off | Preamble Only | Preamble & Header Only.
Configures the WLAN 802.11b/g descramble.

1) ON

Descrambles preamble, header, and payload.

2) Off

No descrambling.

3) Preamble Only

Descrambles only preamble.
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4) Preamble & Header Only

Descrambles preamble and header (payload remains scrambled).

7. Mirror Frequency Spectrum
Options: On | Off; Default: Off.

Allows the VSA to correctly demodulate a frequency spectrum mirrored (flipped) around the
center frequency.

8. Compensate Sampling Clock Error
Options: On | Off; Default: Off.

Compensates for sampling clock errors by adjusting for the difference between ideal and actual
sampling clock frequencies (applied before demodulation).

9. Remove Equalizer Phase Ramp
Options: On | Off; Default: Off.

If enabled, the VSA normalizes the phase and phase ramp of each stream/channel’ s frequency

response individually. If disabled, normalization is based on Stream 1 Channel 1.

10. Display EVM in Percent
Options: On | Off; Default: Off.

Displays EVM in percentage (%) when enabled; otherwise, in dB.

11. Display Sync Correlation in Percent
Options: On | Off; Default: Off.

Displays synchronization correlation in percentage (%) when enabled.

12. Symbol Time Adjustment

Adjusts the FFT window start point within the CP (Cyclic Prefix) region to ensure a clean FFT
period (avoiding interference from the falling edge).

1) Mode
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Options: Auto | Manual.

Default: Manual.

Auto: VSA finds the optimal EVM value, Mannul: User-defined adjustment.
2) Adjustment

Range: -GI/100 to 0.

Default: -3.125%.

Configurable only in Manual mode.

13. Subcarrier Selection

Specifies which subcarrier types are analyzed and displayed.
1) Display Data Subcarriers

Options: On | Off.

Default: Off.

2) Display Pilot Subcarriers

Options: On | Off.

Default: On.

14. Sample Rate Mode
Options: Auto | Manual.
Default: Auto.

Auto: Automatically selects the demodulation sample rate, Manual: Allows manual setting.

15. Pilot Tracking

Pilot subcarriers transmit known sequences to determine errors between ideal and received

signals. The VSA calculates phase, amplitude, and timing errors for correction.
Options: Track Amplitude | Track Phase | Tracking Timing.

1) Track Amplitude

Options: On | Off.

Default: Off.
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If enabled, averaged pilot amplitude scales the expected amplitude of other subcarriers.
2) Track Phase

Options: On | Off.

Default: On.

If enabled, selects which subcarrier types are used for phase error correction.

3) Track Timing

Options: On | Off.

Default: On.

If enabled, the average phase slope of pilots removes symbol-to-symbol timing errors.

16. Frequency Estimation Mode

Options: Preamble Only | Preamble & Pilots | Preamble, Pilots & Data.
Default: Preamble & Pilots.

Selects the signal segment used for frequency offset estimation.

1) Preamble Only

Frequency offset estimation is performed using only the preamble.

2) Preamble & Pilots

Use the preamble and pilot signals.

3) Preamble, Pilots & Data

Use the preamble, pilot signals, and data subcarriers.

17. Equalizer Training

For 802.11n/ac/ax/be signals, the VSA uses an equalizer to correct linear impairments (e.g.,
multipath).

Options: Preamble Only | Preamble, Pilots & Data.
Default: Preamble Only.

1) Preamble Only

Uses only the preamble’ s channel estimation sequence.

2) Preamble, Pilots & Data
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Uses preamble, pilots, and data subcarriers.

18. Equalizer Smoothing
Options: None (Linear) | Triangular.
Default: Triangular.

Configures smoothing during equalization.

19. Length

Visible when Triangular smoothing is selected.
Range: 3-117 subcarriers.

Default: 5.

Sets the triangular filter length (in subcarriers).

3.7.2 Measurement Results

The WLAN measurement results configuration path is: Trace -> Format.

B [WIFI 1] Trace Setting *

Trace1 o= AddTrace (%) Delete Trace

Format

Data Group Pre-demod

Data Result RawMainTime

Setup Steps:
1) Select the display window;
2) Select Group (different measurement results are grouped separately);

3) Select the measurement result data to display.

Example Measurement Results (IEEE 802.11b/g):
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% | ¥ WIFI:Erm

e AddGroup  «fr NewMeasurement

+ Groupt
~ W1 mo@ -

¥ WIFI1: Exror Summary{Tre2)

1. Raw Main Time
Displays the magnitude of raw data from hardware input or playback files.
- X-axis: Time

- Y-axis: Amplitude

2. Error Summary

Includes the following error metrics:

EVM: Average EVM of all pilots, preambles, and data;
EVM Peak: Peak EVM of all pilots, preambles, and data;

Mag Err: Magnitude error (difference between measured and reference signal magnitudes, as
a percentage of the ideal signal’ s RMS power);

Mag Err Peak: Peak magnitude error;

Phase Err: Phase error (difference between measured and reference signal phases);
Phase Err Peak: Peak phase error;

Freq Err: Carrier frequency offset relative to the VSA center frequency;

Sync Corr: Cross-correlation between the measured preamble and the ideal Barker sequence.

3. Spectrum
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Displays the spectrum of raw data from hardware input or playback files.
- X-axis: Frequency

- Y-axis: Amplitude

4. 1Q Meas Time
Displays demodulated time-domain IQ data sampled at chip intervals.

- X & Y axes: Normalized amplitude.

5. Error Vector Time
Displays error vector time-domain trace data within the specified measurement interval.
- X-axis: Time

- Y-axis: EVM

6. Phase Error Vector Time
Displays phase error vector time-domain trace data within the specified measurement interval.
- X-axis: Time

- Y-axis: Phase error

Example Measurement Results (IEEE 802.11a/g/n/ac):

} SIGLENT SigVSA - & x
InputOutput MoasSetup Trace Markers Window Utilties  Help
1] w1 - =

Measurement Management X wMain Time(Trc1)
i AddGroup  ~fr NewMeasurement

Groupl
~ WA s m-os

@ Fie ) Remate Device
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1. Raw Main Time
Displays the magnitude of raw data from hardware input or playback files.
- X-axis: Time

- Y-axis: Amplitude

2. Error Summary

Includes:

EVM: Average EVM of all subcarriers and OFDM symbols (dB);

EVM Peak: Peak EVM of all subcarriers and OFDM symbols (dB);

Pilot EVM: EVM of pilot subcarriers across all symbols (dB);

Data EVM: Average EVM of data subcarriers across all symbols (dB);

Freq Error: Frequency offset relative to carrier center (Hz);

CPE: Common phase error between received and ideal pilots (% RMS);
Sync Corr: Correlation between measured and reference sync signals (%);

Sym Time Adj: Symbol timing adjustment (default: -3.125%, range: [-GI/100, 0]).

3. Spectrum
Displays the spectrum of raw data from hardware input or playback files.
- X-axis: Frequency

- Y-axis: Amplitude

4. 1Q Meas Time
Displays constellation plot of measured data.

- X & Y axes: Normalized amplitude.

5. Burst Info

Displays PLCP (PHY Layer Convergence Protocol) summary data for the analyzed data burst,
including modulation type, symbol length, power (dBm), and EVM (dB).
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6. Error Vector Spectrum
Displays error vector per subcarrier.
- X-axis: Subcarrier index

- Y-axis: EVM

Example Measurement Results (IEEE 802.11ax/be):

<7 SIGLENT SigVSA - &5 X
Fie Edt Control InputOutpunt MeasSetup Trace Markers Window Utilties Help
-=
% | ¥ WIFIY: RawMain Time(Tret) O % ¥ WIFI:10Meas Time(Trcd)
4 AddGroup = Newhassurament
Group M .».».».r...-r.~.~,w,«/rv‘«-/\-,-is“1.»--
~ WHI g m

it bl
& Fie

% | % WIFI:Error Vector Spectrum(Trcé)

1. Raw Main Time
Displays the magnitude of raw data from hardware input or playback files.
- X-axis: Time

- Y-axis: Amplitude

2. Error Summary

Includes:

EVM: Average EVM of all subcarriers and OFDM symbols (dB);
EVM Peak: Peak EVM of all subcarriers and OFDM symbols (dB);
Pilot EVM: EVM of pilot subcarriers across all symbols (dB);

Data EVM: Average EVM of data subcarriers across all symbols (dB);
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Freq Error: Frequency offset relative to carrier center (Hz);
CPE: Common phase error between received and ideal pilots (% RMS);
Sync Corr: Correlation between measured and reference sync signals (%);

Sym Time Adj: Symbol timing adjustment (default: -3.125%, range: [-GI/100, 0]).

3. Spectrum
Displays the spectrum of raw data from hardware input or playback files.
- X-axis: Frequency

- Y-axis: Amplitude

4. 1Q Meas Time
Displays constellation plot of measured data.

- X & Y axes: Normalized amplitude

5. Burst Info

Displays summarized burst information grouped by frame segments (e.g., L-STF, L-LTF, L-SIG),

including EVM, power, and modulation.

6. Error Vector Spectrum
Displays error vector per subcarrier.
- X-axis: Subcarrier index

- Y-axis: EVM

7. RU Info

Displays demodulation information per RU (Resource Unit), such as size, power, and EVM.

8. User Info

Displays per-user information, including modulation, MCS, EVM, power, and STA-ID.
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3.8 Bluetooth

3.8.1 Configuration

The path to enter the Bluetooth configuration interface is: Meas Setup -> Bluetooth Properties.

; SIGLENT SigVSA
File Edit Control InputOutput MeasSetup Trace Markers Windo

I] | Bluetoot| =k New Measurement

Measurement Management Remove Measurement

o= AddGroup = NewMeasureme:
Current Measurement
~ Group1
Measure Management...

- Bluetooth1 3 =

Measurement Type: Bluetooth »

» File {7y Remote [ )
- [Bluetooth 1] Properties...

3.8.1.1 General

1. Search Length

Search Length is the data length for acquiring and searching Bluetooth frames. Searching and
demodulation are performed within the Search Length range. The unit is seconds (s).

2. Waveform Type

Set the type of Bluetooth packet to be demodulated. Options are: Basic Rate | Enhanced Data
Rate | Low Energy. The default value is Basic Rate.

3. 1/QMap

IQ image flip switch. Options are: Normal | Invert. The default value is Normal.

4. Manual Sample Rate

Manual sampling rate setting switch. Options are: Auto | Manual. The default value is Auto.
When set to Manual, the demodulation sampling rate can be changed manually.
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3.8.1.2 Result

1. Packet ID

Set the broadcast packet ID of the signal to be demodulated.

2. Averaging

Used to specify the number of data acquisitions to be averaged. After the specified average
count is reached, turn on the averaging switch via "Averaging". Options are: Off | On. The
default value is Off.

3. Avg Hold Number

The number of data acquisitions to be averaged. Can be set after Averaging is enabled.

3.8.1.3 TxPower

1. Output Power Start Maker

Used to determine the point at which power averaging begins. Defined as a percentage of the
burst length relative to a specific starting point. The difference between the output power stop

and start markers must be at least 1%.

2. Output Power Stop Maker

Used to determine the point at which power averaging stops. Defined as a percentage of the
burst length relative to a specific starting point. The difference between the output power stop
and start markers must be at least 1%.

3. GFSK Start Marker

Used to determine the point at which power averaging begins. Defined as a percentage of the
EDR GFSK length relative to a specific starting point. The difference between the EDR GFSK
average power stop marker and start marker must be at least 1%.

4. GFSK Stop Marker
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Used to determine the point at which power averaging stops. Defined as a percentage of the
EDR GFSK length relative to a specific starting point. The difference between the EDR GFSK
average power stop marker and start marker must be at least 1%.

5. DPSK Start Marker

Used to determine the point at which power averaging begins. Defined as a percentage of the
EDR DPSK length relative to a specific starting point. The difference between the EDR DPSK
average power stop marker and start marker must be at least 1%.

6. DPSK Stop Marker

Used to determine the point at which power averaging stops. Defined as a percentage of the
EDR DPSK length relative to a specific starting point. The difference between the EDR DPSK
average power stop marker and start marker must be at least 1%.

3.8.1.4 Limit

3.8.1.4.1 BR
1. Limit Test

Turn parameter limits on or off.

2. DH Type

Specify the packet type. Options are: DH1 | DH3 | DH5. The default value is DH1.

3. Average Power Lower

GFSK average power lower limit.

4. Average Power Upper

GFSK average power upper limit.

5. Peak Power Upper

GFSK peak power upper limit.
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6. Relative Peak Upper

GFSK peak power upper limit.

7. Af1 Avg Lower

Af1 average lower limit.

8. Af1 Avg Upper

Af1 average upper limit.

9. Af2 Max Lower

Lower limit of the maximum value of Af2.

10. Af2 Avg/Af1 Avg Lower

Lower limit of the Af2/Af1 ratio.

11. Freq Drift Lower

Lower limit of frequency drift.

12. Freq Drift Upper

Upper limit of frequency drift.

13. Max Drift Rate Lower

Lower limit of the maximum frequency drift rate.

14. Max Drift Rate Upper

Upper limit of the maximum frequency drift rate.

15. ICFT Lower
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Lower limit of the initial carrier frequency tolerance.

16. ICFT Upper

Upper limit of the initial carrier frequency tolerance.

38142 LE
1. Limit Test

Enable or disable parameter limits.

2. Limit Type
Set the symbol rate. Options: 1M | 2M | 1M CTE | 2M CTE | Coded. Default value is TM.

3. Average Power Lower

Lower limit of GFSK average power.

4. Average Power Upper

Upper limit of GFSK average power.

5. Peak Power Upper

Upper limit of GFSK peak power.

6. Relative Peak Upper

Upper limit of GFSK peak power (relative).

7. Af1 Avg Lower

Lower limit of the average value of Af1.

8. Af1 Avg Upper

Upper limit of the average value of Af1.
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9. Af2 Max Lower

Lower limit of the maximum value of Af2.

10. Af2 Avg/Af1 Avg Lower

Lower limit of the Af2 Avg/Af1 Avg ratio.

11. Freq Drift Lower

Lower limit of frequency drift.

12. Freq Drift Upper

Upper limit of frequency drift.

13. Freq Offset Lower

Lower limit of frequency offset.

14. Freq Offset Upper

Upper limit of frequency offset.

15. Max Drift Rate Lower

Lower limit of the maximum frequency drift rate.

16. Max Drift Rate Upper

Upper limit of the maximum frequency drift rate.

17. Intial Freq Drift Lower

Lower limit of initial frequency drift.

18. Intial Freq Drift Upper
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Upper limit of initial frequency drift.

3.8.1.43 EDR
1.  Limit Test

Enable or disable parameter limits.

2. Relative Power Lower

Lower limit of relative power.

3. Relative Power Upper

Upper limit of relative power.

4. Initial Freq Lower
Lower limit of initial frequency.

5. Initial Freq Upper

Upper limit of initial frequency.

1. Block Freq Lower

Lower limit of block frequency.

2. Block Freq Upper
Upper limit of block frequency.

3. Total Freq Lower

Lower limit of total frequency.

4. Total Freq Upper

Upper limit of total frequency.
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5 RMS DEVM (DQPSK) Upper

Upper limit of the mean DEVM.

6. Peak DEVM (DQPSK) Upper

Upper limit of the peak DEVM.

7 RMS DEVM (8PSK) Upper

Upper limit of the mean DEVM.

8. Peak DEVM (8PSK) Upper
Upper limit of the peak DEVM.

9. 99% DEVM (DQPSK) Upper

The maximum DEVM value not exceeded at 99% of the symbol points.

10. 99% DEVM (8PSK) Upper

The maximum DEVM value not exceeded at 99% of the symbol points.

3.8.1.5 Advanced

1. Scale Conversion

Range conversion.

382 Measurement Results

The path for setting Bluetooth measurement results is: Trace -> Format.
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B [Bluetooth 1] Trace Setting >

Trace1 o= AddTrace (%) Delete Trace

Format

Data Result RfEnvelope

Format

Setup Steps:
1. Select the display window.

2. Select Result to switch the measurement result data to be displayed.

Measurement Result Examples:

BR Signal Demodulation Results

{7 SIGLENT SigVSA -]
Fie Edt Contiol InptOutpt MessSetup Trace Markers Window Utiities Help Logger
b | 7] Bluetoothi

Maasurement Management 4 o ¢ % | ¥ Blustooth1:Rf
i~ AddGroup i+ NewMeasurement

Group
Biuetoothl '@ @ || @
emot

o File R

¥ Bluetooth 1: Demod Waveform(Trc2)

204k

148171kHz 1481T1kHz
144891kHz 144891kHz

EDR Signal Demodulation Results
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L7 SIGLENT SigVSA -
Fie Edt Contiol WnputOUtpt MessSetup Trace Markers Window Utities Felp Logger

[ | 7 Bhotoomn1 LL L RS

surement Management  Blustooth 1:RiEnvelo % | ¥ Bluste (Tred)

4 AddGroup - NewMeasurement
v Groupl
v Blustoothl ‘g @ || @

#Fle  ( ogM LogMag

GHz
 Blustooth1.QMeasuredPolar(Trc2) % Blustooth 1 Resuit Summary(Tred)

- Standsrd Enhanced Data Rate
1 s L2-DHI

Max ! Ave

21041Hz

T482dBm

T444d8m

001948 (-4dB,1dB)
0%

o

4862us

248663

LE Signal Demodulation Results

{7} SIGLENT SigVSA
Fie Edt Contiol InprtOutpt MessSetup Trace Markers Window Ut Help  Logger

p | 1] Buetooth1 -=E VY

Measurement Management ¢ ¥ Bluetooth1:Rf Envelope(Trc1) % ¥ Blustooth1:RfSpectrum(Tred)

!

= AddGroup == New Measurement
nr
v Groupl oBm

Bluetootht ‘g @ || &

o File Rer LogMag

783
16Hz

¥ Blustooth: Demod Waveform(Trc2) ¥ Blustooth 1 :Result Summary(

3 Standard LowEnergy
765k
N LE
Hz

LinMag

Stop 191993us

1. Rf Envelope

Power image of the data. X-axis: time, Y-axis: signal strength (dBm).

2. Demod Waveform/IQ Measured Polar

When demodulating BR/LE signals: frequency image of the data. X-axis: time, Y-axis: kHz.

When demodulating EDR signals: constellation diagram of the data within the measurement
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length, displayed as IQ measurement over time. Both X and Y axes show amplitude (normalized
amplitude).

3. RfSpectrum

Frequency image of the data. X-axis: time, Y-axis: frequency.
1. Quad Metrics

Data indicators have the same meaning as in Result Summary.
2. Small-size Metrics

Data indicators have the same meaning as in Result Summary.
3. Result Summary

Displays the demodulation data table.

When demodulating BR Bluetooth signals, the following indicators are shown:
1) Standard: Displays the demodulation Bluetooth mode.
2) Packet Type: Displays the packet format.

Payload Length: Packet length.

4) Payload: Packet format.

5) Average Power: GFSK average power.

6) Peak Power: GFSK peak power.

7) Af1 Max: Maximum value of Af1.

8) Af1 Avg: Average value of Af1.

9) Af2 Max: Maximum value of Af2.

10) Af2 Avg: Average value of Af2.

11) Af2 > 115 kHz: Proportion of Af2 exceeding 115 kHz.
12) Af2/Af1: Ratio of Af2 to Af1.

13) Freq Drift: Frequency drift.

14) Max Drift Rate: Maximum frequency drift rate.

15) ICFT: Initial carrier frequency tolerance.

When demodulating EDR Bluetooth signals, the following indicators are shown:
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1) Standard: Displays the demodulation Bluetooth mode.

2) Packet Type: Packet type.

3) Payload Length: Payload length.

4) Payload: Payload data format.

5) Freq Offset wi: Frequency offset wi.

6) Freq Offset wo: Frequency offset wo.

7) wi+wo: Frequency offset wi+wo.

8) RMS DEVM: Root mean square DEVM.
9) Peak DEVM: Peak DEVM.

10) GFSK Avg Power: GFSK average power.
11) DPSK Avg Power: DPSK average power.
12) Rel Avg Power: Relative average power.
13) Ber: Bit error rate.

14) Bit Errors: Number of bit errors.

15) Guard Interval: Guard interval.

When demodulating LE Bluetooth signals, the following indicators are shown:

1) Standard: Displays the demodulation Bluetooth mode.

2) Packet Type: Packet type.

3) Coding: Coding.

4) Payload Length: Payload length.
5) Payload: Payload.

6) Average Power: Average power.
7) Peak Power: Peak power.

8) Af1 Max: Maximum value of Af1.
9) Af1 Avg: Average value of Af1.
10) Af2 Max: Maximum value of Af2.

11) Af2 Avg: Average value of Af2.

12) Af2 > 185 kHz: Proportion of Af2 exceeding 185 kHz.
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13)
14)
15)
16)
17)
18)
19)
20)
21)
22)
23)
24)
25)

Af2 > 370 kHz: Proportion of Af2 exceeding 370 kHz.
Af1/Af2: Ratio of Af1 to Af2.

Freq Drift: Frequency drift.

Max Drift Rate: Maximum frequency drift rate.

Freq Offset: Frequency offset.

Initial Freq Drift: Initial frequency drift.

CTE Freq Drift: CTE (Constant Tone Extension) frequency drift.
CTE Max Drift Rate: Maximum CTE frequency drift rate.
CTE Freq Offset: CTE frequency offset.

CTE Initial Freq Drift: CTE initial frequency drift.

CTE Time: CTE duration.

RFU: Reserved for future use.

CTE Type: CTE type.

39 UWB

3.9.1 Configuration

The path to access the UWB configuration interface is: Meas Setup -> UWB Properties.

{7 SIGLENT SigVSA
File Edit Control InputOutput MeasSetup Trace Markers Wir

I]] | UWB1 | o= New Measurement N

Measurement Management Remove Measurement b gl

o= AddGroup = NewMeasureme:

Current Measurement
v Group1

v UWB1 m e

Measure Management...

Measurement Type: UWE »

e File ) Remote [ _
) [UWB 1] Properties...
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3.9.1.1 Format

1. Channel
Range: Ch0-Ch15, default: ChO.

Set the channel number.

2. PHY Mode

Select the PHY mode. Options: '"HPRF' | 'BPRF' | '802.15.4a", default: Non-ERDEV.

3. STS Packet Configuration
Options: No STS (0); After SFD (1); After PHR/Payload (2); After SFD, no data (3)
Default: No STS (0)

When the PHY Mode is set to ERDEV-BPRF or ERDEV-HPRF, the STS Packet Configuration takes
effect, used to specify the position of the STS packet.

4. MMS Packet

MMS Packet (BETA) supports the analysis of 802.11ab MMS (Multi-Millisecond) data packets.
In this mode, there are no PSDU or PHR sections within the frame, and thus the corresponding
parameters are not visible. The MMS mode consists of an SHR, several RSFs, and several RIFs.

There can be 0-5 RSFs or RIFs. Each part of the frame starts on a millisecond boundary.

The MMS Packet (BETA) checkbox becomes effective when the PHY Mode is set to ERDEV HPRF
and the STS Packet Configuration is set to After SFD, no data (3).

Default: Disabled (unchecked).

5. Data Power Analysis

Frame Data Field (PHR + PSDU) parsing checkbox. When checked, the demodulation algorithm
will demodulate the Data field, calculate parameters such as power, and display them in the
Syms/Errs table.

6. Modulation Analysis

Modulation analysis checkbox, used to control whether modulation analysis is performed
during demodulation. This Modulation Analysis checkbox takes effect only when Data Power
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Analysis is checked. Once selected, demodulation analysis data will be displayed in the IQ Meas
Time, 1Q Ref Time, Err Vect Time, Decoded Bits, and Demodulated Bits graph frames, and
NRMSE will be calculated.

If this option is not checked, modulation analysis will not be performed, which can speed up
the measurement process.

Default: Checked.

7. Code Index
Range: 1-32 (depending on the configuration of Channel and PHY Mode)
Default: 1

Select the ternary code sequence to be used. There are 32 ternary code sequences: Code Index
1-8 have a length of 31 (suitable for Non-ERDEV and HPRF modes), Code Index 9-24 have a
length of 127 (suitable for all modes), and Code Index 25-32 have a length of 91 (suitable for
HPRF mode). The Code Index options are also related to the Channel, with each Channel having
corresponding Code Index options.

8. Code Index
Range: 1-32 (depending on the configuration of Channel and PHY Mode)

Default; 1

Select the ternary code sequence to be used. There are 32 ternary code sequences: Code Index
1-8 have a length of 31 (applicable to Non-ERDEV and HPRF modes), Code Index 9-24 have a
length of 127 (applicable to all modes), and Code Index 25-32 have a length of 91 (applicable
to HPRF mode). The Code Index options are also related to the Channel, with each Channel
having corresponding Code Index options.

9. Delta Length (L)
Options: 4, 16, 64 (related to Code Index and Channel)
Default: 16

Used to specify the length L of the Delta function that expands the preamble sequence (Code
Sequence) into the preamble symbol (Si Symbol). Insert L-1 zeros between each pair of symbols.

Code sequences with lengths of 127 or 91 (corresponding to Code Index 9-32) can only use
L=4. Code sequences with a length of 31 (corresponding to Code Index 1-8) can use L=16 or
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L=64, but wide-bandwidth channels (Channel 4/7/11/15) can only use L=16.

10. SYNC Length
Default: 64 symbols

The number of symbols in the SYNC segment (i.e., the repetition count of the preamble Si
symbols).

The actual protocol (IEEE Std 802.15.4-2024) content has some differences:
When the PHY Mode is Non-ERDEV or BPRF, the SYNC Length can be 16, 64, 1024, or 4096;
When the PHY Mode is HPRF, the SYNC Length can be 16, 24, 32, 48, 64, 96, 128, or 256.

11. SFD Parameters
Used to configure the parameters of the SFD section, which are dependent on the PHY Mode.

When the PHY Mode is Non-ERDEV, configure the Length parameter: the number of Si Symbols,
with options Short (8 symbols) and Long (64 symbols). Default: Long (64 symbols).

When the PHY Mode is BPRF or HPRF, configure the SFD sequence number. For BPRF, options
are 0 (default) or 2; for HPRF, options are 1-4 (default 1).

12. Hop Bursts

The number of hopping burst positions within each half of a BPM-BPSK symbol. This option
takes effect when the PHY Mode is Non-ERDEV and is hidden for other PHY modes. When the
PHY Mode is BPREF, this value is fixed at 2. When the PHY Mode is HPRF, this option is invalid.

Default: 8

13. Chips per Burst

The number of chips within each burst. This setting takes effect only when the PHY Mode is
Non-ERDEV and is hidden for other PHY modes. When the PHY Mode is BPRF, this value is
fixed at 8. When the PHY Mode is HPREF, this setting is invalid.

Default: 128

14. Constraint Length
Option: CL3 | CL7
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Default: CL3

Effective and visible when PHY Mode is HPRF. Set the length of the convolutional encoder
used.

15. Data Rate
Option: Low / High;
Default: Low

Set the ERDEV data rate. When the PHY Mode is Non-ERDEV, this option is hidden and invalid.
It takes effect for other PHY modes.

16. Frame Length (Octets)
Range: 0-127 (Non-ERDEV), 0-4095 (ERDEV)
Default: 20

Set the number of bytes for the Payload section.

17. FCS Type

Option: When PHY Mode is Non-ERDEV or BPRF, the only option is '2-octet'.
When PHY Mode is HPRF, the options are '2-octet' and '4-octet'.

Default: '2-octet'.

Select the FCS type.

18. Decoding Level

Configure the scope of decoding. The decoded data is displayed in the Decoded Bits graph

frame.
Options:
No Decoding: No decoding of bit data; the Decoded Bits graph frame remains empty.

PHR+PSDU bits with FEC: Bit data after convolutional decoding (but still retains SECDED for
PHR and RS coding for PSDU).

PSDU Bits: PSDU bit data after RS decoding.

Default: No Decoding.
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19. Segment Length

Option: 16/32/64/128/256

Default: 64

Length of the STS segment (measured in units of 512 chips).

For BPRF, the Segment Length is fixed at 64. For HPRF, the Segment Length can be 16, 32, 64,
128, or 256.

20. Number of Segments

Option: 1/2/3/4

Default: 1

Configure the number of STS segments.

For BPRF, the Number of Segments is fixed at 1. For HPRF, the Number of Segments can be 1,
2, 3,0r4.

21. Extra Gap
Range: 0-127
Default: 0

The length of the additional Gap (measured in units of 4 chips) inserted between the Payload
and the STS start point. This option is only effective and visible when the STS Packet
Configuration is set to After PHR/Payload (2).

22. Key (128 bits)

The AES-128 encryption key is a 32-digit hexadecimal number represented as a hexadecimal
string (optionally prefixed with "0x"). It is used together with the Upper Part of V and Initial
Count to configure the DRBG (Deterministic Random Bit Generator), which is used to generate
the STS signal.

23. Upper Part of V (96 bits)

V is a value used for AES-128 encryption to iterate the given DRBG sequence. The Upper Part
of Vis a 24-digit hexadecimal number represented as a hexadecimal string (optionally prefixed
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with "0x").

24. Initial Count (32 bits)

Specifies the lower part of V. It increments with each DRBG iteration. The Initial Count is an 8-
digit hexadecimal number represented as a hexadecimal string (optionally prefixed with "0x").

3.9.1.2 Time

1. Search Time

Search Length refers to the amount of data captured and used for searching and demodulating
HRP-UWB frames. Demodulation search is performed within the range of the Search Length.

The unit is seconds (s).

2. Delay Time

Delay time.

3. Number of Waveform Samples

Number of Waveform Samples

3.9.1.3 Advanced

1. Frequency Error Compensation

The frequency offset compensation checkbox is used to determine whether frequency offset
estimation and correction should be performed. The frequency offset estimation range is
locked at +/-1 MHz. When this parameter is unchecked, frequency offset estimation and
correction are still performed, but the lock range is much smaller.

Default: Checked.

2. Estimate From
Option: Entire Frame | SYNC

Default: Entire Frame
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Select the range for frequency offset estimation, either the entire frame or only the SYNC
section. This option only takes effect when the Frequency Error Compensation checkbox is
checked first.

3. Phase Tracking

Phase tracking performs per-chunk phase correction to compensate for residual frequency
error (the remaining frequency error after applying Frequency Error Compensation).

The length of each chunk is 36,576 chips.
The incremental phase correction for each chunk is displayed in the Syms/Errs table.

Default: Checked.

4. Chip Clock Error Compensation

Clock error compensation checkbox. Select to enable or disable internal adjustment of the
clock timing.

When enabled, the VSA estimates the clock error and then internally adjusts the system clock
to match the estimated value.

Default: Checked.

5. Equalization Source
Specify the equalization filter to be applied to the signal.
Options: None | Inverse Measured Pulse

None: The demodulator does not compensate for the channel response of the measured signal
(as shown in 1Q Meas).

Inverse Measured Pulse: The demodulator takes the measured pulse from the EQ Impulse
Response trace, truncates it to the length specified by Delay Spread, calculates the LMS (Least
Mean Square) inverse of the filter, and applies it to the IQ Meas Time trace. This option should
be selected for accurate NRMSE calculation. Set the Reference Filter to Measured Pulse to
obtain the Err Vect Time trace (error vector similar to other VSA measurement types).

6. Delay Spread

When Equalization Source is set to Inverse Measured Pulse, the LMS equalization matrix is
truncated so that the EQ Impulse Response trace is used within a range of +/- a specified
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number of chips. Use Delay Spread to specify the +/- number of chips to be utilized.

Default: 8 Chips

7. Reference Filter

Specifies the filter used for the reference signal.
Options: None | Measured Pulse

Default: None

None: No filter is applied. This option should be selected for error vector calculations to match
the NRMSE metric.

Measured Pulse: To obtain the Err Vect Time result (error vector similar to other VSA
demodulation types), set Reference Filter to Measured Pulse and Equalization Source to None.

8. Data Sample Rate

Set the data sampling rate.

9. From NRMSE Computation
The duration of the portion removed when calculating the NRMSE result for the SHR.
Default: Os.

This does not affect the SHR data used for the subsequent Impairment Estimation.

10. From Impairment Estimation

The duration of the initial portion of the SHR that is removed when calculating results such as
frequency error, phase offset, chip clock error, and phase tracking corrections.

Default: 15 ys.

392 Measurement Results

The UWB measurement result settings path is: Trace -> Format.
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B [UWB 1] Trace Setting ¥

Trace1 o= AddTrace (%) Delete Trace

Format
Data Result RawMain Time

Format LogMag

Setup Steps:
1) Select the display window.
2) Choose a Group to organize different measurement results into separate categories.

3) Select the data format for the measurement results to be displayed.

Example of Measurement Results (ERDEV-HPRF):

5 SIGLENT SigVSA - 5
File Edt Control InputOutput  Meas Sety

X% UWB1:Error Summary(Trcd)

1. Baseband Pulse Mask

The pulse shape from -3 ns to 5 ns is displayed, with upper/lower masks applied to the real

part of the data.

The X-axis of this curve represents time, ranging from -3 ns to 5 ns, and the Y-axis represents
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the pulse shape amplitude.

This curve is applicable only to channels with a bandwidth of 499.2 MHz.

2. Ch Freq Response

Displays the channel frequency response calculated based on the SYNC section of the SHR. Ch
Frequency Response is the DFT of the Eq Impulse Response trace.

The X-axis represents frequency, and the Y-axis represents amplitude (dBm).

3. EqImpulse Response

Displays the impulse response calculated based on the SYNC section of the SHR. All Si symbols
except the first and the last are averaged. The number of Si symbols used for averaging is
shown in the Vect: NNN annotation above the graph frame, where NNN represents the number
of Si symbols used for averaging.

The X-axis represents time, and the Y-axis represents the impulse response amplitude.

4. Error Vector Time

Displays the difference between IQ Meas Time and IQ Ref Time. The X-axis represents the

symbol sequence number, and the Y-axis represents the normalized vector error (%).

This curve is normalized using the overall average pulse amplitude.

5. Frame Info

Displays the demodulation information for the current frame, including the demodulation
status (PASS or FAIL) of each section: SHR, PHR, and PSDU.

6. 1Q Meas Time

Displays the measured pulse waveform, with 2 points per pulse. The length of IQ Meas Time is
the same as that of IQ Ref Time. The Equalization Source option is applied to the data used in
this curve. When Equalization Source is set to Inverse Measured Pulse, non-pulse points are
zeroed out. This curve is normalized using the overall average pulse amplitude.

Note: When Equalization Source is set to Inverse Measured Pulse, the equalizer will zero out
any positions in IQ Meas that do not correspond to pulses in the 1Q Ref trace. If the data is not
demodulated correctly, some pulses in IQ Meas may be zeroed out. To view these pulses, set
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Equalization Source to None.

7. 1QRef Time
Displays the reference pulses of the frame, with 2 points per pulse.

IQ Ref Time has the same length as IQ Meas Time. The reference filter to be used can be
specified by configuring the Reference Filter parameter.

Normalization is applied using the overall average pulse amplitude.

8. RRC Correlated

Displays the cross-correlation function between the measured UWB pulse and a root-raised
cosine (RRC) pulse.

To calculate this trace, the pulse response is correlated with the reference RRC pulse and
normalized by the energy of both the reference and measured pulse responses, so a value of
1 indicates perfect correlation.

The X-axis represents time, and the Y-axis represents the correlation value.

The parameters Min Main Lobe Width, Max Side Lobe, Side Lobe Pk, and Side Lobe Pk Loc are

all calculated from this trace.

9. Error Summary
Displays the demodulated data table.

Freq Err: Average carrier frequency error (Hz and ppm). It represents the difference between
the VSA center frequency and the UWB signal center frequency, displayed in Hz and ppm. A
positive value indicates that the signal center frequency is higher than the VSA center
frequency.

SYNC Power: Average power of the SYNC portion of the 802.15.4 HRP UWB signal. The SYNC
segment is generated by repeating Si symbols multiple times. The average channel power is
calculated by averaging the middle portion of the SYNC segment, excluding the first and last
repeated Si symbols.

Time Offset: Offset from the trigger point (0 ms in Raw Main Time) to the beginning of the
frame. Displays the time offset (in seconds) between the start of the Search Time and the start
of the SHR.

RMARKER: Location of the first chip after the SFD. The relative time position is calculated from
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the start of the recording signal or the trigger point when acquiring data from the hardware.

Chip Clk Err: Error between the standard chip clock (499.2 MHz) and the signal chip clock. The
clock error is calculated by averaging the middle portion of the SYNC segment, excluding the
first and last repeated Si symbols. It is expressed in ppm, so the actual clock error is: (1 + Chip
Clk Err/1E6) * 499.2 MHz.

Main Lobe Pk: Amplitude of the peak lobe (%), measured from the RRC Correlated trace.

Main Lobe Width: Width of the main lobe, defined as the portion where the main lobe exceeds
0.8.

Side Lobe Pk: Amplitude of the highest sidelobe (%), measured from the RRC Correlated trace.

Side Lobe Pk Loc: Location of the highest sidelobe relative to the main lobe, expressed as the
time offset (in ns) from the main lobe peak position.

Min Main Lobe Width: PASS/FAIL indicator for the minimum main lobe width requirement. The
protocol requires the main lobe to be >0.8 and maintained for at least TW duration.

Max Side Lobe: PASS/FAIL indicator for the maximum sidelobe height requirement. The
protocol requires the sidelobe peak to be <0.3.

Pulse Monotonic Increase: Indicates whether the pulse shape increases monotonically
(PASS/FAIL). It checks if the pulse shape monotonically increases to its peak after exceeding
0.015.

NRMSE: Normalized Root Mean Square Error, expressed as a percentage of the pulse
amplitude averaged over the entire frame. NRMSE is calculated using only pulse points,
excluding inactive points, and is the RMS error between the 1Q Meas Time and IQ Ref Time
traces.

SHR NRMSE: NRMSE computed and averaged over the SHR part of the frame. Each domain's
NRMSE is calculated using only that portion, expressed as a percentage of the pulse amplitude
averaged over that part.

Data NRMSE: NRMSE computed and averaged over the Data part of the frame.
STS NRMSE: NRMSE computed and averaged over the STS part of the frame.

SHR Avg Power: Average Synchronization Header (SHR) power. It is the RMS average power of
the SHR, calculated from the resampled version of the input time-domain data.

SHR Peak Power: Peak Synchronization Header (SHR) power. It is the power of the peak sample
in the SHR, calculated from the resampled (2x499.2 MHz) version of the input time-domain
data.

Data Avg Power: Average data (PHR + Payload) power. It is the RMS average power of the Data
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portion, calculated from the resampled version of the input time-domain data.

Data Peak Power: Peak data (PHR + Payload) sample power. It is the peak power of the Data
portion, calculated from the resampled version of the input time-domain data.

STS Avg Power: Average Scrambled Timestamp Sequence (STS) power. It is the RMS average
power of the STS domain, calculated from the resampled version of the input time-domain
data.

STS Peak Power: Peak Scrambled Timestamp Sequence (STS) power. It is the peak power of the
STS portion, calculated from the resampled version of the input time-domain data.

SHR Avg Pulse Amplitude: Average SHR pulse amplitude. It is the average pulse amplitude
level of the Synchronization Header (SHR), calculated from the IQ Meas trace. Only pulse
positions (where 1Q Ref is -1 or 1) are included in the average.

PHR Avg Pulse Amplitude: Average PHR pulse amplitude. It is the average pulse amplitude
level of the PHR portion, expressed in dB relative to the SHR average pulse amplitude.

PSDU Avg Pulse Amplitude: Average PSDU pulse amplitude. It is the average pulse amplitude
level of the PSDU portion, expressed in dB relative to the SHR average pulse amplitude.

STS Avg Pulse Amplitude: Average STS pulse amplitude. It is the average pulse amplitude level

of the STS portion, expressed in dB relative to the SHR average pulse amplitude.

10. Transmit Mask

The Transmit Mask trace displays the signal spectrum with standard-defined limit lines (0 dBr

is set to the maximum value within |f| < 0.65/Tp).

It is calculated from the data in the Time trace, and the spectrum is averaged to simulate a
video bandwidth (VBW) of <1 kHz. The window used for spectrum calculation is the Gaussian
Top window.

Note: A single measurement may not contain enough data to achieve a 1 kHz VBW. The VBW
annotation in the graph indicates the actual video bandwidth. To simulate the required VBW,
the time length is increased by analyzing longer signals (e.g., SYNC Length = 1024).

11. Raw Main Time

Displays the magnitude of the captured raw IQ data, with demodulated data positions marked.
The horizontal axis is in time units (s, ms, us, ns, depending on the data format), and the vertical
axis units are determined by the data format.
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12. Spectrum

Displays the spectrogram of 1Q data before demodulation, which is the FFT of Raw Main Time.
The horizontal axis is in frequency units (Hz, kHz, MHz, depending on the data format), and
the vertical axis units are determined by the data format.

Example of Measurement Results (ERDEV-BPRF):

5 SIGLENT SigVSA - 5 X

1. Baseband Pulse Mask

The pulse shape from -3 ns to 5 ns is displayed, with upper/lower masks applied to the real
part of the data.

The X-axis of this curve represents time, ranging from -3 ns to 5 ns, and the Y-axis represents
the pulse shape amplitude.

This curve is applicable only to channels with a bandwidth of 499.2 MHz.

2. Ch Freq Response

Displays the channel frequency response calculated based on the SYNC section of the SHR. Ch

Frequency Response is the DFT of the Eq Impulse Response trace.

The X-axis represents frequency, and the Y-axis represents amplitude (dBm).

3. Eq Impulse Response
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Displays the impulse response calculated based on the SYNC section of the SHR. All Si symbols
except the first and the last are averaged. The number of Si symbols used for averaging is
shown in the Vect: NNN annotation above the graph frame, where NNN represents the number
of Si symbols used for averaging.

The X-axis represents time, and the Y-axis represents the impulse response amplitude.

4. Error Vector Time

Displays the difference between IQ Meas Time and 1Q Ref Time. The X-axis represents the
symbol sequence number, and the Y-axis represents the normalized vector error (%).

This curve is normalized using the overall average pulse amplitude.

5 Frame Info

Displays the demodulation information for the current frame, including the demodulation
status (PASS or FAIL) of each section: SHR, PHR, and PSDU.

6. 1Q Meas Time

Displays the measured pulse waveform, with 2 points per pulse. The length of IQ Meas Time is
the same as that of IQ Ref Time. The Equalization Source option is applied to the data used in
this curve. When Equalization Source is set to Inverse Measured Pulse, non-pulse points are

zeroed out. This curve is normalized using the overall average pulse amplitude.

Note: When Equalization Source is set to Inverse Measured Pulse, the equalizer will zero out
any positions in IQ Meas that do not correspond to pulses in the 1Q Ref trace. If the data is not
demodulated correctly, some pulses in IQ Meas may be zeroed out. To view these pulses, set
Equalization Source to None.

7. lQRef Time
Displays the reference pulses of the frame, with 2 points per pulse.

IQ Ref Time has the same length as IQ Meas Time. The reference filter to be used can be
specified by configuring the Reference Filter parameter.

Normalization is applied using the overall average pulse amplitude.

8. RRC Correlated
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Displays the cross-correlation function between the measured UWB pulse and a root-raised
cosine (RRC) pulse.

To calculate this trace, the pulse response is correlated with the reference RRC pulse and
normalized by the energy of both the reference and measured pulse responses, so a value of
1 indicates perfect correlation.

The X-axis represents time, and the Y-axis represents the correlation value.

The parameters Min Main Lobe Width, Max Side Lobe, Side Lobe Pk, and Side Lobe Pk Loc are
all calculated from this trace.

9. Error Summary
Displays the demodulated data table.

Freq Err: Average carrier frequency error (Hz and ppm). It represents the difference between
the VSA center frequency and the UWB signal center frequency, displayed in Hz and ppm. A
positive value indicates that the signal center frequency is higher than the VSA center
frequency.

SYNC Power: Average power of the SYNC portion of the 802.15.4 HRP UWB signal. The SYNC
segment is generated by repeating Si symbols multiple times. The average channel power is
calculated by averaging the middle portion of the SYNC segment, excluding the first and last

repeated Si symbols.

Time Offset: Offset from the trigger point (0 ms in Raw Main Time) to the beginning of the
frame. Displays the time offset (in seconds) between the start of the Search Time and the start
of the SHR.

RMARKER: Location of the first chip after the SFD. The relative time position is calculated from
the start of the recording signal or the trigger point when acquiring data from the hardware.

Chip Clk Err: Error between the standard chip clock (499.2 MHz) and the signal chip clock. The
clock error is calculated by averaging the middle portion of the SYNC segment, excluding the
first and last repeated Si symbols. It is expressed in ppm, so the actual clock error is: (1 + Chip
Clk Err/1E6) * 499.2 MHz.

Main Lobe Pk: Amplitude of the peak lobe (%), measured from the RRC Correlated trace.

Main Lobe Width: Width of the main lobe, defined as the portion where the main lobe exceeds
0.8.

Side Lobe Pk: Amplitude of the highest sidelobe (%), measured from the RRC Correlated trace.

Side Lobe Pk Loc: Location of the highest sidelobe relative to the main lobe, expressed as the
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time offset (in ns) from the main lobe peak position.

Min Main Lobe Width: PASS/FAIL indicator for the minimum main lobe width requirement. The
protocol requires the main lobe to be >0.8 and maintained for at least TW duration.

Max Side Lobe: PASS/FAIL indicator for the maximum sidelobe height requirement. The
protocol requires the sidelobe peak to be <0.3.

Pulse Monotonic Increase: Indicates whether the pulse shape increases monotonically
(PASS/FAIL). It checks if the pulse shape monotonically increases to its peak after exceeding
0.015.

NRMSE: Normalized Root Mean Square Error, expressed as a percentage of the pulse
amplitude averaged over the entire frame. NRMSE is calculated using only pulse points,
excluding inactive points, and is the RMS error between the 1Q Meas Time and IQ Ref Time
traces.

SHR NRMSE: NRMSE computed and averaged over the SHR part of the frame. Each domain's
NRMSE is calculated using only that portion, expressed as a percentage of the pulse amplitude
averaged over that part.

Data NRMSE: NRMSE computed and averaged over the Data part of the frame.
STS NRMSE: NRMSE computed and averaged over the STS part of the frame.

SHR Avg Power: Average Synchronization Header (SHR) power. It is the RMS average power of

the SHR, calculated from the resampled version of the input time-domain data.

SHR Peak Power: Peak Synchronization Header (SHR) power. It is the power of the peak sample
in the SHR, calculated from the resampled (2x499.2 MHz) version of the input time-domain
data.

Data Avg Power: Average data (PHR + Payload) power. It is the RMS average power of the Data
portion, calculated from the resampled version of the input time-domain data.

Data Peak Power: Peak data (PHR + Payload) sample power. It is the peak power of the Data
portion, calculated from the resampled version of the input time-domain data.

STS Avg Power: Average Scrambled Timestamp Sequence (STS) power. It is the RMS average
power of the STS domain, calculated from the resampled version of the input time-domain
data.

STS Peak Power: Peak Scrambled Timestamp Sequence (STS) power. It is the peak power of the
STS portion, calculated from the resampled version of the input time-domain data.

SHR Avg Pulse Amplitude: Average SHR pulse amplitude. It is the average pulse amplitude
level of the Synchronization Header (SHR), calculated from the IQ Meas trace. Only pulse
positions (where 1Q Ref is -1 or 1) are included in the average.
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PHR Avg Pulse Amplitude: Average PHR pulse amplitude. It is the average pulse amplitude
level of the PHR portion, expressed in dB relative to the SHR average pulse amplitude.

PSDU Avg Pulse Amplitude: Average PSDU pulse amplitude. It is the average pulse amplitude
level of the PSDU portion, expressed in dB relative to the SHR average pulse amplitude.

STS Avg Pulse Amplitude: Average STS pulse amplitude. It is the average pulse amplitude level
of the STS portion, expressed in dB relative to the SHR average pulse amplitude.

10. Transmit Mask

The Transmit Mask trace displays the signal spectrum with standard-defined limit lines (0O dBr
is set to the maximum value within |f| < 0.65/Tp).

It is calculated from the data in the Time trace, and the spectrum is averaged to simulate a
video bandwidth (VBW) of <1 kHz. The window used for spectrum calculation is the Gaussian
Top window.

Note: A single measurement may not contain enough data to achieve a 1 kHz VBW. The VBW
annotation in the graph indicates the actual video bandwidth. To simulate the required VBW,
the time length is increased by analyzing longer signals (e.g., SYNC Length = 1024).

11. Raw Main Time

Displays the magnitude of the captured raw IQ data, with demodulated data positions marked.
The horizontal axis is in time units (s, ms, us, ns, depending on the data format), and the vertical

axis units are determined by the data format.

12. Spectrum

Displays the spectrogram of 1Q data before demodulation, which is the FFT of Raw Main Time.
The horizontal axis is in frequency units (Hz, kHz, MHz, depending on the data format), and
the vertical axis units are determined by the data format.

Example of Measurement Results (Non-ERDEV):
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) SIGLENT SigVSA - 5 x
Flo Et Control InputOutpit MeasSetup Tiace Markers Window Utiities Help

> 1] uwsi

Messurement Mar < (Tret) % % UWB1:Error Summary(Tred)

1. Baseband Pulse Mask

The pulse shape from -3 ns to 5 ns is displayed, with upper/lower masks applied to the real
part of the data.

The X-axis of this curve represents time, ranging from -3 ns to 5 ns, and the Y-axis represents
the pulse shape amplitude.

This curve is applicable only to channels with a bandwidth of 499.2 MHz.

2. Ch Freq Response

Displays the channel frequency response calculated based on the SYNC section of the SHR. Ch
Frequency Response is the DFT of the Eq Impulse Response trace.

The X-axis represents frequency, and the Y-axis represents amplitude (dBm).

3. EqImpulse Response

Displays the impulse response calculated based on the SYNC section of the SHR. All Si symbols
except the first and the last are averaged. The number of Si symbols used for averaging is
shown in the Vect: NNN annotation above the graph frame, where NNN represents the number

of Si symbols used for averaging.

The X-axis represents time, and the Y-axis represents the impulse response amplitude.

4. Error Vector Time
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Displays the difference between IQ Meas Time and IQ Ref Time. The X-axis represents the
symbol sequence number, and the Y-axis represents the normalized vector error (%).

This curve is normalized using the overall average pulse amplitude.

5. Frame Info

Displays the demodulation information for the current frame, including the demodulation
status (PASS or FAIL) of each section: SHR, PHR, and PSDU.

6. 1Q Meas Time

Displays the measured pulse waveform, with 2 points per pulse. The length of IQ Meas Time is
the same as that of IQ Ref Time. The Equalization Source option is applied to the data used in
this curve. When Equalization Source is set to Inverse Measured Pulse, non-pulse points are
zeroed out. This curve is normalized using the overall average pulse amplitude.

Note: When Equalization Source is set to Inverse Measured Pulse, the equalizer will zero out
any positions in IQ Meas that do not correspond to pulses in the 1Q Ref trace. If the data is not
demodulated correctly, some pulses in IQ Meas may be zeroed out. To view these pulses, set

Equalization Source to None.

7. lQRef Time
Displays the reference pulses of the frame, with 2 points per pulse.

IQ Ref Time has the same length as IQ Meas Time. The reference filter to be used can be
specified by configuring the Reference Filter parameter.

Normalization is applied using the overall average pulse amplitude.

8. RRC Correlated

Displays the cross-correlation function between the measured UWB pulse and a root-raised
cosine (RRC) pulse.

To calculate this trace, the pulse response is correlated with the reference RRC pulse and
normalized by the energy of both the reference and measured pulse responses, so a value of
1 indicates perfect correlation.

The X-axis represents time, and the Y-axis represents the correlation value.

The parameters Min Main Lobe Width, Max Side Lobe, Side Lobe Pk, and Side Lobe Pk Loc are
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all calculated from this trace.

9. Error Summary
Displays the demodulated data table.

Freq Err: Average carrier frequency error (Hz and ppm). It represents the difference between
the VSA center frequency and the UWB signal center frequency, displayed in Hz and ppm. A
positive value indicates that the signal center frequency is higher than the VSA center
frequency.

SYNC Power: Average power of the SYNC portion of the 802.15.4 HRP UWB signal. The SYNC
segment is generated by repeating Si symbols multiple times. The average channel power is
calculated by averaging the middle portion of the SYNC segment, excluding the first and last
repeated Si symbols.

Time Offset: Offset from the trigger point (0 ms in Raw Main Time) to the beginning of the
frame. Displays the time offset (in seconds) between the start of the Search Time and the start
of the SHR.

RMARKER: Location of the first chip after the SFD. The relative time position is calculated from

the start of the recording signal or the trigger point when acquiring data from the hardware.

Chip Clk Err: Error between the standard chip clock (499.2 MHz) and the signal chip clock. The
clock error is calculated by averaging the middle portion of the SYNC segment, excluding the

first and last repeated Si symbols. It is expressed in ppm, so the actual clock error is: (1 + Chip
Clk Err/1E6) * 499.2 MHz.

Main Lobe Pk: Amplitude of the peak lobe (%), measured from the RRC Correlated trace.

Main Lobe Width: Width of the main lobe, defined as the portion where the main lobe exceeds
0.8.

Side Lobe Pk: Amplitude of the highest sidelobe (%), measured from the RRC Correlated trace.

Side Lobe Pk Loc: Location of the highest sidelobe relative to the main lobe, expressed as the
time offset (in ns) from the main lobe peak position.

Min Main Lobe Width: PASS/FAIL indicator for the minimum main lobe width requirement. The
protocol requires the main lobe to be >0.8 and maintained for at least TW duration.

Max Side Lobe: PASS/FAIL indicator for the maximum sidelobe height requirement. The
protocol requires the sidelobe peak to be <0.3.

Pulse Monotonic Increase: Indicates whether the pulse shape increases monotonically
(PASS/FAIL). It checks if the pulse shape monotonically increases to its peak after exceeding
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0.015.

NRMSE: Normalized Root Mean Square Error, expressed as a percentage of the pulse
amplitude averaged over the entire frame. NRMSE is calculated using only pulse points,
excluding inactive points, and is the RMS error between the 1Q Meas Time and IQ Ref Time
traces.

SHR NRMSE: NRMSE computed and averaged over the SHR part of the frame. Each domain's
NRMSE is calculated using only that portion, expressed as a percentage of the pulse amplitude
averaged over that part.

Data NRMSE: NRMSE computed and averaged over the Data part of the frame.
STS NRMSE: NRMSE computed and averaged over the STS part of the frame.

SHR Avg Power: Average Synchronization Header (SHR) power. It is the RMS average power of
the SHR, calculated from the resampled version of the input time-domain data.

SHR Peak Power: Peak Synchronization Header (SHR) power. It is the power of the peak sample
in the SHR, calculated from the resampled (2x499.2 MHz) version of the input time-domain
data.

Data Avg Power: Average data (PHR + Payload) power. It is the RMS average power of the Data

portion, calculated from the resampled version of the input time-domain data.

Data Peak Power: Peak data (PHR + Payload) sample power. It is the peak power of the Data

portion, calculated from the resampled version of the input time-domain data.

STS Avg Power: Average Scrambled Timestamp Sequence (STS) power. It is the RMS average
power of the STS domain, calculated from the resampled version of the input time-domain
data.

STS Peak Power: Peak Scrambled Timestamp Sequence (STS) power. It is the peak power of the
STS portion, calculated from the resampled version of the input time-domain data.

SHR Avg Pulse Amplitude: Average SHR pulse amplitude. It is the average pulse amplitude
level of the Synchronization Header (SHR), calculated from the 1Q Meas trace. Only pulse
positions (where IQ Ref is -1 or 1) are included in the average.

PHR Avg Pulse Amplitude: Average PHR pulse amplitude. It is the average pulse amplitude
level of the PHR portion, expressed in dB relative to the SHR average pulse amplitude.

PSDU Avg Pulse Amplitude: Average PSDU pulse amplitude. It is the average pulse amplitude
level of the PSDU portion, expressed in dB relative to the SHR average pulse amplitude.

STS Avg Pulse Amplitude: Average STS pulse amplitude. It is the average pulse amplitude level
of the STS portion, expressed in dB relative to the SHR average pulse amplitude.
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10. Transmit Mask

The Transmit Mask trace displays the signal spectrum with standard-defined limit lines (0O dBr
is set to the maximum value within |f| < 0.65/Tp).

It is calculated from the data in the Time trace, and the spectrum is averaged to simulate a
video bandwidth (VBW) of <1 kHz. The window used for spectrum calculation is the Gaussian
Top window.

Note: A single measurement may not contain enough data to achieve a 1 kHz VBW. The VBW
annotation in the graph indicates the actual video bandwidth. To simulate the required VBW,
the time length is increased by analyzing longer signals (e.g., SYNC Length = 1024).

11. Raw Main Time

Displays the magnitude of the captured raw IQ data, with demodulated data positions marked.
The horizontal axis is in time units (s, ms, us, ns, depending on the data format), and the vertical
axis units are determined by the data format.

12. Spectrum

Displays the spectrogram of 1Q data before demodulation, which is the FFT of Raw Main Time.
The horizontal axis is in frequency units (Hz, kHz, MHz, depending on the data format), and

the vertical axis units are determined by the data format.

310 FHSS

3.10.1 Configuration

The path to enter the FHSS configuration interface is: Meas Setup -> FHSS Properties.
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} SIGLENT SigVSA
File Edit Control InputOutput MeasSetup Trace Markers Wir

I]] _: FHSS1 | == New Measurement N

Measurement Management Remove Measurement  » [rd

o= AddGroup = NewMeasureme:
Current Measurement
+ Group1
Measure Management...

v FHSS? moe

Measurement Type: FHSS »

s File () Remotel .
[FHSS 1] Properties...

3.10.1.1 Signal

1. Bandwidth

Set the system bandwidth.

2. Power

Set the power.

3. Hopld

Select the hop state with this ID to view the demodulation results.

4. Sample Rate

Set the sampling rate.

5. Mode

In manual mode, hop state detection is based on the configured minimum/maximum dwell
time. In auto mode, hop states are automatically detected.

6. Min Dwell Time

Minimum detectable dwell time.
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7. Max Dwell Time

Maximum detectable dwell time.

3.10.1.2 Measurement

2. FM Settling Tolerance

FM fluctuations below this tolerance are considered settled.

3. PM Settling Tolerance

PM fluctuations below this tolerance are considered settled.

3.10.1.3 Acquisition

4. Analysis Regions Mode

In manual mode, hop demodulation is based on the configured analysis region start and length.
In auto mode, the detection length is automatically matched.

5. Analysis Regions Start

Start of the analysis region.

6. Acquisiton Length

Acquisition length.

3.10.1.4 Result

1. Auto Range

Automatically match the statistical region for hop demodulation results.

2. Reference Point

Reference point for the statistical region of hop demodulation results.
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3. Reference Offset

Offset from the Reference Point.

4. Result Range

Position of the statistical region for hop demodulation results relative to the Reference Point.

5. Result Length

Length of the statistical region for hop demodulation results.

6. Table

Select parameters to display in the table.

3.10.2 Measurement Results

The path to set FHSS measurement results is: Trace -> Format.

B [FHSS 1] Trace Setting X

Trace1 o= AddTrace (%) Delete Trace

Format

Data Result Rf Spectrum

Setup Steps:
1) Select the display window.

2) Choose Result to switch the measurement result data to be displayed.

Example of Measurement Results:
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 SIGLENT SigVSA _ 5 x

HopBegin Dwell Time SwitchingTime StateFrequency AvgFrequency HopStateDeviation Relative Frequency FM SettlingPoint FM Setting Time FM SettledLength FreqDevPeak FroqDev RM
% (ma) (ms) (ms) (kHz) (kHz) (kHz) (kHz) (ms) (ms) (ms) (kHz) (kHz)

11. Rf Spectrum

Spectrum image/raw image of the data (optional region). Horizontal axis: Hz, vertical axis: dBm.

12. Fm Time

FM frequency image, reflecting frequency hopping. Horizontal axis: time, vertical axis: Hz.

13. Spectrogram

Power spectrum waterfall plot. Horizontal axis: length of the analysis region, vertical axis:
analysis results, with color distinguishing power levels.

14. Freq Dev Time

Frequency image of the data. Horizontal axis: time, vertical axis: frequency.

15. Results
Summary table of frequency-hopping signal information:
1) ID: Overall frequency-hopping number, starting from 1.

2) HOP NO: The number of the hop state within the configured analysis cycle, starting from
1.
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3) State Index: State index, the number in the hop state table.

4) Hop Begin: Start time of the current hop (relative time when the signal first enters the hop
tolerance region).

5) Dwell Time: Dwell time of the current hop (duration the signal remains within the hop
tolerance range).

6) Switching Time: Hop switching time (time difference between the previous end point and
the next start point).

7) State Frequency: Nominal frequency of the current hop state.
8) Avg Frequency: Average frequency within the measurement range of the current hop.
9) Hop State Deviation: Deviation between the average frequency and the nominal frequency.

10) Relative Frequency: Difference between the average frequency of the current hop and the
previous hop.

11) FM Settling Point: Coordinates of the FM curve settling point (the point where frequency
deviation no longer exceeds tolerance). Units: sec.

12) FM Settling Time: Time difference between the detected hop point and the settling point.
Units: sec.

13) FM Settled Length: Duration of FM curve settlement for the current hop (time difference
between the settling point and the hop end point).

14) Freq Dev Peak: Maximum difference between the instantaneous frequency of the

measured signal and the ideal frequency trajectory. Units: Hz.
15) Freq Dev RMS: RMS value of Freq Dev Peak. Units: Hz.
16) Freq Dev Avg: Average value of Freq Dev Peak. Units: Hz.
17) PM Settling Point: PM settling point. Units: sec.

18) PM Settling Time: Time difference between the detected hop point and the settling point.
Units: sec.

19) PM Settled Length: Duration of maintained settlement (time interval from the settling
point to when the deviation exceeds tolerance, i.e., the hop end point).

20) Phase Dev Peak: Maximum deviation between the measured phase and the ideal value.
Units: deg.

21) Phase Dev RMS: RMS value of Phase Dev Peak. Units: deg.
22) Phase Dev Avg: Average value of Phase Dev Peak. Units: deg.

23) Min Power: Minimum power level measured during the hop. Units: dBm.
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24) Max Power: Maximum power level measured during the hop. Units: dBm.
25) Avg Power: Average power level measured during the hop. Units: dBm.

26) Power Ripple: Ratio of maximum power level to minimum power level, expressed as the
difference in dBm. Units: dB.

311 FMCW

3.11.1 Configuration

The path to enter the FMCW configuration interface is: Meas Setup -> FMCW Properties.

} SIGLENT SigVSA
File Edit Control InputOutput MeasSetup Trace Markers Win

I]] | FMCW1| == New Measurement

Measurement Management Remove Measurement r el

o= AddGroup = NewMeasureme:
Current Measurement
~ Group1
Measure Management...

. FMCW1 m g

Measurement Type: FMCW »

+ File ) Remote [ _
) [FMCW 1] Properties...

3.11.1.1 General

3.11.1.1.1 Signal
1. Signal Mode

Signal type. Option: Chirp. Default value: Chirp (linear frequency modulation signal).
2. Frequency Center

Center frequency.

3. 1QMap

IQ image switch. Options: Normal | Invert. Default value: Normal.

4. Data Sample Rate

Manual sampling rate setting switch. Options: Auto | Manual. Default value: Auto. When set to
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Manual, the demodulation sampling rate can be changed manually.

3.11.1.1.2 Window
1. Window Length
Window length.

2. Window Overlap

Window overlap.

3.11.1.1.3 Chirp
1. Chirp Detection

Linear frequency modulation signal detection.

2. Chirp Setting

Chirp mode setting. Options: Manual | Auto. Default value: Manual.
3. Chirp Count

Number of chirp signals.

3.11.1.2 Time

1. Time Auto Detect

Time auto-detection.

2. Meas Time

Measurement time.

3. Time Gate Length
Measurement window time.

4. Time Gate Start
Measurement window start time.
5. Min Chirp Length

Minimum chirp time length.

6. Max Chirp Length
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Maximum chirp time length.
7. From Start

From the start point.

8. From End

From the end point.

9. Switch Timing Config

Switching timing configuration.

10. Analysis Exclude

Exclude from analysis.

3.11.1.3 Advanced

3.11.1.3.1 Deviation Length
Deviation Length.

1. Reference

Reference position.

2. Length

Length.

3. Offset Begin

Start offset.

4. Offset End

End offset.

3.11.1.3.2 Deviation Setting
Deviation Setting.

1. Chirp State Deviation
Chirp state deviation.

2. FM Settling Tolerance

FM settling tolerance.

224

www.siglent.com



SigVSA Vector Signal Analysis Software User Manual

3. PM Settling Tolerance

PM settling tolerance.

3.11.1.3.3 Display Region

Display Region.

1. Display Region

Display region. Options: Region | Chirp | All. Default value: Region.
2. Scale Conversion

Scale conversion.

3.11.1.4 Result

1. ID
Identifier.
2. Chirp No.

Chirp signal index number.
3. Start Time

Chirp signal start time.

4. End Time

Chirp signal end time.

5. Chirp Length

Chirp signal time length.

6. Switching Time

Chirp signal switching time.
7. Slope

Chirp signal slope.

8. Slope Deviation

Chirp signal slope deviation.

9. Slope Deviation(Peak)
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Chirp signal slope deviation (peak).

10. Slope Deviation(RMS)

Chirp signal slope deviation (RMS).

11. Slope Deviation(Average)

Chirp signal slope deviation (average).
12. Bandwidth

Bandwidth.

13. FM Settling Point

FM settling point.

14. FM Settling Time

FM settling time.

15. FM Settling Length

FM settling length.

16. Frequency INL(Peak)

Frequency Integral Non-Linearity (peak).
17. Frequency INL(RMS)

Frequency Integral Non-Linearity (RMS).
18. Frequency INL(Average)
Frequency Integral Non-Linearity (average).
19. Average Frequency

Average frequency.

20. Frequency Deviation(Peak)
Frequency deviation (peak).

21. Frequency Deviation(RMS)
Frequency deviation (RMS).

22. Frequency Deviation(Average)
Frequency deviation (average).

23. PM Settling Point

Phase modulation settling point.
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24. PM Settling Time

Phase modulation settling time.
25. PM Settling Length

Phase modulation settling length.
26. Phase Deviation(Peak)
Phase deviation (peak).

27. Phase Deviation(RMS)
Phase deviation (RMS).

28. Phase Deviation(Average)
Phase deviation (average).

29. Minimum Power
Minimum power.

30. Maximum Power
Maximum power.

31. Average Power

Average power.

32. Power Ripple

Power ripple.

3.11.2 Measurement Results

The path for setting FMCW measurement results is: Trace -> Format.

B [FMCW 1] Trace Setting X

Tracel o= AddTrace (%) Delete Trace

Format

Data Result RawMain Time

Setup Steps:
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1) Select the display window.

2) Select Result to switch the measurement result data to be displayed.

Measurement Result Example:

<7 SIGLENT SigVSA - & X
Fle Edt Control InputOutput MeasSetup Trace Markers Utiities  Help  Logger

11 ) - - B iE

Measurement Management |~ ¥ FMCW 1. Spectrogram(Tre2) % | "% FMCW1:Phase Dev Time(Trc3)

4 AddGroup - NewMeasurement

-15951dBm B m "
- Groupl
FMCW1 @ x " )
Span T5SMHz Sus st
(Trcd) o x

) File

Stop 4ms

SlopaDovRMS  SlopeDevAvg  Bandwidth  FM SattlingPoint FM Sottling FM Sattied Lei
(kHz/1s) (kHz/ 1 5) (kH2) § u (ns)

1. Rf Spectrum

Frequency image of the data. X-axis: time, Y-axis: frequency.

2. Fm Time

FM frequency image, showing frequency hopping. X-axis: time, Y-axis: Hz.
3. Spectrogram

Power spectrum waterfall plot. X-axis shows the length of the analysis region, Y-axis shows the
analysis results, and power is distinguished by color.

4. Spectrum

Frequency spectrum image/raw image of the data (selectable region). X-axis: Hz, Y-axis: dBm.
5. Results

Frequency hopping signal information summary table:

1) ID: Total chirp point number, starting from 1.

2) Chirp No.: Reference chirp point number, starting from 0.
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3) Start Time: Chirp signal start time, unit: ys.

4) End Time: Chirp signal end time, unit: ps.

5) Chirp Length: Chirp time length, unit: ps.

6) Switching Time: Chirp switching time, unit: ps.

7) Slope: Chirp signal slope, unit: kHz/ys.

8) Slope Dev: Chirp signal slope deviation, unit: kHz/us.

9) Slope Dev Peak: Chirp signal slope deviation (peak), unit: kHz/ps.
10) Slope Dev RMS: Chirp signal slope deviation (RMS), unit: kHz/ps.
11) Slope Dev Avg: Chirp signal slope deviation (average), unit: kHz/ps.
12) Bandwidth: Bandwidth, unit: kHz.

13) FM Settling Point: FM settling point, unit: ps.

14) FM Settling Time: FM settling time, unit: ps.

15) FM Settling Length: FM settling length, unit: ps.

16) Frequency INL Peak: Frequency Integral Non-Linearity (peak).
17) Frequency INL RMS: Frequency Integral Non-Linearity (RMS).
18) Frequency INL Avg: Frequency Integral Non-Linearity (average).
19) Avg Frequency: Average frequency, unit: kHz.

20) Freq Dev Peak: Frequency deviation peak, unit: kHz.

21) Freq Dev RMS: Frequency deviation RMS, unit: kHz.

22) Freq Dev Avg: Frequency deviation average, unit: kHz.

23) PM Settling Point: Phase modulation settling point, unit: ps.

24) PM Settling Time: Phase modulation settling time, unit: ps.

25) PM Settling Length: Phase modulation settling length, unit: ps.
26) Phase Dev Peak: Phase deviation peak, unit: deg.

27) Phase Dev RMS: Phase deviation RMS, unit: deg.

28) Phase Dev Avg: Phase deviation average, unit: deg.

29) Min Power: Minimum power, unit: dBm.

30) Max Power: Maximum power, unit: dBm.

31) Avg Power: Average power, unit: dBm.
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32) Power Ripple: Power ripple, unit: dB.

Ordering Information

Standard configuration

Serial .
Name Description Order Number
Number
Basic Vector Signal Provides measurement functions
1 Analysis Signal analysis | such as spectrum analysis and IQ | SIGV-VSAA1
software analysis.
Provides an option for general
Custom OFDM ) ]
2 ) . OFDM signal demodulation SIGV-VSAOT1
modulation analysis .
analysis.
o ) Provides options for general
Digital modulation o ) .
3 . digital modulation signal SIGV-VSAD1
analysis ] )
demodulation analysis.
Options
Serial .
Name Description Order Number
Number
Provides an option for running up
32 Measurement
1 ) ) to 32 measurements SIGV-VSAA2
vector signal analysis .
simultaneously.
LTE/LTE-A FDD Provides options for LTE/LTE-A
2 : : , , SIGV-VSAL1
modulation analysis FDD demodulation analysis.
LTE/LTE-A TDD Provides options for LTE/LTE-A
3 , . , . SIGV-VSAL2
modulation analysis TDD demodulation analysis.
5G NR/NR-A Provides options for NR/NR-A
4 . : _ _ SIGV-VSANT1
Modulation Analysis demodulation analysis.
5 5G NR-NTN Provides options for NR-NTN SIGV-VSAN2
230 www.siglent.com



SigVSA Vector Signal Analysis Software User Manual

modulation analysis

demodulation analysis.

Signal analysis

hopping signal analysis.

WLAN Provides options for WLAN
6 802.11b/a/g/n/ac/ax | 802.11b/a/g/n/ac/ax SIGV-VSAW1
WLAN 802.11be Provides options for WLAN
7 _ . . . SIGV-VSAW?2
modulation analysis 802.11be demodulation analysis.
. Provides options for HRP-UWB
HRP-UWB modulation ) i )
8 ) with various bandwidths SIGV-VSAU1
analysis . .
demodulation analysis.
Bluetooth modulation | Provides options for Bluetooth
9 . . . SIGV-VSAB1
analysis demodulation analysis.
Frequency-Hoppin Provides options for frequency-
10 Aueney-ropping g WEY™ | sigv-vsaFT

More options coming soon! Follow us for updates.

Serial I
Name Description Order Number
Number
GSM/EDGE Provides options for GSM
1 _ . _ _ SIGV-VSAGT
modulation analysis demodulation analysis.
WCDMA/HSPA Provides options for WCDMA
2 _ . _ _ SIGV-VSAG2
modulation analysis demodulation analysis.
NB-lot downlink Provides options for NB-lot
3 ' . . . SIGV-VSAG3
modulation analysis demodulation analysis.
Provides options for linear
4 FMCW Signal analysis | frequency modulation (chirp) SIGV-VSAF2
signal analysis.
) ) Provides options for Pulse signal
5 Pulse Signal analysis ) SIGV-VSAP1
analysis.
6 DVB-S2\S2X Provides options for DVB-S2\S2X SIGV-VSAV1
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modulation analysis

analysis.
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U SIGLENT

About SIGLENT

SIGLENT is an international high-tech company, concentrating on R&D,
sales, production and services of electronic test & measurement
instruments.

SIGLENT first began developing digital oscilloscopes independently in
2002. After more than a decade of continuous development, SIGLENT
has extended its product line to include digital oscilloscopes, isolated
handheld oscilloscopes, function/arbitrary waveform generators,
RF/MW signal generators, spectrum analyzers, vector network analyzers,
digital multimeters, DC power supplies, electronic loads and other
general purpose test instrumentation. Since its first oscilloscope was
launched in 2005, SIGLENT has become the fastest growing
manufacturer of digital oscilloscopes. We firmly believe that today
SIGLENT is the best value in electronic test & measurement.

Follow us on
Facebook: SiglentTech
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